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Introduction
The FDOT-sponsored Transit Boardings Estimation and Simulation Tool (TBEST) transit demand
forecasting and analyisis software is an approved and recommended method for developing ridership
estimates for major Transit Development Plan (TDP) updates. Historically, TBEST has been utilized for
strategic planning initiatives inlcuding fulfilling the requirement for transit agencies to produce ridership
estimations within TDP’s. To assist agencies in this process, FDOT provides pre-formatted socioeconomic data and pre-coded networks, however, Florida transit agencies were required to provide
resources to update network data, perform TBEST modeling, utilize TBEST tools to analyze model output
and train staff members to utilize the software.

While this investment was not overwhelming,

oftentimes, once the TDP development effort was over, the TBEST model was shelved until the next TDP
update. FDOT realized that both the agency and FDOT’s investment in theTBEST software could be
maximized by further usage by service planners.
To that end, FDOT has developed this document to assist transit agencies in establishing and utilizing
TBEST for other planning applications. It allows strategic and service planners a tool for testing the
implementation of new routes, stops or services or other operational changes that occur outside of TDP
development. This procedure was based on the practices of an existing transit agency, LYNX in central
Florida. Many of the procedures and workflows included in this document are based on the LYNX TBEST
implementation and can be adopted as a best practice for other Florida transit agencies.
This Technical Memorandum is part one of a 2 part guidance document. Part 2 of the guidance,
provides guidance to FDOT and review agencies that are responsible for reviewing TBEST outputs and
reports as part of the TDP update process. This Technial Memorandum explores the TBEST software
tools that both service and strategic planners need to answer impact questions related to future service,
fare, network and socio-economic conditions. The ability to answer “what-if” questions with a reliable
modeling and analysis environment enables planners to effectively meet the demand for transit
performance forecasting.

Agency implementation and maintenance of the TBEST system provides an

integrated service and strategic planning platform where projects, data, and analysis techniques are
shared to produce an efficient enterprise platform for transit service analysis.
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TBEST utilization for service planning requires a systematic , enterprise approach to implementation and
management within the agency. Establishing a TBEST implementation plan that will guide the agency’s
software installation, data flow, modeling, maintenace and training efforts. Within this document, the
components of the implementation plan are explained and guidance is provided for developing a plan
that best fits the implementing agency’s service and strategic planning needs, available data, and
personnel. The implementation plan is supported by workflows and procedures that assist agency staff
in TBEST model validation, model application, maintenance and analysis.
For a thorough integration with existing TBEST documentation, the current TBEST User Manual is
included as Appendix A in this document. Within the TBEST implementation procedures and workflows,
there are hyperlinked references to concepts, instructions, or graphics within the TBEST User Manual.

Benefits of TBEST Implementation
TBEST is a powerfull planning tool that service and strategic planners which can utilized by planners
throughout the agency to support transit service decision-making and in-depth analysis. By following
the implementation steps outlined in this document, agencies will have access to accurate and up-todate socio-economic data, network and service characteristics for developing strategic and service
planning scenarios. The primary benefit of implementing TBEST at the agency is improved efficiency and
reduced cost while increasing support of the planning process. Listed below are items that represent
the cost saving measures associated with TBEST implementation:
•

The TBEST software has no licensing costs.

•

TBEST software is maintained and continually updated by FDOT.

•

Socio-economic data updates and training opportunities are provided by FDOT.

•

The effort required to maintain the network and service characteristics within TBEST model is
dramatically reduced by implementing the TBEST GTFS Network Import tool. The tool imports
the current transit operations into the TBEST environment using General Transit Feed
Specification (GTFS) files already developed for use with Google Transit. If available at the
agency, the GTFS files eliminate manual network coding for model validation and model
maintenance.
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•

TBEST implementation takes the guess work out of model development. Planners save time by
utilizing an accurate and current TBEST model that is consistently maintained within the
organization.

•

Model application scenarios can be easily shared between strategic and service planners.

•

The workflows and procedures within this document reduce the startup time for model
development and application.

•

The implementation process has been documented from a real-world procedures developed at
LYNX in Orlando.
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TBEST Implementation Overview
TBEST Implementation - Process Flow
TBEST implementation described in this document provides transit agency planners with a structured
environment where the validated TBEST model is constantly maintained and data flow from the
production server to planners and technicians is a documented and regimented process. Due to the
inter-departmental nature of data and software maintenance and integration, TBEST implementation
requires not only coordination between the Strategic and Service Planning departments, but also the
Operations department for access to ‘bids’ (or service changes) that go into production, the IT
department for TBEST installation and external data dissemination, and the GIS department for ArcGIS
licensing and access to GIS data.
When implementing TBEST for service or strategic planning, a validated ‘production’ model is
maintained and is accessible to planners within the agency. As new service or strategic planning
‘projects’ are initiated, the production model is copied to the local planners’ computer. Planners use of
the production model to produce TBEST model application scenarios that apply proposed service or
network improvements to the existing model as part of a planning project. After the model application
project is complete, the TBEST system used for the project is uploaded to a folder on the production file
server that documents the modeling for the project. The modeling results in the form of reports, charts
or maps are disseminated to other agency staff members, the public or external planning agencies.
Over time, as the production model is updated based on implemented service changes, the original
model is archived to have a full accounting of model history within the agency.
The specific instructions for implementing TBEST are incorporated into the model validation,
maintenance, application and analysis workflows and procedures within this document.
Figure 1.1 below illustrates the personnel responsibilities, data flow, and technical specifications for
implementing TBEST.

TBEST Implementation Procedures for Strategic and Service Planning | 4

Figure 1.1 – TBEST Implementation Diagram
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TBEST Personnel Roles
TBEST implementation requires a team of individuals with skills in management, planning, modeling,
GIS, and IT. These staff members will be responsible for software installation, model development,
validation, maintenance, application and analysis.

Table 1.1 below contains the position titles and

responsibilities for agency staff involved in TBEST implementation. Within this document, the position
titles listed in the table will be matched with task responsibilities so that it is clear who within the
agency is to perform the task-level duties.

Position Title
Management
Modeling/GIS
Technician

Service Planner
Strategic Planner
IT Support Staff

TBEST Implementation Personnel Roles
Responsibilities
Initial TBEST implementation plan, coordinating and assigning staff,
coordinating training sessions
TBEST “power user” within the organization. The individual will develop the
base year TBEST network, prepare and execute the model validation,
maintain the base year model as the system network changes over time,
operate the GTFS Import tool (if applicable), provide the validated model to
service planners and strategic planners for model application, and provide
technical support to planners in developing future scenarios.
Develop TBEST scenarios for evaluation of future changes to service and/or
socio-economic conditions
Develop TBEST scenarios to support Transit Development Plans and longer
range land use planning.
Initial installation and update of TBEST software and add-on tools including
the GTFS Import software. IT staff will also be responsible for installation
and maintenance of required third-party software including SQL Server
2005 Express/Enterprise and ArcGIS. Although SQL Server 2005 Express is
included in the TBEST install, the agency has the option of installation SQL
Server 2005 Enterprise if more database capacity is required.
Table 1.1 – TBEST Implementation Personnel Roles

Data Storage
The key data storage device for the production TBEST model and model application projects is the
production file server. This server will house the
validated TBEST model, service planning projects,
strategic planning projects and a history of validated
models.

The production file server should have

approximately 5GB of storage space allocated for
TBEST data.
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The server storage location selected by the agency should have a root \TBEST folder with the data
storage sub-folders listed in the Table 1.2 below. The TBEST models will be stored in TBEST Distribution
File format. For more information on TBEST Distribution Files, See Appendix A – 3.2 TBEST Distribution
Files.
TBEST Implementation – Production Data Storage Folders
Folder
Contents
ValidatedModel
Contains the production, validated TBEST model in TBEST Distribution File
format named with the following nomenclature:
<TransitSystem>_ProductionModel.tds.
ServicePlanningProjects
The ServicePlanningProjects and StrategicPlanningProject directories will
and
contain sub-directories for each planning “project”. Projects are
StrategicPlanningProjects individual service planning or strategic planning model applications. The
project directories are created by planners and should be named with the
following nomenclature: <ProjectName><ddmmyy>. Project folders will
contain the TBEST model application in TBEST Distribution File format.
The TBEST Distribution Files should be named with the following
nomenclature: <TransitSystem>_<ProjectName>.tds. For documentation
of the model application, the project directory should also contain a
completed and scanned version of the TBEST Model Application Scenario
Checklist available in Appendix B.
History
Contains historical models that are taken out of production as new bids
are incorporated into the production model. The models will be stored in
TBEST Distribution File format and should be named with the following
nomenclature: <TransitSystem><ddmmyy>_validation.tds.
Table 1.2 – TBEST Implementation - Production Data Storage Folders

Model Maintenance
As each new operations service bid goes into production, the Modeling/GIS Technician must obtain the
new network and service characteristics. For those agencies that maintain Google Transit data, the
Modeling/GIS Technician must obtain the new GTFS (General Transit Feed Specification) feed from the
operations department. TBEST GTFS Network Import tool can be used to update the production model.
For more on TBEST integration with GTFS, see Appendix C – TBEST GTFS Network Import Tool. If no
GTFS data is available, the Modeling/GIS Technician will need to use the new schedule data to update
the TBEST transit network using the TBEST Network Editor. Once the updates are completed and tested,
the new model will be posted to the production server by the Modeling/GIS Technician.

External Data Distribution
The data and reports developed as part of the TBEST modeling process can be shared with others
outside of the agency including city, county, regional and state planners, GIS data users, and the general
TBEST Implementation Procedures for Strategic and Service Planning | 7

public. External distribution protocols could include through an FTP, server or through web applications
that serve TBEST GIS networks and socio-economic data.

In either case, the agency IT staff would

determine the necessary infrastructure to facilitate this process.

TBEST Installation
TBEST must be installed on each staff member’s computer who will be utilizing the software to maintain
the model or model application.
TBEST should be installed on the machines of the following personnel:
•

Strategic Planners

•

Service Planners

•

Modeling/GIS Technician

TBEST hardware requirements are listed in Appendix A – Hardware Requirements. The hardware listed
are the minimum specifications, additional RAM and CPU with a 64-bit Windows Operating System are
recommended. Each TBEST install requires an ArcGIS 10 to be on the deployment machine with an
active license. For more information on additional software requirements, see Appendix A – Software
Requirements.
TBEST installation and updates require administrative privileges. Most transit agencies have strict
security implemented on client workstations. The protocols for TBEST installation will follow those
established by agency Information Technology department or staff.

After installation, the IT staff

member performing the installation should modify the security permissions on the C:\TBEST folder to
enable full permissions for the local user.
The TBEST installation can be downloaded directly from the TBEST website: www.tbest.org.

On

occasion, software updates will be posted to the TBEST website. Before installation, always check to see
if an updated version of the software is available. If an update is available, it should be installed on all
TBEST machines.
The TBEST technical specifications and installation procedures are listed within Appendix A – TBEST
Configuration.
Each installation will require approximately 1/2-hour of IT-Support Staff time.
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TBEST GTFS Network Import Tool Installation
Follow the directions in Appendix C to obtain and install the GTFS Network Import Tool.

Training
Staff members should be trained to operate TBEST at the level outlined in their personnel roles. For
introductory purposes, a training webinar is being developed and will be located on the website at
www.TBEST,.org . The Modeling/GIS Technician should contact the FDOT Transit Planning Office to
determine any upcoming sponsored training for a thorough and detailed understanding of TBEST
capabilities. If state sponsored courses are not available within a reasonable timeframe, the agency
should plan on developing an in-house training curriculum than includes a one-day training seminar for
service planners on TBEST capabilities
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TBEST Implementation Plan
Prior to TBEST implementation, the agency management team must convene to develop a TBEST
implementation plan. The plan does not require an overwhelming amount of documentation; however,
it does require initial coordination by Service Planning, Strategic Planning and GIS management staff.
The management team will be responsible for developing the implementation schedule, identifying
personnel roles, data management details, and TBEST installation schedule.

Plan Components
The management staff will be responsible for addressing the Plan Components in Table 2.1 as part of the
TBEST implementation plan.

Plan Component
Staffing

Data

Hardware
Schedule
Installation
Training
Analysis (Optional)

TBEST Implementation Plan Components
Management Action
• Match staff members with TBEST Personnel Roles. Include these
personnel in the initial development of the TBEST implementation
plan.
• Determine the availability of GTFS data and it’s compatibility with
TBEST.
• Perform an initial assessment of the available data for model
validation.
• If TBEST information is to be made available externally, establish
the preferred method of access, via web or FTP. External data
deployment is not detailed as part of this document and is up to
the agency to determine how this will be implemented.
• Determine the production TBEST file server with adequate disk
space.
• Establish the TBEST installation schedule
• Establish the model validation schedule
• Assess the availability of ArcGIS licenses
• Identify the TBEST version to install
• Check the TBEST website or contact the Transit Office for training
opportunities
• Determine corridors or other areas that will be commonly used
summarize performance
• Determine performance metrics that are utilized to by the agency
to identify underperforming routes, underserved routes, etc.
• For Mobility Areas, develop threshold trip ranges that match
service recommendations
Table 2.1 – TBEST Implementation Plan Components
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Management and technical staff should meet on at least a quarterly basis to review TBEST model
applications within the agency, identify training opportunities, review TBEST software enhancements
and identify areas that need improvement.

Implementation Schedule
With the initial development of the TBEST implementation plan, the implementation cycle can begin by
initiating the TBEST software installation and model validation tasks. Depending on the complexity of
the transit system and available data, model validation can take anywhere from 3 days to 3 weeks to
complete. After model validation is complete,explore training opportunities on the TBEST website or
contact the FDOT Transit Office. The seminar will provide planners with hands-on experience working
with the agency’s operational TBEST model. model maintenance, model application, and model analysis
are performed on an on-going basis. Maintenance of the model can be minimal if updates to the model
are in the new production system. If the system is being dramatically changed, the model may need to
be re-validated, thus causing extra time for updates. For service and strategic planning, depending on
the complexity of the project, model application scenario development can encompass one hour or
several days. Likewise, model analysis time can range anywhere from ½ hour to one day depending on
the report, chart and/or map products that are needed to properly depict the model output.
The following work plan represents the general timeline for TBEST implementation for strategic and
service planning.
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Figure 2.1 – TBEST Implementation Schedule
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TBEST Modeling Workflows and Procedures
The following sections provide procedural descriptions for tasks and activities related to TBEST
model development, maintenance and application. The procedures will allow personnel to
follow step-by-step instructions for model validation, model maintenance, model application,
and model analysis.

Where applicable, workflows will contain hyperlinks to relevant TBEST

instructions, procedures or concepts contained in the document or appendices.
While the workflow’s represent important aspects of utilizing TBEST for service and strategic
planning, they are not comprehensive in terms of the numerous possibilities for model
application and model analysis. As TBEST evolves and more workflows that support the
planning process are identified, this document will be updated to include those processes. The
panning community is encouraged to experiment with TBEST and provide feedback on your
experiences. New ideas and procedures can benefit not only the contributing agency, but the
community at-large.
Important TBEST Modeling Terms
Prior to describing detailed TBEST procedures, some common terms used in the documentation
are defined below. Please become familiar with these terms before continuing.
•

Base Year Development Scenario - When a model has not been validated, the scenario
where the base year conditions are being developed is known as the Base Year
Development scenario.

•

Base Year Scenario - refers to the scenario which represents the validation year. Once a
model has been validated, TBEST keeps the base year scenario hidden from the TBEST
user interface. To access the base year scenario, the user creates a new scenario. This
newly created scenario will contain all of the base year conditions including the transit
network, service characteristics, socio-economic data and network properties including
fare and transfer stations.

•

Model Application Scenario - refers to the scenario that will be utilized for service or
strategic planning.
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•

Bid – Implemented operational changes to the transit system network and service
characteristics.

Model Validation
TBEST model validation involves development of a Base Year Development Scenario which represents
network structure, service characteristics, socio-economic data, fare, and special generators/amenity
data from a single time-frame. The Base Year Development Scenario is then validated against observed
ridership information from the same time-frame. The result of this section is the production TBEST
model that planners will utilize for model application and analysis.
The TBEST model validation process is supported with easily downloadable and pre-formatted Florida
state-wide Census and Employment data, an enhanced network coding environment, automated
validation procedures and other data input tools to facilitate this process. Agencies are responsible for
data collection, scenario development and model validation.
The model validation task is generally performed by the Modeling/GIS Technician. However, input from
planners, operations and management may be needed during the data collection process.
•

The TBEST model validation process involves two primary workflows: Workflow 1.1 - Model
Validation Data Collection

•

Workflow 1.2 - Developing a Validated TBEST Model
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Workflow 1.1 – Model Validation Data Collection
Operation Steps

1. Transit System Properties
a. Service Area –Identify the counties that make up the System service area
2. Base Year Scenario Properties
a. Target Base Year – year all network and socio-economic data will be assembled and updated to form
the base year model. Generally this will be the current year, but can be any past year where data is
available.
b. Mean Annual Person Wage – used to calculate the value of money in the system service area. For
base year development, this is number for the current year and no growth rate should be entered in
the Scenario Properties dialog.
3. Network
a. If the agency has the GTFS network available from the base year time frame, the TBEST GTFS
Network Import tool can be used to develop the network and route validation collections. See
Appendix C – TBEST GTFS Network Import Tool to review the requirements for using GTFS data.
b. If the agency does not have a GTFS network, the following must be collected from the base year
time frame:
i. Network alignments and stop locations – this could be in the form of general route maps or
ESRI shapefiles that represent the linear route geometry and stop locations in point format.
ii. Schedule– this could be route time tables or other means of determining route schedules.
The schedule information provides headway, service span, stop names, time points,
segment (time point to time point)in-vehicle travel time (IVTT), transfer points, and
interliners, all of which will be coded into a TBEST network.
4. Socio-Economic Data
a. Census Population and InfoUSA Employment Data – TBEST Socio-Economic Support Data contains
county-level population and employment data for the all of Florida. This data is available for
download within TBEST and is fully integrated into the model development process.
b. Zonal Employment Data (Optional) – as an alternative to the address based employment data
provided with the state-wide Socio-Economic data download within TBEST, TBEST also accepts a
zonal (polygon) shapefile with Industrial, Service, Commercial employment coded for each polygon.
The specifications on the file format are listed in Appendix A - 4.2 - Employment Data Sources If this
option is selected, the input employment data must reflect year of the model. TBEST will not apply
growth rates to this data.
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5. Socio-Economic Growth
a. System-Wide Growth Rates - TBEST has a flexible method for applying socio-economic growth when
developing the base year scenario or when developing future year scenarios. When developing for
the base year, growth rates are applied from the source year of the Census data and source year of
the address –based employment data incorporated from the state-wide socio-economic data. At
the time of the creation of this document, the latest data available for population and demographics
is Census 2000 and the latest data available for employment is 2010. In the case where the agency
is developing a base year model for 2011, at a minimum, system-wide compound growth rates for
population and employment should be acquired or calculated. The growth rate applied by TBEST is
a compounded rate based on the duration of years between the data source year and the base year
being developed. If available, TBEST also accepts system-wide growth rates for Total Households
and Income variables.
b. Zonal Population and Employment (optional)– if the system-wide growth rates described above are
not adequate for simulating population and employment spatial distribution changes in the agencies
service area, TBEST has a method for assigning zonal growth rates at the Census Block Group-level.
Implementing this growth mechanism requires a zonal (polygon) dataset with population and
employment numbers that reflect the base year situation. These datasets are often times
developed by MPO’s and DOT for transportation modeling and are available upon request.
Appendix A - 4.3 Applying Socio-Economic Growth Parameters contains more information on TBEST
socio-economic growth calculations.
6. Fare
a. TBEST allows for input of a base fare and transfer fare. If the agencies fare structure is more
complex, utilizing discounted fare cards or other fare policies, it would be better to determine the
average fare per rider as input to the base fare and, if applicable, the transfer fare. TBEST does not
provide a per route fare.
7. Special Generators/Amenities
a. Special Generators are coded at the stop and time period level. In most cases, special generators
can be coded for all time periods. The exception would be Park-n-Ride, where it would mainly
influence AM Peak and/or Off-Peak ridership. Amenities are also coded at the stop-level. For more
information on the TBEST definition of Special Generators/Amenities, see Appendix A – 5.14 Special
Generators and Stop Amenities.
8. Observed Ridership
a. TBEST has a flexible validation procedure that works with the agency’s level of observed ridership
data. TBEST accepts observed ridership for an average Weekday, average Saturday and average
Sunday. The averaging of ridership data can occur over a duration which consistently represents the
system performance. Daily average ridership can be grouped at the following levels:
i. Route by direction – discrete ridership is available for inbound and outbound directions of a
route.
ii. Route in both directions – ridership for a route (both directions) or multiple patterns which
make up one route
iii. Routes grouped by Route Type and Route Technology – for this option, validation could take
place for Express Bus, Radial, Circulators, etc. For smaller systems where there is only one
route type and one route technology, then one observed ridership number could be used to
validate the system.
b. TBEST has an optional stop-level validation for stops which contain an abnormally high number of
riders that cannot generally be explained in base socio-economic or transit service conditions. There
is a limit of 100 of such stops that can be entered for validation.
TBEST Implementation Procedures for Strategic and Service Planning | 16

9. Optional: Determine standard metric queries that may be used to evaluate service or performance on future
year models.
10. Optional: Determine standard Analysis Areas, Corridors, or Site locations that may be used in future year
model update or analysis.
11. Optional: Determine Mobility Area Trip Threshold Ranges with service improvement recommendations
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Workflow 1.2 – Developing a Validated TBEST Model
Operation Steps

Operation Reference

1. Open TBEST
2. Download the most current (or relevant to the proposed Base Year) TBEST SocioEconomic Support Data
3. Create the Transit System
a. Select the source Socio-Economic data
b. Select the counties that make up the system service area
4. Create the Base Year Development Scenario
c. Enter the Scenario name. The name should be: ‘BaseYearModel’
d. Enter the Target Base Year
e. Enter the base year Mean Annual Person Wage for the service area.
f. Enter zero for the wage growth rate.
g. By default, TBEST will utilize InfoUSA employment data, if zonal employment
data is to be used, select the option and reference the file location.
5. Input the Base Year Network
Option A: Utilize the TBEST GTFS Network Import Tool to import the network
a. Place the GTFS feed in a folder on the local computer. If the files are in a .zip
format, un-zip the files before proceding. The folder the feed is placed in
should generally be named for the date of the feed. If Modeling/GIS
Technician has developed the stop_features.txt file containing stop
amenities, special generators and transit hubs, place the file in this folder.
b. If open, close TBEST.
c. Open the TBEST GTFS Network Import tool
d. In Appendix C, follow the steps in the TBEST GTFS Network Import operation
procedure and execute step 7(skipping steps 8 and 9). Check the Select All
checkbox to select all of the routes.
e. Close the TBEST GTFS Network Import tool
f. Open the TBEST
g. Open the Base Year Development Scenario for the model being validated
h. Perform GTFS network quality control steps in Appendix C.
Option B: Digitize the network using the TBEST network coding environment
a. Open the ‘BaseYearModel’ scenario
b. If route and stop geometry are available in shapefiles, reference them in the
TBEST map. This information can only be utilized as a reference to the
location of the routes and stops.
c. Using the TBEST Network Coding environment, input routes, segments,
stops, headway, service span, stop names, time points, segment (time point
to time point)in-vehicle travel time (IVTT), transfer points, and interliners.
6. Input Socio-Economic Growth Rates
a. Based on the available growth data, enter the information into the SocioEconomic Growth dialog.

Appendix A – 3.3
TBEST SocioEconomic Data

Appendix A – 3.9
Scenario Properties

Appendix A – 4.3
Enter Socio
Economic Growth
Rates
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7. Input Network Properties
a. Enter the fare structure. Do not enter a growth rate.
b. Check Time Points that represent transfer hubs.
c. Enter interlined routes.
8. Network Quality Control
d. Run the TBEST model.
e. When the model is completed, use the Scenario Summary tool to develop
route-level reports for Weekday, Saturday and Sunday.
f. Investigate if ridership, socio-economic data, service and performance
measures are reasonable. If any variables are unreasonable, review network
coding and other data input to verify that it is correct.
g. Continue revisions until the model output is reasonable or any
inconsistencies can be explained.
9. Exit TBEST, re-open TBEST and make a copy of the Transit System

Appendix A – 5.15
Network Properties

10. Model Validation
h. If desired, enter any stops that require unique validation
i. Develop route validation collections which match the detail of observed
ridership. If the TBEST GTFS Network Import tool was used to create the
network, route validation collections will already exist.
j. Enter observed ridership for each route validation collection
k. Run the model validation procedure
l. After the model validation procedure, verify that the validation factors are
accurate.
11. Optional: Using the TBEST Search tool, develop and save any standard metric queries
that may be used to evaluate service or performance on future year models.

Appendix A – 6.5
Model Validation

12. Optional: Using the TBEST Analysis toolbar, develop and save any standard Analysis
Areas, Corridors, or Site locations that may be used in future year model update or
analysis

Appendix A – 8.4
TBEST Analysis
Toolbar

Appendix A – 8.1
TBEST Search

13. Optional: Prior to TBEST deployment on service and strategic planning machines, the
Modeling\GIS Technician should develop the Mobility Area Threshold Ranges
following the procedures in Appendix A: 7.3 Defining Mobility Area Thresholds. Once
the thresholds are developed, the Threshold database located at
C:\TBEST\Tools\ScenarioReporting\Thresholds.mdb, should be copied from the
Modeling\GIS Technician’s machine to each of service and strategic planning
machines after TBEST installation. If the Thresholds.mdb file is already present, it
should be over written.
14. Delete any saved TBEST Reports.
15. Create a TBEST Distribution file of the validated system. Name the Distribution File:
‘ProductionTBESTModel_<bid_date>.tds
16. Post the Distribution File the production server to be utilized by service and strategic
planners.
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Model Maintenance
Once a validated model is in production, the model network, service characteristics, socio-economic
must be continually updated to provide planners with reliable information for service or strategic
planning.

In general, TBEST model maintenance activities are triggered when the transit system

operations change. These changes could happen at set time intervals, such as every four months, or as
a response to demand or policy changes. This section provides workflows for two types of production
TBEST model updates:
1. Model update without revalidation
2. Model update with revalidation
In most cases, the production TBEST model can be updated with service changes without being revalidated. This is the easier of the two options, however, if not checked against system performance, it
may not capture short-term trends in ridership patterns.
Below are key factors in determining if a model should be revalidated:
•

Major service changes have been implemented and observed ridership is available for validation

•

A mistake is noted in the original validation

•

Greater than 10% shift in ridership since the original validation

•

The service area has expanded or contracted

•

For new routes or service modifications that were not in the original validation, their TBEST
predicted performance has a greater than 10% differential with the observed ridership.

•

Even if none of the above criteria are true, the model should be revalidated every two years.

To address these factors, prior to updating the model, the Modeling/GIS Technician should acquire the
most recent ridership numbers from the Operations department. These ridership numbers should be
compared with the observed ridership in the model validation to determine if revalidation is warranted.
The Technician should also be apprised of major service changes and determine if those changes again
warrant revalidation.
Maintaining the accuracy of the TBEST model as service bids change presents multiple options for
model update.

The most efficient and accurate method for maintaining a network and service

characteristics is to integrate with the operational data that is the source for the “production” network.
The TBEST GTFS Network Import tool was developed to fill the need to incorporate the latest agency
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network and service characteristics into the existing, validated TBEST model, without any impact to
existing systems or additional network coding. For systems that don’t have their network available in
GTFS format, the TBEST network coding environment can be used to maintain the network as it changes.
The TBEST model maintenance process involves two primary workflows. Based on the utilization of
GTFS data within agency, those two workflows will vary. For agencies using GTFS data, one of the two
following workflows should be selected for updating the production TBEST model:
•

Workflow 2.1 - Updating a validated TBEST Model using the GTFS Network Import Tool

•

Workflow 2.2 - Revalidating a TBEST model utilizing a GTFS Network

For Agencies with no GTFS, one of the two following workflows should be selected for updating the
production TBEST model:
•

Workflow 2.3 - Updating a validated TBEST Model using the TBEST Network Editor

•

Workflow 2.4 - Revalidating a TBEST model using the TBEST Network Editor
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Workflow 2.1 - Updating a validated TBEST Model using the GTFS Network Import Tool
Operation Steps

Operation Reference

1. Obtain the current GTFS feed from the Operations or Planning Department.
*As a time saving task, ask the responsible staff members for information on
which routes have been modified from the previous bid. If this information is not
available, you will need to do a little more work defining TBEST routes to replace
with incoming GTFS routes.
2. Place the GTFS feed in a folder on the local computer. If the files are in a .zip
format, un-zip the files before proceding. The folder the feed is placed in should
generally be named for the date of the feed. If you have developed the
stop_features.txt containing stop amenities, special generators and transit hubs,
place the file in this folder.
3. If not present already on the Modeling/GIS Technician machine, download the
production model from the \ValidatedModel folder on the production server to
the C:\TBEST\DistributableSystems\ folder.
4. Open TBEST
5. Extract the Distribution File so that it is loaded and editable in TBEST.
6. Within the validated TBEST Transit System, make a copy of the ‘BaseYearModel’
scenario. Name the copied scenario ‘GTFSImport’.
7. Close TBEST
8. Open the TBEST GTFS Network Import tool.
9. Follow the steps in the TBEST GTFS Network Import operation procedure and
executing steps 8 and/or 9 (skipping step 7). Use the copied
‘GTFSImport’scenario as the target scenario.
10. Close the TBEST GTFS Network Import tool
11.

Appendix C -TBEST
GTFS Network Import

Open TBEST and then open the ‘GTFSImport’ scenario.

12. Perform the GTFS Network Import Quality Control procedure.

Appendix C - GTFS
Network Import
Quality Control

13. With a clean TBEST network, perform the following:
a. Run the TBEST model and check the option to “Force Socio-Economic
Updates’ on the Model Run dialog.
b. After the model run, verify the ridership numbers are reasonable.
c. Close and re-open TBEST. This will remove any file linkages within TBEST
that may cause problems when copying files.
d. In the validated model, delete the ‘BaseYearModel’ scenario
e. Rename the ‘GTFSImport’ scenario to ‘BaseYearModel’.
f.

Create a TBEST Distribution file with the name:
‘ProductionTBESTModel_<bid_date>.tds
14. On the Production Server, under the \History folder, create a folder with the bid
date for the current production model. Copy the current production TBEST
Distribution file in the \ValidatedModel folder to the newly created folder. Delete
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the existing production model in the \ValidatedModel folder.
15. Upload the distribution file created in Step 11f to the \ValidatedModel folder on
the production server.

Workflow 2.2 – Revalidating a TBEST model utilizing a GTFS Network
Operation Steps

Operation Reference

Option A: Create a new Transit System and import the GTFS Routes. This option would
be selected if the transit network was undergoing major modifications and very few
routes would remain the same from the previous validation.
1. Follow the steps in Workflow 1.2 - Developing a Validated TBEST Model
Option B: Reject the current model validation and import the routes into the base year
development scenario
1. Obtain the GTFS feed that will represent the base year model input from the
Operations or Planning Department
2. Place the feed in a folder on the local computer. If the files are in a .zip format, unzip the files before proceding. The folder the feed is placed in should generally be
named for the date of the feed. If you have developed the stop_features.txt
containing stop amenities, special generators and transit hubs, place the file in this
folder. Depending on the nature of the system changes, this file may need to be
updated for the new validation.
3. Obtain the observed route-level ridership information for the new route structure.
4. Within TBEST, make a copy of the Transit System to be re-validated. The copied
system should be given a name that describes the new validation year.
5. In the copied system, determine the scenario that will be used for the new model
validation. If it is not already, the scenario should be renamed to ‘BaseYearModel’.
If model application scenarios exist that need to be updated with the model
revalidation, keep those those scenarios in the system.
6. Check the TBEST Downloads to verify if updated Socio-Economic data is available.

7. Reject the validation on the target TBEST Transit system.

Appendix A – 3.3
Socio-Economic
Download
Appendix A – 6.5
Reject Model
Validation

8. Open the TBEST GTFS Network Import tool.
9. Follow the steps in the TBEST GTFS Network Import operation procedure, executing
steps 8 and/or 9 (skipping step 7). Use the ‘BaseYearModel’ scenario as the target
scenario.

Appendix C - TBEST
GTFS Network
Import

10. Close the TBEST GTFS Network Import tool
11. In TBEST, open the ‘BaseYearModel’ scenario and perform the following:
a. Open the Scenario Properties window and enter the following properties:
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i. modify the Target Base Year to match the year of the imported
network
ii. modify the Mean Annual Person Wage for the Target Base Year. Do
not enter a growth rate for Mean Annual Wage.
b. Complete the GTFS Network Import Quality Control procedure in Appendix
C.
c. Open the Validation Route Collection dialog and verify that all routes are
placed in a collection. If new routes were added to the network, place the
routes into new collections.

Appendix A – 6.5
Route Validation
Collections

d. In the Validation Observed Ridership dialog, enter the updated observed
ridership numbers.

Appendix A – 6.5
Validation Observed
Ridership

e. Calculate socio-economic growth rates for the ‘BaseYearModel’ scenario.

Appendix A – 4.3
Enter Socio
Economic Growth
Rates

f.

Run the model and check the option to “Force Socio-Economic Updates’ on
the Model Run dialog.
g. After the model run, verify the ridership numbers are reasonable.
h. Run the TBEST Model Validation procedure.
i.

After the model validation procedure, verify that the validation factors are
accurate.
12. In the TBEST Explorer window, for the newly re-validated transit system, review the
Reports, Search Files, Corridors, Area Analysis and Site Analysis files. Remove any of
these that will not be in the production environment. If the revalidated TBEST
Transit System contains only the ‘BaseYearModel’ scenario, skip to step 16.
13. Prior to going into production, the transit system should be copied so that the
production model can be separated from the model with scenario applications. In
the copied transit system with model application scenarios, perform the following
on each scenario other than the ‘BaseYearModel’ scenario:
a. Open the Validation Route Collection dialog and verify that routes are
placed in the proper collection. If a route is in the application scenario that
is not in the base year model, do not place it in a collection.
b. Calculate the socio-economic growth rates.

Appendix A – 6.5
Route Validation
Collections
Appendix A – 4.3
Enter Socio
Economic Growth
Rates

c. Run the model and check the option to “Force Socio-Economic Updates’ on
the Model Run dialog.
d. After the model run, verify the ridership numbers are reasonable.
14. Create a TBEST Distribution file of the copied transit system with model application
scenarios. Provide the distribution file to the Service or Strategic planners that are
responsible developing the scenarios.
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15. In the revalidated model that will go into production, delete all of the scenarios
except the ‘BaseYearModel’ scenario.
16. Create a TBEST Distribution file with the name:
‘ProductionTBESTModel_<bid_date>.tds
17. On the Production Server, under the \History folder, create a folder with the bid
date for the current production model. Copy the current production TBEST
Distribution file in the \ValidatedModel folder to the newly created folder. Delete
the existing production model in the \ValidatedModel folder.
18. Upload the distribution file created in step 16 to the \ValidatedModel folder on the
production server.

Workflow 2.3 - Updating a validated TBEST Model using the TBEST Network Editor
Operation Steps

Operation
Reference

1. Obtain the revised bid information from the Operations Department.
*As a time saving task, ask the responsible staff members for information on which routes
have been modified from the previous bid.
a. Network alignments and stop locations – this could be in the form of general route
maps or ESRI shapefiles that represent the linear route geometry and stop
locations in point format.
b. Schedule– this could be route time tables or other means of determining route
schedules. The schedule information provides headway, service span, stop names,
time points, segment (time point to time point)in-vehicle travel time (IVTT),
transfer points, and interliners, all of which will be coded into a TBEST network.
2. If not present already on the Modeling/GIS Technician machine, download the production
model from the \ValidatedModel folder on the production server to the
C:\TBEST\DistributableSystems\ folder.
3. Open TBEST
4. Extract the Distribution File so that it is loaded and editable in TBEST.
5. Within the validated TBEST Transit System, make a copy of the ‘BaseYearModel’ scenario.
Name the copied scenario ‘NewBaseYearModel’.
6. Open the ‘NewBaseYearModel’ scenario in TBEST.
7. Using the TBEST Network Coding environment, input routes, segments, stops, headway,
service span, stop names, time points, segment (time point to time point)in-vehicle travel
time (IVTT), transfer points, and interliners.
8. When network editing is complete, perform the following:
a. Run the TBEST model and check the option to “Force Socio-Economic Updates’ on
the Model Run dialog.
b. After the model run, verify the ridership numbers are reasonable.
c. Close and re-open TBEST. This will remove any file linkages within TBEST that may
cause problems when copying files.
d. In the validated model, delete the ‘BaseYearModel’ scenario
e. Rename the ‘ NewBaseYearModel’ scenario to ‘BaseYearModel’.
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f.

Create a TBEST Distribution file with the name:
‘ProductionTBESTModel_<bid_date>.tds
9. On the Production Server, under the \History folder, create a folder with the bid date for
the current production model. Copy the current production TBEST Distribution file in the
\ValidatedModel folder to the newly created folder. Delete the existing production model
in the \ValidatedModel folder.
10. Upload the distribution file created on step 8f. to the \ValidatedModel folder on the
production server.

Workflow 2.4 – Revalidating a TBEST model using the TBEST Network Editor
Operation Steps

Operation Reference

1. Obtain the revised bid information from the Operations Department.
*As a time saving task, ask the responsible staff members for information on
which routes have been modified from the previous bid.
a. Network alignments and stop locations – this could be in the form of
general route maps or ESRI shapefiles that represent the linear route
geometry and stop locations in point format.
b. Schedule– this could be route time tables or other means of determining
route schedules. The schedule information provides headway, service
span, stop names, time points, segment (time point to time point)invehicle travel time (IVTT), transfer points, and interliners, all of which will
be coded into a TBEST network.
2. To efficiently compile the new base year network, investigate if service or
strategic planning scenario(s) have been developed that contain routes that will
be part of the revalidation. If there is a single scenario that contains the
majority of routes that are in the new validation, use this Transit System and
scenario as the source scenario for the revalidation. If other scenarios in the
same Transit System or other Transit Systems contain routes that are part of the
new network but are not part of the selected scenario, those routes can be
imported via the Import Routes tool.
3. Obtain the observed route-level ridership information for the new route
structure.
4. Within TBEST, make a copy of the Transit System to be re-validated. The copied
system should be given a name that describes the new validation year.
5. In the copied system, determine the scenario that will be used for the new
model validation. If it is not already, the scenario should be renamed to
‘BaseYearModel’. If model application scenarios exist that need to be updated
with the model revalidation, keep those scenarios in the system.
6. Check the TBEST Downloads to verify if updated Socio-Economic data is
available.
7. Reject the validation on the target TBEST Transit system.

Appendix A – 8.2
Import Routes

Appendix A – 3.3
Socio-Economic
Download
Appendix A – 6.5
Reject Model
Validation
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8. Using the TBEST Network Coding environment, input routes, segments, stops,
headway, service span, stop names, time points, segment (time point to time
point)in-vehicle travel time (IVTT), transfer points, and interliners for the
‘BaseYearModel’ scenario.
9. When network editing is complete, perform the following:
a. Open the Scenario Properties window and enter the following
properties:
i. modify the Target Base Year to match the new base year
ii. modify the Mean Annual Person Wage for the Target Base Year.
Do not enter a growth rate for Mean Annual Wage.
b. Open the Validation Route Collection dialog and verify that all routes are
placed in a collection. If new routes were added to the network, place
the routes into new collections.

Appendix A – 6.5
Route Validation
Collections

c. In the Validation Observed Ridership dialog, enter the updated observed
ridership numbers.

Appendix A – 6.5
Validation Observed
Ridership

d. Calculate socio-economic growth rates for the ‘BaseYearModel’ scenario.

Appendix A – 4.3 Enter
Socio Economic
Growth Rates

e. Run the TBEST model and check the option to “Force Socio-Economic
Updates’ on the Model Run dialog.
f. After the model run, verify the ridership numbers are reasonable.
g. Run the TBEST Model Validation procedure.
h. After the model validation procedure, verify that the validation factors
are accurate.
10. In the TBEST Explorer window, for the newly re-validated transit system, review
the Reports, Search Files, Corridors, Area Analysis and Site Analysis files. Remove
any of these that will not be in the production environment. If the revalidated
TBEST Transit System contains only the ‘BaseYearModel’ scenario, skip to step
16.
11. Prior to going into production, the transit system should be copied so that the
production model can be separated from the model with scenario applications.
In the copied transit system with model application scenarios, perform the
following on each scenario other than the ‘BaseYearModel’ scenario:
a. Open the Validation Route Collection dialog and verify that routes are
placed in the proper collection. If a route is in the application scenario
that is not in the base year model, do not place it in a collection.
b. Calculate the socio-economic growth rates.

Appendix A – 6.5
Route Validation
Collections
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c. Run the model and check the option to “Force Socio-Economic Updates’
on the Model Run dialog.
d. After the model run, verify the ridership numbers are reasonable.
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12. Create a TBEST Distribution file of the copied transit system with model
application scenarios. Provide the distribution file to the Service or Strategic
planners that are responsible developing the scenarios.
13. In the revalidated model that will go into production, delete all of the scenarios
except the ‘BaseYearModel’ scenario.
14. Create a TBEST Distribution file with the name:
‘ProductionTBESTModel_<bid_date>.tds
15. On the Production Server, under the \History folder, create a folder with the bid
date for the current production model. Copy the current production TBEST
Distribution file in the \ValidatedModel folder to the newly created folder.
Delete the existing production model in the \ValidatedModel folder.
16. Upload the distribution file created in step 16 to the \ValidatedModel folder on
the production server.
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Model Application
The TBEST model can test a variety of service, land use, and market scenarios that are useful for the
service or strategic planner. The list below provides a sample of modeling opportunities which support
strategic and service planning:
TBEST Modeling Opportunities
•

New routes

•

Route realignments

•

Socio-Demographic changes

•

Modifying service-Levels

•

Operating speed improvements

•

Transfer potential

•

Fare changes

•

Stop additions/eliminations

In order to implement these types of changes into the TBEST model, planners will need to create model
application scenarios. This section will focus on workflows and procedures that support scenario
creation, documentation, quality control, and data storage.
Model application is primarily intended for service and/or strategic planners to perform. However, the
Modeling/GIS Technician may perform the modeling if the planner does not have the required skill sets.
In this case, the planner would provide the necessary model input to the Modeling/GIS Technician.
Procedurally, the model application process contains the following steps:
1. Model application data collection
2. Production transit system download
3. Develop model application scenario
4. Run the TBEST model
5. Perform model analysis
6. Finalize scenario documentation
7. Project transit system upload
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The model analysis tasks will be detailed in later sections of this document. In this section there are two
primary workflows for model application.
•

Workflow 3.1 - TBEST Model Application – Data Collection

•

Workflow 3.2 - TBEST Model Application - Scenario Development

For model application, data collection is aided by the TBEST Model Application Scenario Checklist in
Appendix B. This form assists the planner in organizing scenario input while simultaneously creating
documentation for the model. If utilized, the form will become a time-saving mechanism for the agency
as planners can easily organize data, and then later quickly refer to the document to assess the contents
of the model.
The Scenario Development workflow includes procedures that will assist the planner in developing
model input. These procedures introduce questions relevant to the task, and then provide the TBEST
action for incorporating the answer into the model. The procedures are referenced within the Scenario
Development workflows.
Model Application – Scenario Development Supporting Procedures
•

Procedure 3.1 - Adding New Routes

•

Procedure 3.2 - Route Realignment

•

Procedure 3.3 - Adding New Stops

•

Procedure 3.4 - Deleting Stops

•

Procedure 3.5 - Deleting Segments

•

Procedure 3.6 - Deleting Routes

•

Procedure 3.7 - Updating Socio-Economic Data for DRI or TOD

•

Procedure 3.8 - Selecting Routes, Segments and Stops
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Workflow 3.1 – TBEST Model Application – Data Collection
Operation Steps

1. Print the TBEST Model Application Scenario Checklist in Appendix B. Fill out the form as data is
collected for the scenario.
2. Transit System Properties
a. Service Area –will the counties that make up the service area of the system change in the
future year? If so, to expand the network outside of the current counties that make up the
service area would require that the model is re-validated. See model re-validation.
3. Scenario Properties
a. Forecast Year – what is the representative year that reflects the expected network and socioeconomic conditions input into the model?
b. Mean Annual Person Wage –What will the mean annual person wage be in the future? If
unknown, what is compound Wage Growth Rate that can be applied?
c. Zonal Employment Data (Optional) – if the model was validated using Zonal Employment Data,
the planner must provide Zonal Employment Data that matches the model forecast year. The
zonal (polygon) shapefile must have Industrial, Service, Commercial employment coded for
each polygon. The specifications on the file format are listed in Appendix A: 4.2 Employment
Data Sources
4. Network
a. New Routes – Procedure 3.1 - Adding New Routes contains the questions that need to be
asked in order to define the new route.
b. Route Realignment - Procedure 3.2 - Route Realignment contains the questions that need to
be asked in order to define route realignment.
c. Do stops need to be added? On which routes? Where?
d. Do stops need to be deleted?
e. Do routes need to be deleted?
f. Do stops need to be re-positioned? Which stops? To where?
g. Will operating speeds/IVTT be adjusted? Which routes?
h. Have the routes that will be modeled in this scenario been built for another TBEST scenario?
Are you combining the impacts of more than one scenario? Which routes will need to be
imported?
5. Service Levels
a. Will any route service spans be adjusted?
b. Will any headways/arrivals be adjusted? On which routes? Which segments? Within a
corridor, or other discrete area? Will the headway/arrivals modifications be an incremental
adjustment or a discrete number?
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6. Socio-Economic Growth
a. System-Wide Growth Rates - When developing model application scenarios, growth rates are
applied from the base year to the forecast year. The planner must estimate an annual
compounded growth rate for population and employment within the service area. If available,
TBEST also accepts system-wide growth rates for Total Households and Income variables.
b. Zonal Population and Employment (optional)– if the system-wide growth rates described above
are not adequate for simulating population and employment spatial distribution changes in the
agency’s service area, TBEST can assign zonal growth rates at the Census Block Group-level.
Implementing this growth mechanism requires a zonal (polygon) dataset with population and
employment numbers that reflect a future year that is at least one-year greater than the base
year. Population and employment estimates are usually developed and maintained by MPO’s
and DOT for transportation modeling and are available upon request. Appendix A - 4.3
Applying Socio-Economic Growth Parameters contains more information on TBEST socioeconomic growth calculations.
c. Localized Growth – will there be any localized socio-economic adjustments such as DRI’s or
TOD’s that would impact predicted growth patterns. This would be a case where a
development will significantly impact the demographics or employment at individual stops or a
group of stops. For options on making these types of adjustments, see Procedure 3.7 Updating Socio-Economic Data for DRI or TOD. For the adjusted stops, localized adjustments
over-ride the application of system-wide or zonal growth rates.
7. Fare
a. Will there be adjustments to the base fare or transfer fare? Will there be an accounting for
inflation between the base year and forecast year?
8. Special Generators/Amenities
a. Will there be any changes to existing Special Generators? Are the changes time period
dependent?
b. If new stops are being added, will they contain any special generator or amenity coding?
c. If there are Park-n-Ride special generators, either new or existing, what is the number of
parking spaces available in the parking lot?
d. For more information on the TBEST definition of Special Generators/Amenities, see Appendix A
– 5.1 Special Generators and Stop Amenities.
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Workflow 3.2 – TBEST Model Application - Scenario Development
Operation Steps

Operation Reference

1. Download the production TBEST model from the \ValidatedModel folder on the
production server to the C:\TBEST\DistributableSystems folder
2. Open TBEST
3. Extract the Distribution File so that it is loaded and editable in TBEST.
4. Within the validated TBEST Transit System, make a copy of the ‘BaseYearModel’
scenario. Give the copied scenario a descriptive name such as:
‘MAS_AddRoute14’. The MAS prefix stands for Model Application Scenario.
5. Modify the Scenario Properties for the new Scenario
a. Enter the Forecast Year
b. Enter the Wage Growth Rate
c. If the model was validated using a zonal employment dataset, a dataset
needs to be referenced that reflects the employment conditions in the
forecast year.
6. Input the Network updates. Perform each as required.
a. Procedure 3.1 - Adding New Routes
b. Procedure 3.2 - Route Realignment
c. Procedure 3.3 - Adding New Stops
d. See Appendix A – 5.12 Moving Existing Stops
e. Procedure 3.4 - Deleting Stops
f. Procedure 3.5 - Deleting Segments
g. Procedure 3.6 - Deleting Routes
h. See Appendix A – 5.7 Updating Operating Speeds
i. See Appendix A – 8.2 Importing Routes from other TBEST scenarios
7. Input Socio-Economic Growth Rates.
a. If the scenario Forecast Year is greater than the Base Year, calculate the
system-wide socio-econmic growth rates.
b. Procedure for updating within a specific Area, Corridor, or Site location
c. Localized growth around DRI or TOD. Refer to Procedure 3.7 - Updating
Socio-Economic Data for DRI or TOD.
8. Input Service-level Changes. Perform each as required.
a. Update headway/arrivals on a Route
b. Update stop headway/arrivals for a time period
c. Update headway/arrivals within a specific Area, Corridor, or Site
location
d. Update route-level Service Span
9. Input Network Properties
a. Enter the proposed fare structure. If the fare will stay the same but still
needs to reflect inflation between the Base Year and Forecast Year,
enter the expected inflation rate.
b. Check values for any proposed transfer hubs
c. Enter proposed interlined routes.

Appendix A – 3.9
Scenario Properties

Appendix A – 4.3
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Appendix A – 5.14
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10. Network Quality Control
a. Run the TBEST model.
b. When the model is completed, use the Scenario Summary tool to
develop route-level reports for Weekday, Saturday and Sunday.
c. Investigate if ridership, socio-economic data, service and performance
measures are reasonable. If any variables are unreasonable, review
network coding and other data input to verify that it is correct.
d. Continue revisions until the model output is reasonable or any
inconsistencies can be explained.
11. Make final adjustments to the TBEST Model Application Scenario Checklist
prepared for this scenario. Scan the document.
12. At this point, the model is ready for reporting and analysis.
13. After the analysis is complete, create a TBEST Distribution File with the
following naming nomenclature: <TransitSystem>_<ProjectName>.tds
14. Create a folder in either the \StrategicPlanningProjects or
\ServicePlanningProjects folder on the production server. The folder should be
named with the following nomenclature: <ProjectName><ddmmyy>. Upload
the Distribution File to the new folder. In the same folder, place the scanned
TBEST Model Application Scenario Checklist.
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Procedure 3.1 - Adding a new Route
Input Options

TBEST Action

1. Route Definition
a. What type of route will it be?
(Radial, Express, Crosstown, or
Circulator)

Create the new route in TBEST using the Route Options
menu in the Route window and select ‘Add a Route’. In
the New Route dialog, enter the Route Type.

b. What technology will the route
use? (Bus, BRT, Light Rail, Heavy
Rail, Street Car, People Mover,
Commuter Rail, Other)
c. What is the name of the new
Route?

In the New Route dialog, enter the Technology.

In the New Route dialog, enter the Route Name and
Directional Description(s).

2. Route Alignment
a. What is the alignment of the new
route?

To define the route alignment in TBEST, use the
Segment toolbar to the digitize the route linear
alignment (Appendix A – 5.8) for both the inbound and
outbound route directions (or single direction if it is a
circulator). The Reverse Route (Appendix A – 5.16) tool
can be used to reverse the direction of the route to
avoid digitizing for both directions.

b. Where are the proposed stop
locations?

Using the Stop toolbar, digitize the stop locations along
all route directions.

i. If stop locations are
unknown, what is the
proposed spacing between
stops?
c. What major transfer locations are
important?

Select Using the Route toolbar, under Route Options
context menu, select Tools, Generate Stops option.

d. Will the route be interlined?

If the new route will be interlined with an existing route
or another proposed route, the Stop Name must be
entered for the stop locations that will interline the
routes. This is for both the inbound and outbound
directions. Once this is accomplished, the Network
Properties form can be utilized to code the interlining.

e. Will any of the transfer be timed?

If the new route will have a timed transfer with an
existing route or another proposed route is a timed
transfer, enter the transfer station in the Network
Properties (Appendix A – 5.15).

If stop transfer locations are important, make sure that
transfer stops are digitized within 500 ft of transfer stop
on other route. You can use the the Distance tool on
the Map toolbar to measure the distance between two
stops on the map.
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f.

What operating speed(s) will the
route utilize?

Develop segments to represent changing roadway or
operating speeds. See Appendix A – 5.7 TBEST
Segment Calculator

3. Service
a. What times of day will the route
operate?

Using the Service Span dialog, enter the service span in
hours for the Weekday time periods (AM Peak 6-9, OffPeak 9-3, PM-Peak 3-6, Night 6-6) .

b. Will it operate on the weekend
with a different schedule?

Using the Service Span dialog, enter the service span in
hours for the Weekday time periods (Saturday,Sunday) .

c. What are expected the headways?

In TBEST, headways are coded at the stop/time period
level.

4. Demographic
a. Given a system-wide growth rate,
does the population, demographic
and employment data current
being applied in the model
accurately reflect the future
conditions for the proposed route?
b. If the answer to a. is no, what is
the planned population and
employment that will be present
when the route is in place? An
example of this situation would be
a DRI or TOD where the density
and demographics will
substantially change in future
years.
5. Special Generators/Amenities

If yes, no action is necessary.

The socio-economic conditions represented in the
source Census and Employment data do not adequately
reflect the future conditions. This will require the
planner to estimate the general density of poulation
and employment around each proposed stop and the
expected demographic distribution. See Procedure 3.7 Updating Socio-Economic Data for DRI or TOD.

a. Code Special Generators

Special Generators are coded at the stop and time
period level. In most cases, special generators can be
coded for all time periods. The exception would be
Park-n-Ride, where it would mainly influence AM Peak
and/or Off-Peak ridership. See Appendix A – 5.14
Special Generators.

b. Code Amenities (Optional)

At present, amenities have no impact on the model so
they will not influence the model prediction. See
Appendix A – 5.14 Stop Amenities.
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Procedure 3.2 - Updating Socio-Economic Data
for DRI or TOD
Input Options

TBEST Action

If not already open, open the Model
Application Scenario
2. Select the Stops to update

See Procedure 3.8 - Selecting Routes, Segments and Stops

3. Show the Socio-Economic stop-level variables

See Appendix A – 5.11 Show Socio-Economic Variables

4. Three options to update the Socio-Economic
attributes:

By modifying TBEST generated socio-economic attributes,
when the TBEST model run is performed, the system-level
socio-economic growth rate calculations are no longer
performed on the modified stop(s). To revert the stops
out of this edited mode, see Appendix A – 8.3 Stops with
Localized Socio-Economic Adjustments

1.

a. If each stop will contain a unique
value for the attribute.

In the Stops window, enter the cell that contains the
socio-economic data to be updated and enter the value
directly in the cell.

b. If multiple stops will contain the
same value for the attribute.

Select the stops to be updated. On the Stop toolbar,
select the Calculator button or in the Stop Options menu,
select Calculator. In the Calculator dialog, select the
Socio-Economic variable to be updated and enter the
value in the ‘Set a Value’ text box. Click the Update
button to perform the update.

c. If multiple stops will be updated
with a percentage increase or
decrease of the existing attribute
value. *Note: if stops have an
original value of zero for the
Socio-Economic variable to be
updated, the percentage increase
or decrease will have no impact
on the number. These stops
should be individually
investigated for their future year
socio-economic conditions.

Select the stops to be updated. On the Stop toolbar,
select the Calculator button or in the Stop Options menu,
select Calculator. In the Calculator dialog, select the
Socio-Economic variable to be updated and enter the
percent adjustment value in the ‘(+/-) % of Current Value’
text box. Click the Update button to perform the update.
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Procedure 3.3 - Route Realignment
Input Options

TBEST Action

1.

Open the Model Application Scenario

2.

Activate the route to be modified for
editing

See Appendix A – 5.4 Activate Route For Editing

3. Route Alignment
a. What is the alignment of the
new route?

To define the route alignment in TBEST, use the Segment
toolbar to delete the existing portion of the route that will
be re-aligned. This may require that existing segments
are split (Appendix A – 5.8) at the point of the proposed
route divergence. Digitize the route linear alignment
(Appendix A – 5.8) for both the inbound and outbound
route directions (or single direction if it is a circulator).

b. Where are the proposed
stop locations?

Using the Stop toolbar, digitize the stop locations along
the realignment.

c. What major transfer
locations are important?

If stop transfer locations are important, make sure that
transfer stops are digitized within 500 ft of transfer stop
on other route. You can use the the Distance tool on the
Map toolbar to measure the distance between two stops
on the map.

d. Will the route be interlined?

If the new route will be interlined with an existing route
or another proposed route, the Stop Name must be
entered for the stop locations that will interline the
routes. This is for both the inbound and outbound
directions. Once this is accomplished, the Network
Properties form can be utilized to code the interlining.

e. Will any of the transfer be
timed?

If the new route will have a timed transfer with an
existing route or another proposed route routes is a timed
transfer, the

f.

Develop segments to represent changing roadway or
operating speeds. See Appendix A – 5.7 TBEST Segment
Calculator

What operating speed(s) will
the route utilize?

4. Service
a. What times of day will the
realignment operate?

Using the Service Span dialog, enter the service span in
hours for the Weekday time periods (AM Peak 6-9, OffPeak 9-3, PM-Peak 3-6, Night 6-6) .

b. Will it operate on the
weekend with a different
schedule?
c. What are expected the
headways?

Using the Service Span dialog, enter the service span in
hours for the Weekday time periods (Saturday,Sunday) .
In TBEST, headways are coded at the stop/time period
level.
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5. Demographic
a. Given a system-wide growth
rate, does the population,
demographic and
employment data current
being applied in the model
accurately reflect the future
conditions for the proposed
realignment?
b. If the answer to a. is no,
what is the planned
population and employment
that will be present when
the route is in place? An
example of this situation
would be a DRI or TOD
where the density and
demographics will
substantially change in
future years.
6. Special Generators/Amenities

If yes, no action is necessary.

The socio-economic conditions represented in the source
Census and Employment data do not adequately reflect
the future conditions. This will require the planner to
estimate the general density of population and
employment around each proposed stop and the
expected demographic distribution. See Procedure 3.7
Updating Socio-Economic Data for DRI or TOD.

a. Code Special Generators

Special Generators are coded at the stop and time period
level. In most cases, special generators can be coded for
all time periods. The excpetion would be Park-n-Ride,
where it would mainly influence AM Peak and/or Off-Peak
ridership. See Appendix A – 5.14 Special Generators.

b. Code Amenities (Optional)

At present, amenities have no impact on the model so
they will not infuence the model prediction. See
Appendix A – 5.14 Stop Amenities.
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Procedure 3.4 - Adding Stops
Input Options

TBEST Action

1. Open the Model Application Scenario
2. Activate the route to be modified for
editing
3. Stop Locations

See Appendix A – 5.4 Activate Route For Editing

a. Where are the proposed stop
locations?

Using the Stop toolbar, digitize the stop locations along
the realignment.

b. What major transfer
locations are important?

If stop transfer locations are important, make sure that
transfer stops are digitized within 500 ft of transfer stop
on other route. You can use the the Distance tool on the
Map toolbar to measure the distance between two stops
on the map.

c. Will any of the transfer be
timed?

If the new route will have a timed transfer with an
existing route or another proposed route routes is a
timed transfer, the

d. What are expected the
headways?

In TBEST, headways are coded at the stop/time period
level.

4. Service

5. Demographic
e. Given a system-wide growth
rate, does the population,
demographic and
employment data current
being used for model
accurately reflect the future
conditions?
f. If the answer to a. is no, what
is the planned population
and employment that will be
present when the route is in
place? An example of this
situation would be a DRI or
TOD where the density and
demographics will
substantially change in future
years.
6. Special Generators/Amenities

If yes, no action is necessary.

The socio-economic conditions represented in the source
Census and Employment data do not adequately reflect
the future conditions. This will require the planner to
estimate the general density of poulation and
employment around each proposed stop and the
expected demographic distribution. See Procedure 3.7Updating Socio-Economic Data for DRI or TOD.
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g. Code Special Generators

Special Generators are coded at the stop and time period
level. In most cases, special generators can be coded for
all time periods. The excpetion would be Park-n-Ride,
where it would mainly influence AM Peak and/or Off-Peak
ridership. See Appendix A – 5.14 Special Generators.

h. Code Amenities (Optional)

At present, amenities have no impact on the model so
they will not infuence the model prediction. See
Appendix A – 5.14 Stop Amenities.

Procedure 3.5 - Deleting Stops
Input Options

TBEST Action

1. Open the Scenario
2. Select the stops to be deleted

See Procedure 3.8 - Selecting Routes,
Segments and Stops

3. Delete the stops

See Appendix A – 5.12 Delete Stops

Procedure 3.6 - Deleting Segments
Input Options

TBEST Action

1. Open the Scenario
2. Select the stops to be deleted

See Procedure 3.8 - Selecting Routes,
Segments and Stops

3. Delete the stops

See Appendix A – 5.12 Delete Stops

Procedure 3.7 - Deleting Routes
Input Options

TBEST Action

1. Open the Scenario
2. In the Route Window, select the route(s) to be deleted
3. Delete the Routes

See Appendix A – 5.4 Delete Route(s)
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Procedure 3.8 - Selecting Routes, Segments
and Stops
Procedure Steps

TBEST Action

1. Route Selection
a. Select an individual route(s)

b. Select routes that meet a
certain criteria or metric

To select routes in the Route list, click the route in the list.
Shift + Click to select multiples. To select a route by
direction, expand route node and select the directional
portion of the route.
Use the Search Tool (Appendix A – 8.1) and select Routes
as the Category in the Build Criteria Statement box or Open
an saved Search File (Appendix A – 8.1) and execute the
search

2. Segment Selection
a. Select an individual segment(s)

Select Using the Map (Appendix A – 5.6) or Select in
Segments Grid (Appendix A – 5.6)

b. Select all segments in the
system

Select the first segment listed in the segment grid, scroll
down to end of the list of segments in the grid and Shift +
Click the last segment

c. Select stops on a route(s)

Activate Route For Editing (Appendix A – 5.4); Select the
first highlighted segment in the segment grid, scroll down
to the last highlighted segment in the grid and Shift + Click
the last highlighted segment

d. Select segments that meet a
certain criteria or metric

Use the Search Tool (Appendix A – 8.1) and select
Segments as the Category in the Build Criteria Statement
box or Open an saved Search File (Appendix A – 8.1) and
execute the search

3. Stop Selection
a. Select an individual stop(s)

Select Using the Map (Appendix A – 5.6) or Select in
Segments Grid (Appendix A – 5.6)

b. Select all stops in the system

Change the stop view to show all stops(Appendix A – 5.11);
Select the first stop listed in the stops grid, scroll down to
end of the list of stops in the grid and Shift + Click the last
stop

c. Select stops on a route(s)

Activate Route For Editing (Appendix A – 5.4); Select the
first stop in the stops grid, scroll down to the last stop in
the grid and Shift + Click the stop

d. Select the stops on a
segment(s)

Select a segment or multiple segments in the Segment grid;
use the Select Stops on Segments (Appendix A – 5.11) tool
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e. Select stops that are only within
an Area Analysis, Corridor, or
Site Analysis

Create an Area Analysis (Appendix A – 8.5) to select stops
or Open an Existing Area Analysis to select stops (Appendix
A – 8.7);
Create a Corridor (Appendix A – 8.7) to select stops or
Open an Existing Corridor to select stops (Appendix A –
8.7);
Create a Site Analysis (Appendix A – 8.6) to select stops or
Open an Existing Site Analysis to select stops(Appendix A –
8.7);

f.

Use the Search Tool (Appendix A – 8.1) and select Stops as
the Category in the Build Criteria Statement box or Open
an saved Search File (Appendix A – 8.1) and execute the
search

Select stops that meet a certain
criteria or metric
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Model Analysis
The TBEST software platform provides numerous tools to query (spatial and tabular), map, chart and
summarize the TBEST model results and model variables. Model analysis can be performed on any
scenario. The list below provides a sample of model analysis opportunities which support strategic and
service planning:
TBEST Model Analysis Opportunities
•

Route and System Performance Measures

•

Segment Reporting

•

Stop Reporting

•

Regional Analysis

•

Corridor, Site or Area Analysis

•

Metrics for Testing Service Changes

•

Custom Map Development with a TBEST Loaded Network

•

Scenario Summary Tool

The possibilities for analyzing TBEST data extends well past the opportunities listed above.
Combinations of summary options and variable selections put the power of analysis in the hands of the
user. This section will provide the basics of constructing reports, maps, charts and also provide
integration with the model application process.
For the planner, the type of analysis to perform is based on specific project requirements and the level
of detail necessary to illustrate the project outcome. Since TBEST estimates ridership at the stop-level
and associates socio-economic data to the stop-level, it is possible to aggregate output to the segment,
route, system or geographic area. Additionally, since the model predicts ridership for six time periods,
it is also possible to summarize the data based on a single time period, aggregated time periods
(Weekday, Weekend), or to expand the summaries to Weekly, Monthly or Yearly.
The TBEST implementation plan calls for optional development of agency-wide performance metrics,
corridors, sites, or other geographic areas, and Mobility Area thresholds. If implemented, all of these
analysis specifications can be utilized to perform standard data summaries.

Planners across the

organization can easily perform summarizations that would otherwise take time to develop and
understand.
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Route and System Performance Reporting
Performance reporting is a standard summary tool within the TBEST software. Much of the value of
developing a transit model is to evaluate performance in “what-if” scenarios. Route performance
reports can be generated for all routes, selected routes, or unique route groupings. For all route
performance reports, the total system performance measures are tabulated at the bottom of the report.
The exception to this is when only selected routes are summarized, in which case the total performance
for the selected routes is summarized.

The following workflows describe the development of

performance reports:
•

Workflow 4.1 - Performance Reports by Route Type

•

Workflow 4.2 - Performance Reports by Technology

•

Workflow 4.3 - Performance Reports by Route Validation Collection

•

Workflow 4.4 - Performance Reports by Route Direction

•

Workflow 4.5 - Performance Reports by Route Name

•

Workflow 4.6 - Performance Reports for All Routes

•

Workflow 4.7 - Performance Report for Selected Routes
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Workflow 4.1 –Performance Reports by Route Type
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog will open.
5. On the TBEST Reports dialog, select Weekday as the Time Period and Route Type as the Grouping. Note: any
TBEST Time Period can be selected to summarize the performance.
6. Click Apply. TBEST Performance Measures are summarized for the Route Types within the system. The system
performance measures are summarized at the bottom of the report.
7. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_byRouteType’.
Report Sample
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See Appendix A – 7.1
Route Perfomance

Workflow 4.2 –Performance Reports by Technology
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog will open.
5. On the TBEST Reports dialog, select Weekday as the Time Period and Route Technology as the Grouping. Note:
any TBEST Time Period can be selected to summarize the performance.
6. Click Apply. TBEST Performance Measures are summarized for the Route Technologies within the system. The
system performance measures are summarized at the bottom of the report.
7. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_byTechnology’.
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See Appendix A – 7.1
Route Perfomance

Report Sample
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Workflow 4.3 –Performance Reports by Route Validation Collection
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog will open.
5. On the TBEST Reports dialog, select Weekday as the Time Period and Route Validation Collections as the
Grouping. Note: any TBEST Time Period can be selected to summarize the performance.
6. Click Apply. TBEST Performance Measures are summarized for the Route ValidationCollections within the
system. The system performance measures are summarized at the bottom of the report.
7. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_byRouteCollections’.
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See Appendix A – 7.1
Route Perfomance

Report Sample
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Workflow 4.4 –Performance Reports by Route Direction
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog will open.
5. On the TBEST Reports dialog, select Weekday as the Time Period and Route Direction as the Grouping. This
report will summarize the unique route directional names within the system. For example: if route Directional
Descriptions are populated with values of either ‘Inbound’ and ‘Outbound’ for all routes, this report will
summarize performance for Inbound and Outbound. Note: any TBEST Time Period can be selected to
summarize the performance.
6. Click Apply. TBEST Performance Measures are summarized for each Route by Direction. The system
performance measures are summarized at the bottom of the report.
7. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_byDirection’.
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See Appendix A – 7.1
Route Perfomance

Report Sample
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Workflow 4.5 –Performance Reports by Route Name
Operation Steps
1. Open TBEST

Operation Reference

2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog will open.
5. On the TBEST Reports dialog, select Weekday as the Time Period and Route Name as the Grouping. Note: any
TBEST Time Period can be selected to summarize the performance.
6. Click Apply. TBEST Performance Measures are summarized for each Route Name. The system performance
measures are summarized at the bottom of the report.
7. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_byRouteName’.
Report Sample
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See Appendix A – 7.1
Route Perfomance

Workflow 4.6 –Performance Reports for All Routes
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must
be run before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8 Model
Status

4. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog
will open.
5. On the TBEST Reports dialog, select Weekday as the Time Period and No Grouping as the Grouping.
Note: any TBEST Time Period can be selected to summarize the performance.

See Appendix A – 7.1 Route
Perfomance

6. Click Apply. TBEST Performance Measures are summarized for each Route Name. The system
performance measures are summarized at the bottom of the report.
7. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_AllRoutes.
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Report Sample
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Route selections are accomplished by either using the TBEST Search tool or by individually selecting
routes in the Routes window. The following workflow illustrates using the Search tool to select only
routes with ‘Inbound’ directional description and then create a performance report based on that
selection. For more information on methods of Route Selection, see the Procedure 3.8 - Route, Segment
and Stop Selection.
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Workflow 4.7 –Performance Report for Selected Routes
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Under the Scenario menu on the main toolbar, select Search. The TBEST Attribute Search dialog will open.
5. On the TBEST Attribute Search dialog, build the following criteria statement for Routes: ([Direction
Description] Like '%Inbound%')

See Appendix A – 8.1
Search Tool

6. Click the Apply button. The Route window will display the selected routes.
7. Close the Attribute Search dialog.
8. Under the Reports menu on the main toolbar, select Route Performance. The TBEST Reports dialog will open.
9. On the TBEST Reports dialog, select Weekday as the Time Period and in the Routes to Summarize section,
select the Selection Only option. Note: any TBEST Time Period can be selected to summarize the
performance.
10. Optionally, the Map Results option can be checked. This option should be selected when then number of
selected routes is less than 10. Otherwise, the map can become to cluttered and illegible.
11. Click Apply. TBEST Performance Measures are summarized for the selected routes. The total performance
measures for the selected routes are summarized at the bottom of the report.
12. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Performance_InboundRoutesOnly’.
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See Appendix A – 7.1
Map Results Option

Report Sample
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Segment Reporting
Evaluating ridership projections at the segment level can provide insight to the impact of route
realignments, additional stops on a route segment, or removal of service on a segment or segments. In
addition, evaluating segments with a common attribute, such as those within a corridor or other userdefined designation, can provide insight into rider behavior in the specific areas. TBEST performance
reporting provides a Segment Analysis which provides the ability to report the ridership for all segments,
selected segments or segments that have been ‘tagged’ with a Corridor ID. The following workflows
describe the development of segment analyses:
•

Workflow 4.8 - Segment Reporting for Realigned Route - a sample for creating a route
realignment, and then reporting the difference between the original route structure and the
new route structure at the segment level.

•

Workflow 4.9- Segment Reporting by User-Defined Tag - sample for coding selected segments
with an IDs and then creating a report which subtotals predicted ridership for each CorridorID
“tag”.

•

Workflow 4.10 - Ridership Report for Selected Segments - illustrates using the Select Map
Segment tool to select segments that intersect a user clicked point on the TBEST map.

For

more information on methods of segment selection, see the Procedure 3.8 - Route, Segment
and Stop Selection.
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Workflow 4.8 – Segment Reporting for Realigned Route
Operation Steps

Operation Reference

1. Open TBEST
2. For a validated TBEST Transit System, copy the ‘BaseYearModel’ scenario and give the copied scenario a
3. Open the scenario.
4. Activate the route direction that will be realigned.

See Appendix A – 5.4
Activate Route

5. At the point that the route will realign, use the Split Active Route Segment tool button on the Segment toolbar
to split the existing segment at that point. If segment already terminates at this location, do not split the
segment.
6. Activate the opposite route direction if it will be realigned. Repeat Step 5.

See Appendix A – 5.8
Split Segment

7. In the Segment Grid, select the segments that will be realigned.
8. Under the Reports menu on the main toolbar, select Segment Analysis. The TBEST Reports dialog will open.
9. On the TBEST Reports dialog, select Weekday as the Time Period and in the Segments to Summarize section,
select the Selection Only option. Note: any TBEST Time Period can be selected to summarize the
performance.
10. On the TBEST Reports dialog, click the Apply button. Direct, Transfer and Total Boardings are summarized for
the selected segments. The total for the selected segments are summarized at the bottom of the report.
11. Save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_RealignmentRoute<RouteNumer>’. Close the Report.
12. Activate the route direction that will be realigned.

See Appendix A – 7.1
Segment Report

13. Delete the segments that are after the split location in the direction of travel. When completing this for step
for the route opposite direction, delete the segments that are before the split location.
14. Use the Add Route Segment tool button on the Segment toolbar to digitize the new segment(s) that define the
realignment.

See Appendix A – 5.8
Add Route Segment

15. For each new Route Segment, use the Segment Calculator to enter the bus(or other technology) operating
speed on the route for each timeperiod.

See Appendix A – 5.7
Segment Calculator
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16. Once the segments are complete, use the Add Stop tool button on the Stops toolbar to add stops on the
realigned section of the route.
17. Using the Stop grid or the Stop Calculator tool on the Stop toolbar, add the Headway/Arrivals and, if required,
Special Generators and Amenities for the new stops for each TBEST time period.

See Appendix A –
5.12 Add Stop
See Appendix A –
5.13 Stop Calculator

18. If both route directions will be realigned, then repeat steps 3-8 of this workflow for the other route direction.
19. In the Route List, select the Route that was realigned. In the Route Options menu, select Tools and then select
Calculate Travel Time. The stop-to-stop travel times will be updated on the selected route.

See Appendix A –
5.16 Calculate Travel
Time

20. Save the scenario and run the TBEST model.
21. After the model run, repeat steps 7-11 but don’t close the report when finished.
22. In the TBEST Explorer window, open the report that was saved for the original scenario.

See Appendix A – 7.4
Open Report

23. With the two reports open in Excel, copy the total from all segments from one Excel sheet to the other. Use
the Excel summary tools to calculate the difference in ridership after the realignment.
Workflow 4.9 – Segment Reporting by User-Defined Tag
Operation Steps

Operation Reference

1. Open TBEST
2. Open a Scenario or create a new Scenario.
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.

See Appendix A – 3.8
Model Status

4. Using either the Segment Map selection tool or select Segments in theSegment grid, define the segments
that will receive the Corridor ID. If using the Segment Map selection tool, Shift + Click on the map to select
at multiple locations.
5. Use the Segment Calculator to calculate the Corridor ID for the selected segments.
6. Under the Reports menu on the main toolbar, select Segment Analysis. The TBEST Reports dialog will open.
7. On the TBEST Reports dialog, select Weekday as the Time Period and in the Segments to Summarize section,
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See Appendix A – 7.1
Segment Analysis

select the All Segments option. Note: any TBEST Time Period can be selected to summarize the
performance.
8. On the TBEST Reports dialog, click the Apply button. Direct, Transfer and Total Boardings are summarized
for the selected segments. The total for the selected segments are summarized at the bottom of the report.
9. Save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_SegmentbyCorridor’.
Report Sample
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Workflow 4.10 –Ridership Report for Selected Segments
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.
4. On the Segments toolbar, select the Select Edit Segment tool button.
5. With the Select Edit Segment tool button active, click a point on the map where several segments overlap.
After the click, the map and segments grid selections will update with the segments at that location.
6. Under the Reports menu on the main toolbar, select Segment Analysis. The TBEST Reports dialog will open.
7. On the TBEST Reports dialog, select Weekday as the Time Period and in the Segments to Summarize section,
select the Selected Segments option. Note: any TBEST Time Period can be selected to summarize the
performance.
8. Click Apply. In the resulting Segment Summary Report, ridership is provided for each of the selected segments.
The total ridership for the selected segments is summarized at the bottom of the report.
9. If desired, save the Report. Give the report a descriptive name such as:
‘<ScenarioName>Weekday_Segments_<atmaplocation>’.
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See Appendix A – 3.8
Model Status

Report Sample
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Stop Reporting
The ability of the TBEST model to estimate ridership at the stop-level provides a great tool for analyzing
the model results based on the impact of other variables at the stop including service levels, walkdistance socio-economic market, ridership levels as compared to other stops, and many combinations of
data that best tell the story of what is impacting performance at any given stop in the system. For more
information on methods of Stop Selection, see Procedure 3.8 - Route, Segment and Stop Selection. Stop
reporting can also be performed for all stops in the system.
For a workflow example involving Stop Reporting, see Workflow 1.2 – Corridor Updating and Stop
Reporting.
Regional Analysis
Summarize service or ridership by Zones. Zones could be any user input polygon shapefile including
local municipalities, Census Block Group, or any other planning areas. Appendix A - Regional Analysis
contains the procedural description.
Corridor, Site or Area Analysis
The ability to geographically identify analysis areas within the service boundaries and summarize
ridership within those areas is a key component of the TBEST software. The Analysis Toolbar provides
tools to define and save user designed or specified areas that will be updated and/or analyzed. Within
TBEST, the geographic areas are segregated into Corridors, Areas, and Sites. Once developed, the saved
areas can be opened in multiple scenarios to summarize ridership differences across scenarios. In
addition, these areas are integrated into the TBEST Scenario Summary tool and into the process for
developing Sector Scenarios.
The following workflow illustrates creating a Corridor, updating service within the Corridor, and then
comparing the results with the base year model. While this example uses a Corridor, the same
procedures would apply if a Site or Area were used to define the area.

TBEST Implementation Procedures for Strategic and Service Planning | 65

Workflow 4.11 – Corridor Updating and Stop Reporting
Operation Steps

Operation Reference

1. Open TBEST
2. Create a Model Application Scenario

3. Using the Analysis Toolbar, create a Corridor based on project requirements using a ¼ mile buffer around the
Corridor delineation.

See Workflow 3.2 Scenario
Development
See Appendix A – 8.4
Analysis Toolbar

4. Save the Corridor. Give the Corridor a descriptive name based on the project description.
5. Using the Refresh the Selection button the Analsysis Toolbar, update the stop selection to the stops that reside
within the Corridor.

See Appendix A – 8.4
Refresh Selection

6. Use the Stop Calculator on the Stop Toolbar to increase the Commercial Employment by 20%.

See Appendix A –
5.13 Stop Calculator

7. Save the Scenario and run the model.
8. After the model run, re-open the Corridor created in step 3 and refresh the stop selection using the Refresh the
Selection button the Analsysis Toolbar.

See Appendix A – 8.4
Refresh Selection

9. Under the Reports menu on the main toolbar, select Stop Ridership. The TBEST Reports dialog will open.
10. On the TBEST Reports dialog, select Weekday as the Time Period and verify that the All Stops option is selected
in the Stops to Summarize panel. Note: any TBEST Time Period can be selected to summarize the ridership.
11. Click Apply. The total ridership within the Corridor is totaled at the bottom of the report.
12. Save the Report. Give the report a descriptive name such as: ‘<ScenarioName>Weekday_<CorridorName>’.
13. Close the Scenario and open the ‘BaseYearModel’ scenario.
14. In the ‘BaseYearModel’ scenario, open the Corridor created in step 3 and refresh the stop selection using the
Refresh the Selection button the Analsysis Toolbar.
15. Under the Reports menu on the main toolbar, select Stop Ridership. The TBEST Reports dialog will open.
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See Appendix A – 7.1
Stop Reporting

16. On the TBEST Reports dialog, select Weekday as the Time Period and verify that the All Stops option is selected
in the Stops to Summarize panel. Note: any TBEST Time Period can be selected to summarize the ridership.
17. Click Apply. The total ridership within the Corridor is totaled at the bottom of the report.
18. Save the Report. Give the report a descriptive name such as: ‘<ScenarioName>Weekday_<CorridorName>’.
19. In the TBEST Explorer panel, under the Reports folder in the source Transit System, open the report created in
step 12.
20. In Excel, combine the totals of the two reports to tabulate the ridership differences within the corridor
between the two scenarios.
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Report Sample
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Corridor Definition
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Metrics for Testing Service Changes
Metrics allow the planner to quickly identify routes, segments or stops that are not meeting
performance or other metric criteria set forth by the agency. Within TBEST, metrics are developed using
the Search Tool. Within the tool, criteria statements can be constructed using network, service,
ridership, performance, and socio-economic l variables. The criteria statements can combine multiple
variable criteria. The following statements are examples of the types of criteria that can be generated
and then applied to the TBEST scenario:
•

Express routes with < 1 average boardings per service hour in the AM PEAK and Headway at 30
minutes

•

Express Routes with average boardings per stop visit < 5

•

Stops with Population < 10 and Service Employment < 10 and Total Boardings > 0

When applied, the Search Tool will return a selection of Routes, Segments or Stops. From the selection,
the user can generate a report to summarize the results. For procedural descriptions for creating and
opening Search Files, see Appendix A – 8.1 Attribute Search.
Custom Map Development with a TBEST Loaded Network
With the many input and output variables that are maintained and processed within the TBEST
environment, it can be a challenge to combine data variables into a sophisticated display which
illustrates the dynamics and inter-relationships of a particular scenario. The TBEST Loaded Network
provides a data output which planners can utilize to combine network, service, travel-time, socioeconomic, performance, special generator, amenity, and nearly all TBEST variables.

The Loaded

Network tool will produce an ESRI Personal Geodatabase (Microsoft Access database) containing TBEST
attributes ‘loaded’ into a stops layer and a segments layer. The loaded layers can be manipulated within
TBEST, ArcMap, or Microsoft Access to display combinations of variables within maps, charts, tables or
reports. This output gives the planner a tremendous opportunity to maximize the use of TBEST data.
The procedure for creating the Loaded Network is provided in Appendix A- 8.9 Loaded Network. The
possibilities for analysis are numerous within ArcMap and Access environments.

Within the

organization, GIS or database specialists should be consulted for utilizing the loaded network within
these environments. Within TBEST, the loaded network output is referenced into the TBEST Map. The
TBEST Map allows users to right-click and access the ArcMap Layer Properties dialog for a layer in the
map. Within the Layer Properties dialog, users are able to set properties for symbolizing layer features
TBEST Implementation Procedures for Strategic and Service Planning | 70

based on attribute values. For example, the user can produce a map where the size of a stop location is
proportional to the number of zero-vehicle dwelling units are within the market area of the stop.
Likewise, the user can produce a map where the width of each transit network segment is proportional
to the total boardings on that segment during the output time period. The Layer Properties dialog also
allows the user to label features and set visibility for select features.
As an example, a request for a TBEST mapping analysis using a loaded network could include the
following:
For a given scenario, produce a map containing only Route 1 and Route 2 and a base map. Set the
segment symbol width to proportional to the total ridership in the AM Peak, and show stop locations
with the stop symbol size proportional to the number of zero-vehicle households within the market
area.

The

following

workflow

illustrates

the

steps

in

producing

this

map.
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Workflow 4.12 –Creating a Custom Map with a TBEST Loaded Network
Operation Steps

Operation Reference

1. Open TBEST
2. Open a TBEST Scenario
3. Confirm that the model runs are valid and no edits are pending. If edits are pending, the model must be run
before TBEST reports will reflect changes in the model input.
4. Under the Tools menu on the main toolbar, select Create a Loaded TBEST Network. The TBEST Loaded
Network dialog will open. See Appendix A – 8.9 for Loaded Networkselection options. Selection the option to
Add TBEST Map after processing.
5. When the Loaded Network processing is complete, there will be two layers added to the map: Loaded AM
Peak Network – Stops and Loaded AM Peak Network - Segments
6. Pin the TBEST Map Control window so that it visible and no longer docked on the side bar.
7. In the list of map layers in the Map Control, right-click on the Loaded AM Peak Network – Stops layer and
select Layer Properties.
8. In the Layer Properties dialog, click the Symbology tab. In the left panel, select Quantities. Under Quantities,
select Graduated Symbols. In the Fields panel, select Share_ZeroVeh_HH as the Value.
9. In the Layer Properties dialog, click the Definintion Query tab. User the Query Builder to compile the following
Definition Query: [Route_Name] = 'Route 1' OR [Route_Name] = 'Route 2'
10. In the Layer Properties dialog, click OK to apply the changes.
11. In the list of map layers in the Map Control, right-click on the Loaded AM Peak Network – Segments layer and
select Layer Properties.
12. In the Layer Properties dialog, click the Symbology tab. In the left panel, select Multiple Attributes. Under
Multiple Attributes, select Quanity By Category. In the Value Fields panel, select Route_Name in the first
drop-down box. In the Variation by panel, click the Symbol Size button. In the Draw quantities using symbol
size to show relative value dialog, in the Fields panel, select Total_Boardings for the Value. Click OK to close
the Draw quantities using symbol size to show relative value dialog.
13. In the Layer Properties dialog, click the Definintion Query tab. User the Query Builder to compile the following
Definition Query: [Route_Name] = 'Route 1' OR [Route_Name] = 'Route 2'
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See Appendix A – 3.8
Model Status

14. In the Layer Properties dialog, click the Labels tab. Check the Label features in this layer option. In the Text
String panel, in the Label Field drop-down box, select Route_Name. Click the Symbol button to format the text
color and size.
15. In the Layer Properties dialog, click OK to apply the changes.
16. To export the map to an image, under the File menu, select Export, and then select Map. Provide an output
name and location. The map can now be included in a report or other documentation.
17. The map below illustrates the results. The Base Map is the Reference/ESRI_Transportation_World_2D ArcGIS
Online Map Service.
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Map Sample
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Scenario Summary Tool
The TBEST Scenario Summary tool is an integrated tool that allow for summary of TBEST Boardings,
Population, Household, Income, Employment, Network, Performance, and Cost variables. Within a
Scenario Report, planners have the ability to interactively select individual variables that make sense for
the type of output required.

The Scenario Summary Tool also contains an interactive display for

developing supporting charts which greatly enhance data visualization. For a complete description of
the TBEST Scenario Summary tool, see Appendix A – 7.3 Scenario Summary Tool.
The TBEST Scenario Summary Tool combines multiple data inputs and summarization methods which
together total hundreds of unique options for data summarization. This volume of options precludes
complete workflow documentation.

However, three sample workflows have been developed to

illustrate the Scenario Summary Tool capabilities:
•

Workflow 4.13 - Determining the market gain from new routes added to the system

•

Workflow 4.14 - Determining Weekday system performance within a Corridor

•

Workflow 4.15 - Determine the projected yearly cost of implementing a 20% decrease in
headway for the system
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Workflow 4.13 –Determining the market gain from New Routes added to the System
Operation Steps

Operation Reference

1. Develop a Model Application Scenario with two new routes. Run the model when data entry is complete.

See Workflow 3.2
Model Application

2. Open the TBEST Scenario Summary Tool
3. In the TBEST Scenario Summary dialog, make the following selections:
a. Transit System – the TBEST Transit System utilized in Step 1
b. Scenario A – select the ‘BaseYearModel’ scenario
c. Scenario B – check the Compare option and enter Model Application Scenario developed in Step 1
d. Summary Span – for Market Analysis, the Summary Span does not impact the output. Accept the
default value ‘Daily Summary by Time Period’
e. Time Period – Accept the default ‘Weekday’ value.
f. Routes to Summarize - select the ‘All Routes’ option
g. Route Operating Cost per Hour – Accept the default $50.00 value
4. Click the Show Report button. The Scenario Report will be generated.
5. In the Summary Variables panel to the left of the report, check the Summary Nodes for Population, Household,
Income, and Employment. Uncheck the Boardings option. Note: by expanding a Summary Node in the
Summary Variables panel, the variables associated with the Summary Node will be exposed. To filter desired
variables to hide/display in the report, uncheck/check the option box beside the variable name.
6. Scroll to the bottom of the report. The Totals row will display Population, Household, Income, and
Employment variable totals for Scenario A and Scenario B. The difference in each variable is also displayed.
From this summary, the planner can determine the total additional market provided for the two additional
routes added to the system. The Scenario Report can be saved to a .csv file by clicking the Export to Excel
button on the toolbar.
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See Appendix A – 7.3
Scenario Summary
Selection Options

7. Optionally, the report can be supported by a Chart. To open the a chart of the results, click the Open Chart
button on the toolbar. By default, the chart will contain Totals for Scenario A and Scenario B for each of the
variables in the report. To save the chart as an image, click the Save Chart as Image.. button on the toolbar.
Once saved, the chart can then be included in any user developed output report assocated with this model
application.
Note: by expanding a Summary Node in the Summary Variables panel, the variables associated with the
Summary Node will be exposed. To filter desired variables to hide/display in the report, uncheck/check the
option box beside the variable name.
Report Sample
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See Appendix A – 7.3
Scenario Charting

Chart Sample
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Workflow 4.14 –Determining Weekday system performance within a Corridor
Operation Steps

Operation Reference

1. Develop a Model Application Scenario and perform updates within a defined Corridor. If not already defined,
use the Analysis Toolbar to define the Corridor. Run the model when data entry is complete.

See Workflow 3.2
Model Application

2. Open the TBEST Scenario Summary Tool
3. In the TBEST Scenario Summary dialog, make the following selections:
a. Transit System – the TBEST Transit System utilized in Step 1
b. Scenario A – select the ‘BaseYearModel’ scenario
c. Scenario B – check the Compare option and enter Model Application Scenario developed in Step 1
d. Summary Span – Accept the default value ‘Daily Summary by Time Period’
e. Time Period – Accept the default ‘Weekday’ value.
f. Routes to Summarize - select the ‘Routes intersecting a Mobility Area’ option. In the drop-down box,
select the Corridor developed in Step 1.
g. Route Operating Cost per Hour – Accept the default $50.00 value
4. Click the Show Report button. The Scenario Report will be generated.
5. The Mobility Area Analysis Scenario Report will contain a summary header and two tables.
a. Summary Header - contains Mobility Thresholds that have been developed for the agency. If a
threshold range contains the number of additional trips generated in the model application scenario,
the number of trips is populated in the row below the threshold range. In addition to the additional
number of trips, the Scenario Report will display service expansion reccomendations warranted for the
increase in ridership.
b. Routes which access the Mobility area – this table summarizes routes which intersect with the
Mobility area. Trips are for the entire length of the intersecting routes, including areas which fall
outside of the Mobility Area. *Note: For determining AMA additional trips within the target
comparison scenario are matched with the results of this table.
c. Trips generated only within the Mobility area - this table summarizes routes which intersect with the
Mobility area but only includes variable summaries within that are entirely within the Mobility area.
6. In the Summary Variables panel to the left of the report, check the Network and Performance Measures
Summary Nodes. Uncheck the Boardings option. Expand the Network Summary Node and uncheck all
Variables except Route Arrivals.
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See Appendix A – 7.3
Scenario Summary
Selection Options

7. Scroll to the bottom of the Trips generated only within the Mobility area table. The Totals row will display the
selected Network and Performance Measures variable totals for Scenario A and Scenario B. The difference in
each variable is also displayed. From this summary, the planner can determine the performance changes
within the defined Corridor. The Scenario Report can be saved to a .csv file by clicking the Export to Excel
button on the toolbar.
8. Optionally, the report can be supported by a Chart. To open the a chart of the results, click the Open Chart
button on the toolbar. By default, the chart will contain Totals for Scenario A and Scenario B for each of the
variables in the report. To save the chart as an image, click the Save Chart as Image.. button on the toolbar.
Once saved, the chart can then be included in any user developed output report assocated with this model
application.
Note: by expanding a Summary Node in the Summary Variables panel, the variables associated with the
Summary Node will be exposed. To filter desired variables to hide/display in the report, uncheck/check the
option box beside the variable name.
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See Appendix A – 7.3
Scenario Charting

Report Sample
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Chart Sample
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Workflow 4.15 –Determine the projected yearly cost of implementing a 20% decrease in Headway for the system
Operation Steps

Operation Reference

1. Develop a Model Application Scenario. Decrease the headways on all Weekday time periods by 20%. Run the
model when data entry is complete.

See Workflow 3.2
Model Application

2. Open the TBEST Scenario Summary Tool
3. In the TBEST Scenario Summary dialog, make the following selections:
a. Transit System – the TBEST Transit System utilized in Step 1
b. Scenario A – select the ‘BaseYearModel’ scenario
c. Scenario B – do not check the Compare option. Scenario B should be greyed out.
d. Summary Span – select the ‘Service Year’ value
e. Time Period – NA
f. Routes to Summarize - select ‘All Routes’
g. Route Operating Cost per Hour – Enter $45.00
4. Click the Show Report button. The Scenario Report will be generated.
5. In the Summary Variables panel to the left of the report, check the Summary Node for Cost. The Cost variables
are added to the Scenario Report and the Report header is updated to display the input Operating Cost per
Hour.
6. Scroll to the bottom of the Scenario Report. The RouteCost, CostperPassengerTrip, CostperRouteMile are
summarized in the Totals row. From this summary, the planner can determine the projected cost of
implementing the service changes. The Scenario Report can be saved to a .csv file by clicking the Export to
Excel button on the toolbar.
7. Optionally, the report can be supported by a Chart. To open the a chart of the results, click the Open Chart
button on the toolbar. By default, the chart will contain Totals for Scenario A and Scenario B for each of the
variables in the report. To save the chart as an image, click the Save Chart as Image.. button on the toolbar.
Once saved, the chart can then be included in any user developed output report assocated with this model
application.
Note: by expanding a Summary Node in the Summary Variables panel, the variables associated with the
Summary Node will be exposed. To filter desired variables to hide/display in the report, uncheck/check the
option box beside the variable name.
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See Appendix A – 7.3
Scenario Summary
Selection Options

See Appendix A – 7.3
Scenario Charting

Report Sample

TBEST Implementation Procedures for Strategic and Service Planning | 84

Chart Sample
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INTRODUCTION
This section helps the user get started with TBEST Version 4.0 by providing an overview of the
structure and logic of TBEST and a brief description of the capabilities and user interface of the
TBEST application. For users familiar with the TBEST 3.2 User’s Guide, release notes
available on the TBEST website summarize the changes from the prior release.

1.1 What is TBEST?
TBEST stands for Transit Boardings Estimation and Simulation Tool. TBEST interfaces with
and derives its GIS functionality from ESRI’s ArcGIS suite of products.
Over the past few years, the FDOT Public Transit Office has been at the forefront in the
development of state-of-the-art transit analysis tools. In the specific area of transit ridership
estimation and forecasting, the FDOT Public Transit Office funded the development of the
Integrated Transit Demand and Supply Model (ITSUP) and the Regional Transit Feasibility
Analysis and Simulation Tool (RTFAST). Both of these tools were well received by the user
community for their ability to estimate ridership at the individual stop-level, user-friendly
graphical interface, GIS functionality, and analytical rigor. The user community provided a
wealth of feedback and helped identify a number of improvements subsequently made to these
tools. TBEST represents a third and culminating effort in the development of robust stop-level
models for transit ridership. TBEST is a comprehensive transit analysis and ridershipforecasting model that is capable of simulating travel demand at the individual stop-level while
accounting for network connectivity, spatial and temporal accessibility, time-of-day variations,
and route competition and complementarity.
TBEST simulates transit ridership at the level of the individual stop, clearly distinguishing among
stops at the same location, by route and direction. Thus, it is a “micro-level” model that can
provide very detailed information regarding ridership estimates at individual stops. However,
TBEST’s primary role is envisioned to be obtaining more aggregate route level, segment level,
location-based, or system level measures of transit ridership through the aggregation of stoplevel outputs. By simulating ridership at the level of the individual stop, the model provides a
strong platform and robust framework for modeling transit ridership in a region by time of day
and day of week. The motivation behind the development of stop level forecasting was not
necessarily a need for stop level forecasts, but rather the recognition that the predominant walk
access nature of transit use requires a level of geographic precision that equates to
understanding the size and characteristics of the activities and population in the stop level walk
access buffer. Thus, TBEST has a model structure that is sensitive at the stop level even
though service planning decisions are and should continue to be made at the route segment
level. Variations in transit ridership at a stop that are not explainable by stop-level input
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variables are significant and model users are discouraged from using individual stop level
results for stop level service planning decisions.
Version 4.0 of TBEST has been calibrated using year 2000 census and ridership data from
Portland. TBEST is continuing to be evaluated and updated as additional user and researcher
experience is gained. TBEST users should check the TBEST website, http://www.tbest.org/ , to
make sure they have the most current version of TBEST and this User Guide. The User Guide
has a date on the front cover and on the footer of each page so the user can determine if their
version is the most current by comparing it with the version on the Web site.
Model estimation results and coefficients furnished in this user guide and provided as default
parameters with the installation version of TBEST should be used with full knowledge of the
TBEST model. While the model structure attempts to capture travel behavior as much as
possible within the model variables (as opposed to the constants), and the model is designed to
calibrate the system total ridership to replicate local base conditions, caution is warranted. As
TBEST user experience increases there will be a stronger basis for understanding the
transferability of the model coefficients. Users who desire to use model coefficients customized
to their own area will need to re-estimate and re-calibrate the various equations that comprise
TBEST using census and stop-level ridership data from their own area. The modeling
methodologies and estimation procedures are described in the TBEST Appendices. In general,
the user should note that the re-estimation and re-calibration of models comprising TBEST is a
complex statistical and data mining exercise that requires considerable time and effort. This is
not recommended unless there is extensive local TBEST use anticipated and applications
experience has not proven satisfactory with default coefficients.

1.2 The TBEST Approach to Transit Ridership Forecasting
TBEST is intended to serve as a comprehensive transit ridership forecasting model. Transit
ridership at individual stops depends on numerous factors and it is critical that all possible
factors are considered if one desires to obtain accurate predictions of transit ridership. The
methodology underlying TBEST ensures that the model is sensitive to as wide a range of socioeconomic and supply attributes as possible with available data. In particular, the following
features of TBEST are noteworthy:
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Forecasting Stop-Level Boardings: TBEST provides forecasts or predictions of stop-level

boardings. Thus, ridership in the context of TBEST, is defined as the number of
boardings at each transit stop.
1. Direct and Transfer Boardings: TBEST incorporates separate equations for estimating and
distinguishing between direct boardings and transfer boardings at each stop location. At
any given transit stop, one may have patrons who begin their trip at the designated stop and
other patrons who are transferring to the subject route at the designated stop in the course
of their overall trip/journey. By distinguishing between direct and transfer boardings, TBEST
is able to:
• Account for both stop characteristics that contribute to transit linked trip making and
transit network characteristics that influence transfer activity levels and locations;
• Account for stop buffer characteristics that contribute to attracting and generating walk
access ridership at a stop;
• Provide a quantitative perspective on the extent of trip linking that is occurring and;
• Provide a framework for analyzing the impacts of transfer points and transfer
opportunities on ridership.
2. Time of Day Based Analysis: TBEST includes separate ridership estimation equations for
each time of day and day of week. The times of day that have been incorporated into
TBEST include:
•
•
•
•
•
•

Weekday a.m. (morning) peak period
Weekday p.m. (afternoon) peak period
Weekday off peak period
Weekday night period
Saturday (all day)
Sunday (all day)

The specific definitions of these time periods are given later in this guide in conjunction with
the model specification and equations. Separate peak period coefficients are developed in
TBEST to account for the very different trip generation characteristics of residential and
employment areas for these two time periods. Although TBEST is able to provide time-ofday based ridership forecasts as defined above, it is not able to provide ridership estimates
by trip purpose. Data capabilities preclude the estimation of separate model equations for
different trip purposes.
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3. Spatial Accessibility (Socio-economic Characteristics):
TBEST accounts for spatial
accessibility in computing boardings at individual stops. Ridership is partially dependent on
the number of people of various characteristics (defined by age, working status,
race/ethnicity, income, car ownership, etc.) who can access the transit system. TBEST
considers circular buffer areas around individual stops to identify the market that has access
to the transit system.
4. Time-Space Network Connectivity: In addition to considering spatial accessibility at the
origin stop, one needs to consider the overall connectivity and time-space accessibility that
a system provides to compute accurately ridership at any stop. People are more likely to
use a transit system (stop) that is well connected and from which many destinations offering
a range of activity opportunities can be reached. However, it is likely that riders will not be
willing to tolerate trip lengths or durations and number of transfers beyond a certain
threshold level. Thus, one needs to consider the activity opportunities (measured in terms
of population and employment) that can be reached within a certain time frame and number
of transfers when modeling the number of boardings at any stop. In addition, this network
accessibility has to be computed and accounted for along the temporal dimension. The
network connectivity and range of reachable destinations may be different at different times
of the day due to service supply differences (frequency and travel speed) by time of day.
TBEST incorporates a powerful, comprehensive, and sophisticated methodology for
accounting for time-space network connectivity and accessibility, thus making it a powerful
tool for transit ridership forecasting.
5. Competing and Complementary System Effects: Within a transit system, there are bound to
be competing and complementary system effects that affect ridership. For example, any
stop is likely to have a series of neighboring stops that are competing for the same
market/riders. If indeed, neighboring stops have overlapping market area buffers, then it is
important to consider such competing effects in computing stop-level ridership. Similarly,
there may also be complementary effects that affect and enhance ridership at a stop. For
example, if a stop is a transfer point where two or more routes meet, then the number of
boardings at the stop may be enhanced by virtue of the transfer opportunities present there.
TBEST explicitly accounts for both of these effects in computing stop-level ridership.
6. GIS-Based Software Tool: TBEST has been developed so that the user can use the
software through an interface that provides full GIS functionality. ArcGIS 10 or higher
residing locally on your computer is required to use TBEST. A modest investment in ArcGIS
allows the user to untap the full potential of TBEST. Socio-economic scenarios, supply
attributes, and route and stop configurations can be changed and edited on the fly, thus
making TBEST a truly user-friendly transit ridership forecasting tool.
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7. Automatic Calibration to Local System Total Ridership: As ridership is known to vary by
urban area scale independent of other factors such as density, TBEST is designed to
automatically scale system total ridership to match counted ridership for the base validation
year. This automatic scaling accounts for conditions not directly captured in the model
variables including scale, roadway congestion, parking availability and cost and other local
context conditions.
8. Performance Measures: TBEST includes estimates of several performance measures in its
output. Performance measures such as route miles, service miles, service hours, boardings
per service mile or hour, and average boardings per service trip are provided by TBEST at
the individual route-level and for the system as a whole. These performance measures can
be used to assess the impacts of various socio-economic and supply scenarios on system
performance.
As the computations involved in accounting for the items listed previously are quite complex and
numerically intensive, particularly for large transit systems that have thousands of unique transit
stops, model run times in TBEST can be quite substantial with complete model runs taking as
long as a few hours. It is recommended that TBEST be run on high-performance hardware and
one may want to run multiple models in batched overnight sessions.
Preparing Near and Mid Term Forecasts: TBEST was designed to provide near and midterm forecasts of transit ridership. The model uses zone and address level demographic data
and detailed transit network specification as the basic inputs. While the model can be applied to
any future year socio-demographic and transit service specifications the user chooses to apply,
because the model is not interactive with the roadway network, long range forecasts will not
show a sensitivity to changes in the competitive situations between transit and roadways over
time. As such, one would need to use caution in interpreting longer-range forecast applications
particularly if the competitive position of transit relative to roadways (system speed) was
anticipated to change significantly.
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The user-friendly design of TBEST encourages service planners to aggressively explore various
service levels and configurations in an effort to identify transit service needs and opportunities.
In particular, in Florida, TBEST is intended to be used for the development of Transit
Development Plans in many areas. TBEST is the planning tool currently supported by FDOT
that enables properties to comply with State rules. Florida Administrative Code: Rule 1473.001 Public Transit, states:
Section 341.052, F.S.
(3) Transit Development Plans (TDPs). TDPs are required for grant program
recipients in Section 341.052, F.S. A TDP shall be the provider’s planning,
development, and operational guidance document, based on a ten-year planning
horizon and covers the year for which funding is sought and the nine subsequent
years. A TDP or an annual update shall be used in developing the Department’s fiveyear Work Program, the Transportation Improvement Program, and the Department’s
Program and Resource Plan. A TDP shall be adopted by a provider’s governing body.
Technical assistance in preparing TDPs is available from the Department. TDPs shall
be updated every five years and include all elements described below.
……. At a minimum the situation appraisal shall include:
2. An estimation of the community’s demand for transit service using the planning
tools provided by the Department, or a Department approved transit demand
estimation technique with supporting demographic, land use, transportation, and
transit data. The result of the transit demand estimation process shall be a ten-year
annual projection of transit ridership.
The ease of use of TBEST enables various service and land use scenarios to be efficiently
evaluated.
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1.3 TBEST Capabilities and Output
Transportation planners face the challenge of how best to deploy resources and how the market
might respond if additional services were available (i.e. what are the needs). Whether
expanding, redeploying or contracting services, the transit planner is faced with making
fundamental trade-offs between:
1) Service area geographic coverage and network configuration,
2) Service frequency, and,
3) Span of service, (i.e. what hours of service to operate on weekdays, weekends, and holidays)
Perhaps the next most significant decision is service pricing i.e., what fares to charge
customers. All of these decisions can be evaluated and explored with TBEST. While the
planner’s job goes beyond these decisions to include such things as specification of equipment
and decisions on marketing and operating strategies, the vast majority of a transit agency’s
resources are tied up in the critical decisions that TBEST is designed to help address.
TBEST provides a variety of functions and tools that support the following:
1. Strategic Planning – Based upon required planning cycles (0-10 years), TBEST will
allow users evaluate ridership implications from the combined impacts of socioeconomic growth, fare changes, service modifications, new service, and other system
modifications. The estimated ridership and performance measures can be used to
satisfy the demand estimations requirement for a Transit Development Plan (TDP).
2. Service Planning – Routes can be added, removed, and altered to determine the best
location for new service that will yield the highest ridership or will meet other userspecified parameters. TBEST can also be used to analyze existing routes and test
scenarios to improve the performance of the route by changing route structure, service
area, service frequency, span of service, time of day, etc.
3. Corridor Analysis – Examination of specific corridors in communities and determine the
potential for transit service and what type of service would be suitable. The corridor data
can be isolated and compared over various scenarios.
4. Area Analysis – Examination of specific growth areas in communities and evaluate the
effectiveness of transit service scenarios within the area. This can be applied to
Developments of Regional Impact (DRI) or localized demographic changes. The area
data can be isolated and compared over various scenarios.
5. Site Analysis – Examination of localized changes around a particular site (such as
transit station).
6. GIS Data Management – TBEST can be used as a tool for Transit focused GIS data
development, management and analysis. TBEST is compatible with ArcGIS and all stop
and route geometry is stored in personal geodatabases.
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As with any model, TBEST is a tool that is intended for use by an informed planning
professional and its results are to be examined in the context of user judgment and knowledge.
TBEST is a powerful tool to help the planning professionals explore and evaluate needs and
opportunities.

1.4 TBEST User Interface
TBEST is a very advanced Transit Ridership Forecasting software with highly enhanced
Graphic User Interface. The user interface has a mapping window that displays a geographic
network of a transit system. The network attributes of the corresponding transit system are
defined and displayed in two tables, labeled Segments and Stops.
The TBEST interface provides a user-friendly environment for transit system and scenario
management, development of a transit network, and model analysis. Key interface elements
are illustrated in Figure 1.1.
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Main Menu

TBEST Explorer

Main Toolbar

Segments

Analysis Toolbar

Map Toolbar

Status Bar

Stops

Map Control

Routes

Figure 1.1 - TBEST User Interface

Main Menu:
The Main Menu contains options for downloading and importing transit systems to create a
scenario, editing an existing system and various scenario and map-based functions.
Main Toolbar:
The Main Toolbar consists of shortcuts to use some of TBEST’s most common and useful
functions. Most of the functions are for scenario data development and analysis and are only
enabled when a scenario is open for editing.
Analysis Toolbar:
This toolbar allows the user to create and save Area, Site, and Corridor Analyses. In addition,
the saved analysis can be converted to a Sector Scenario (analysis tools and Sector Scenarios
are explained in Section 8 of the User’s Guide).
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TBEST Explorer:
The TBEST Explorer window provides user-friendly navigation panel to access and manage
TBEST components. TBEST Explorer consists of three main folders: Transit Systems,
Distribution Files, and Socio-Economic Data. The Transit Systems folder contains sub-folders
to manage individual Transit Systems. Within each system, folders are provided to manage
scenarios, reports, search files, corridors, sub areas, and site analysis. The Distribution Files
folder contains any TBEST Distribution Files located in the TBEST Database install location (by
default this location is C:\TBEST\DistributableSystems\). From the TBEST Explorer window,
users can navigate and manage exported TBEST Systems. The Socio-Economic Data folder
includes formatted state-wide Census and InfoUSA data that is used to supply local areas with
base population and employment data (see Section 4 for more information on Socio-Economic
data).
From Explorer, files can been opened or deleted. Further options for scenarios include creating
a new scenario, copying a scenario, and running the model.
Mapping Toolbar:
The Mapping Toolbar allows a user to scale, zoom and pan in the map window and also
includes identify, measuring and clear map tools. A detailed list and description of each button
in this tool bar is discussed in Section 5.3.
Map Window:
The Map Window shows a user configured base map and the transit system network (stops and
route segments) for the current scenario.
Map Control:
The Map Control Tab provides a Map table of contents for modifying map layers and settings
(very similar to ArcMap). Spatial data can be added from files with the ability to define data
labels, and symbols in the same manner as in ArcGIS.
Routes:
The Routes Tab provides Transit route management and editing capabilities. It shows an
interactive display for all routes defined in the system. Routes can be added, deleted and/or
copied from this interface.
Segments:
The Segments Table displays route attribute data for segments. Users can modify existing
routes by adding new segments or deleting existing segments or even re-aligning segments to
create alternative routes. It displays in-vehicle travel time on each segment by time period and
day.
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Stops:
The Stops Table displays route attribute data for stops. Data includes the name of the route,
stop descriptions and numbers, time points, arrivals at each stop, travel time, and headways. In
addition, socio-economic data can be toggled on for each stop using the View Menu.
Status Bar:
The Status Bar at the bottom of TBEST displays the current Transit Scenario, active routes,
displayed geometry (either entire route network or selected routes) and total stops, visible stops
and selected stops. In addition, the Status Bar will display the progress of various tasks
performed within TBEST.
Window/Panel Docking:
All windows/panels in TBEST, including TBEST Explorer, Map Control, Routes, Segments and
Stops can be toggled, pinned or closed. Panels can also be dragged out of a pinned or toggled
position into a floating window.

A B C
A. Toggle Tabs – This button allows the user to toggle any of the tables or tabs in TBEST.
When toggled off, a button to reopen the tab will be shown at the bottom left of the open tab.
B. Pin Tabs – This button allows the user to pin a table or tab so that it stays open in the
TBEST environment. When unpinned, the table or tab will be auto hidden and can be accessed
by mousing over or clicking the panel that appears on the far bottom or far right of the TBEST
screen.
C. Close Tabs – This button closes the tab or table. Any tab or table can be reopened through
the View > Windows in the Main Menu. A user can also close tabs or tables directly from this
window. Closed tabs can be re-opened by selecting the closed window under the View ->
Windows menu option on the Main Toolbar.
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TBEST CONFIGURATION
This section provides TBEST hardware and software specifications, a guide to installing TBEST,
and the post-installation setup procedures. With the successful installation of TBEST, several
database and support files are loaded onto the local computer. This section discusses the
location and management of these files and the configuration of the TBEST Base Map.

2.1 Hardware Requirements
TBEST is a computationally intensive software package that calls for using high-performance
personal computers to minimize model run times and handle large databases. It is
recommended that TBEST be run on a high-end Dual Core machine. Hard disk space
requirements are dependent on the size of the databases (region) and the extent to which
multiple scenarios will be created.
Minimum Recommended Hardware Specifications
•
•
•

Dual Core 2.0 GHz
2 GB RAM
10 GB free disk space after installation of TBEST

While TBEST will run on a machine whose hardware specifications are below those noted
above, run times and database/screen refresh rates are likely to be considerably longer.

2.2 Software Requirements
TBEST is a Microsoft Windows® based software package that involves complex computations,
intensive database handling, and input/output visualization using GIS. As such, TBEST comes
with some specific software requirements so that all of its features and capabilities will function
properly.
Required Software Resident on Machine Running TBEST
•
•
•

Microsoft Windows® XP or 7
ArcGIS 10 (Subject to change with new ArcGIS releases) (ArcView License Level)
Microsoft SQL Server Express 2005 or Microsoft SQL Server 2005

SQL Server management notes:
• SQL Server Express is a free version of SQL Server 2005.
• SQL Server Express has a limit of a 4GB total database size. If more database space is
necessary, SQL Server Developer Edition (or higher) can be purchased from Microsoft.
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•
•
•

•

For the TBEST implementation, SQL Server runs on the local computer where TBEST is
installed. TBEST will not work with SQL Server on another computer or server.
Do not stop or delete the SQLSERVER.exe service from the list of Services running on your
machine.
The TBEST database tables can be viewed by downloading and installing the Microsoft SQL
Server Express 2005 Management Studio from:
http://www.microsoft.com/downloads/details.aspx?FamilyId=C243A5AE-4BD1-4E3D-94B85A0F62BF7796&displaylang=en
For more information, visit the SQL Server 2005 website at:
http://www.microsoft.com/sql/editions/express/default.mspx

2.3 Installing TBEST
TBEST can be downloaded and installed via the TBEST website located at: www.tbest.org
The installation package can also be provided on a CD upon request.
The installation process is similar to that of other Microsoft Windows® based software where the
user follows the instructions on the screen. At the time of the TBEST 4.0 release, Microsoft
Windows XP® and Windows 7® are the supported operating systems. The installation of
TBEST requires that the user have Windows Administrative privileges on the machine. The
TBEST website will contain both the full installation of TBEST and the most recent TBEST
software updates. The TBEST Help menu on the Main Toolbar provides access to the TBEST
Software page where new updates will be posted.
Before installing TBEST, it is recommended that all other programs be closed. To install and
run TBEST 4.0, the system should have Microsoft .NET framework 2.0 installed. If not installed,
the .NET framework is available for download on the Microsoft website.
TBEST utilizes the Microsoft SQL Server Express 2005 or SQL Server 2005 database as its
primary information repository. The TBEST installation package will automatically install SQL
Server Express 2005 if it is not already present on the target machine. SQL Server Express is a
free database software, however, if the target transit system is for a large urban environment
(>20000 stops), it may be necessary to purchase the SQL Server 2005 Developer Edition due
to storage limitations with the Express edition.

TBEST Installation Procedure
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Step 1:

Step 2:
Step 3:
Step 4:

Step 5:

Download the current TBEST installation file from www.tbest.org. Users signed up
on the TBEST User Forum will get automatic notifications when software updates are
available.
Execute the installation file from its download location.
The installation process will commence as shown in Figure 2.1. Follow the onscreen instructions.
If not present already, the installation package will install SQL Server Express 2005.
Reference the sequence illustrations below for more detail on how to install SQL
Server Express.
After SQL Express is installed, the TBEST install will continue until all of the files are
copied and the registries are updated. Appropriate data files that are included with
the TBEST software will be copied into the directories identified by the user during
the installation process. If possible, please accept the default location for the
software and database.

Sequence Illustration for TBEST Installation
The following steps provide an illustration for the key options involved in the installation of SQL
Server Express and TBEST. Note: if SQL Server Express is already installed on the target
machine, the install will skip this step.

Figure 2.1 - TBEST InstallShield Wizard
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Figure 2.2 - Installing Microsoft SQL Server 2005 Express Wizard

Check the acceptance box and click Next to display SQL Server 2005 Prerequisites Setup
wizard (Figure 2.3) and click Next to display SQL Server 2005 as shown in Figure 2.4.

Figure 2.3 - Installing Prerequisites to SQL 2005
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Figure 2.4 - Setup Wizard for SQL Server 2005

Click Next for System Configuration Checks (Figure 2.5).

Figure 2.5 - System Configuration Check

Click Next to Install SQL Server 2005.
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Once installed, Registration Window automatically opens, as shown in Figure 2.6.

Figure 2.6 – Registration

Click Next to display SQL Database Services (Figure 2.7) and use only default settings.

Figure 2.7 - SQL Server 2005 Feature Selection
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Select Mixed Mode. For the sa login password, enter TBEST. Click Next.

Figure 2.8 - Authentication Mode Selection Window

Leave the checkboxes unchecked on Error and Usage Report Settings and click Next.

Figure 2.9 - Error and Usage Report Settings
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Click on Install.

Figure 2.10 - SQL Server 2005 Express Edition Setup

Setup will install five additional required programs of SQL Server Express

Figure 2.11 - Installing SQL Server 2005
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Click Next and then Finish to complete the SQL Server Express installation. The install will now
begin deployment of TBEST components.

Figure 2.12 - TBEST Installation Wizard

Click Next to display select the TBEST Destination Folder. Use of the default C:\Program
Files\TBEST\ option is strongly suggested.
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Figure 2.13 - TBEST Installation Folder Selection

The installation will now deploy the TBEST components. When the installation is complete,
click Finish.
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2.4 Uninstalling TBEST
Prior to uninstalling the TBEST software through Microsoft Windows Add/Remove Programs
interface, delete all TBEST Transit Systems using the Delete button on the Transit Systems
form. To save the data for later use, package the systems in TBEST Distribution Files (See
Section 3.2 for a discussion on TBEST Distribution Files) prior to deleting.
Note: If you do not delete existing systems prior to uninstall, you may have technical difficulty
re-installing the transit systems.
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2.5 Configuring the TBEST Base Map
TBEST provides an ArcGIS-based mapping interface where users can use to digitize routes,
realign route segments, add and move stops, and delete route segments or stops. The use of
these tools is enhanced by having background layers that provide a basis for drawing or
realigning routes and adding or moving stops. The most useful background layer in this context
would be a detailed street network or road geography layer. With a street network in the
background, a user can easily draw routes and locate stops in a manner consistent with the
street network in the region. In addition to a street network, one may also wish to include:
• State boundaries
• Rail network
• Water bodies
• TAZ geography from the travel demand model
All of these layers will provide a useful backdrop for performing transit route and stop-level
analysis and building alternative system configuration scenarios.
Within TBEST there are two base map reference options. The advantages of each are
summarized below.
Option 1: Reference an ArcGIS online web service (hosted by ESRI) or Bing Maps.
Utilizing an online web service provides the following advantages:
• A variety of maps are available including aerial imagery and demographics
• Local data configuration is not required
• TBEST map draw performance
• Map coverage is world-wide
Option 2: Reference a local ArcGIS Map document (.mxd) or layer file (.lyr).
Utilizing a local map document provides the following advantages:
• Internet connection is not required
• User can customize the base map to meet specific mapping requirements
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Follow the steps below to configure the TBEST Base Map:
Configuring the TBEST Base Map
Step 1:
Step 2:

Step 3:

From the Main Menu, select Map > TBEST Base Map. The TBEST Base Map dialog
will open.
To reference Bing Maps, select the Bing Maps Online Service option. To reference
an online Base Map, select the Reference an ArcGIS Online Map Service option.
Choose a service from the drop-down menu. See Figure 2.19 for an illustration. To
reference local data, select the Reference an ArcMap Document (.mxd) or Layer file
(.lyr) option. Browse for a local .lyr file or .mxd file. See Figure 2.20.
Click OK to save the settings.

Figure 2.19 – Reference Online Base Map
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Figure 2.20 – Reference Local Base Map

Additional Base Map notes:
• The TBEST Base Map will be the background map for all transit systems installed on
your computer.
• The Base Map setting can be changed at any time to suit the service area of an installed
system.
• For more information on creating .lyr or .mxd files, please refer to ArcGIS
documentation.
• The ESRI_StreetMap_World_2D online map contains a world-wide street network
making it a good reference base map for editing and viewing TBEST transit networks.

2.6 Review of TBEST Directory Structure
TBEST saves most files in a systematic order within the Database folder defined during
installation. While it is not necessary for the user to manipulate TBEST files directly, it is
important to know their location on the location computer. If the default Database Folder was
selected during installation, TBEST files will be stored in the C:\TBEST\ directory. Under this
directory, TBEST stores data into three primary folders:
1. TransitSystems: Whenever a new Transit System is created or installed, a folder with
that particular name is created under the \TBEST\TransitSystems\ directory. All related
data and scenario information is stored in a structured format under this directory.
TBEST creates subfolders within a Transit System to store specific scenario information
including exported Reports, Spatial Analysis Files, and saved TBEST Searches.
2. DistributableSystems: By default, TBEST Distribution File packages (.tds) are stored in
this directory.
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3. SupportData: This directory is the default for Socio-Economic support data related to a
State or Region. TBEST recognizes properly packaged support data in this directory for
creating new systems.

2.7 TBEST Databases and Supporting Files
TBEST software relies on properly formatted and maintained databases in a variety of formats.
While TBEST users are not required to manage files external to the software, a brief review is
warranted for those with a need to access the underlying files. Each installed TBEST Transit
System will have the following files:

1. SQL Server 2005 Database
a. Contains model, socio-economic data and non-geographic network data for a
system.
b. Located at: C:\TBEST\TransitSystems\<SystemName>\TBEST.mdf.
2. ESRI Personal Geodatabase
a. Socio-Economic data (Population and Employment data)
i. Located at: C:\TBEST\TransitSystems\<SystemName>\
TBEST_SYSTEM_LAYERS.mdb.
b. Transit Network
i. Located at: C:\TBEST\TransitSystems\<SystemName>\
TBEST_LAYERS.mdb. (Base Year Network)
ii. Located at: C:\TBEST\TransitSystems\<SystemName>\
Scenarios\<ScenarioName>\TBEST_LAYERS.mdb. (Scenario Network)
Note on TBEST Databases:
o Copying the directory where a system resides will not back it up. To back up a system,
package the system in a TBEST Distribution File.
o Do not change the name of any of the TBEST files, folders or subfolders. This will cause
data access issues within TBEST.
o The C:\TBEST\TransitSystems\BEST.style file can be edited in ArcMap to alter the
default symbols for route and stop geometry in a Transit System. See ArcMap’s
documentation for changing symbols in style files.
o By default, all exported Reports, data, and TBEST Search files are directed to directories
under C:\TBEST\TransitSystems\<SystemName>\. This allows them to be packaged
with the TBEST Distribution File and retrieved after importing.
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3. MANAGING TRANSIT SYSTEMS AND SCENARIOS
This section provides an overview of the
management and use of TBEST Transit
Systems and Scenarios. The overview will
include discussion of the organization of
the scenarios within transit systems,
incorporation of socio-economic data into a
new transit system and additional tools for
distributing model files.

3.1 TBEST Transit Systems
Figure 3.1 – Transit Systems in TBEST

TBEST Transit Systems encapsulate the
Explorer
framework for scenario-based Transit
modeling, reporting and analysis. Within this framework, TBEST stores and manages a Base
Year model and any number of future year scenarios. Transit System scenarios contain a transit
network, socio-economic data, and model properties that are specific to either the development
of a base year model or proposed future-year alternatives.
Base Year networks and socio-economic data are not directly editable within TBEST. It is only
through running the TBEST Validation process that a new Base Year model is created. TBEST
can manage multiple Transit Systems over any geographic area.
Viewing TBEST Transit Systems
To view TBEST Transit Systems, navigate to the TBEST Explorer window (see Figure 3.1
above) and open the Transit Systems folder. All loaded systems
are listed in subfolders. To
the right of each system is the model validation status. Validated models are shown with a
check
beside the base year of the model. Unvalidated models are shown with a caution .
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3.2 TBEST Distribution Files
TBEST is able to take all of the files needed
for a Transit System (SQL Server database
files, GIS files, reports, search files, analysis
files) and compile them into one file, known
as a
TBEST Distribution file (.tds).
Distribution files can be used for Transit
System backups, storage of model versions
or to distribute models to other TBEST users.
To create a TBEST Distribution file from an
installed TBEST Transit System, use the
following steps:
Figure 3.2 Distribution Files in TBEST
Explorer

Creating a TBEST Distribution file
Step 1:
Step 2:

Right-click on the transit system’s folder in TBEST Explorer and select Create
TBEST Distribution File.
In the dialog box that appears, choose where to create a Distribution File, then click
Save. Note: The default save location is C:\TBEST\DistributableSystems\. If you
store the Distribution File in this location, it will appear in the TBEST Explorer window
under the Distribution Files folder (see Figure 3.2 above).

To load a TBEST Distribution File back into TBEST, use the following steps:
Loading a Transit System from a TBEST Distribution File
Step 1:

Select File > Load System from TBEST Distribution File or double-click a .tds file
in the Distribution Files folder in TBEST Explorer.

Step 2:
Step 3:

Once the file is loaded successfully, TBEST displays a message, click OK.
The imported Transit System will now be loaded in under the Transit Systems folder
in TBEST Explorer.

Tips for loading Distribution Files:
 When loading a Distribution File, make sure that it is located on a local computer drive,
not on a network drive.
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The name of the Distribution File is not necessarily the name of the system inside the
Distribution File. For example, a TBEST Transit System could be named SCAT, but the
Distribution File was saved as SCAT_1.tds. When you load the Transit System, it will
still be named SCAT.
TBEST will not allow two Transit Systems with the same name. If you are loading a
Transit System from a Distribution File and an existing Transit System contains the
same name as the incoming System, it will be necessary to either delete or rename the
existing System.

3.3 TBEST Socio-Economic Data
TBEST users can create a new Transit
System from scratch with the use of
TBEST Socio-Economic Data. The
Socio-Economic data has been
developed on a statewide basis and
can be accessed by download from
within TBEST. The Socio- Economic
data packages will contain population
Figure 3.3 Socio-Economic Data in TBEST Explorer
and employment data that has been
formatted to work with TBEST. See
Section 3.5 on using the Socio-Economic data to create a new Transit System.
To download TBEST Socio-Economic data, use the following steps:
Downloading Socio-Economic Data:
Step 1:
Step 2:
Step 3:

Step 4:

Select File > Downloads > Download Socio-Economic Support Data in the TBEST
Main Menu.
Select the desired Socio-Economic data package from the TBEST Support Data
Download form as shown in Figure 3.4 and click Download.
Click Save in the File Download dialog, see Figure 3.5.
In the Save As dialog, navigate to C:\TBEST\SupportData\ and save the file.
When the download is complete, click the Close button on the File Download dialog.
To complete the process of extracting the downloaded Socio-Economic data for use
in TBEST, click the Extract button on the TBEST Support Data Download form. In
the Save As dialog, navigate to the C:\TBEST\SupportData\ directory, and select the
downloaded file in .cab format. The extraction process will bring up a Windows
Command window that displays the progress of the extraction.
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Step 5:

When the extraction process is complete, TBEST Explorer will contain a reference to
the download under the Socio-Economic Data folder.

Figure 3.4 - Download Socio-Economic Data

Figure 3.5 – File Download Dialog Box
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3.4 Downloading Transit Systems
The Florida Department of Transportation has developed a series of base models to be used by
Transit Agencies around the state as a starting place for developing their validated TBEST
models. To ease distribution of these systems, TBEST allows for download and local
installation of the systems. The published systems are currently un-validated but it is possible
that as TBEST models are developed and validated, these systems will be made available for
download.
To download a TBEST Transit System, use the following steps:
Downloading a Transit System
Step 1:

Step 2:
Step 3:

Step 4:
Step 5:

From the TBEST Main Menu, select File > Downloads > Download Published
Systems in Distribution File Format. This displays a list of Transit Properties as
shown in Figure 3.6.
Select a Transit System from the list and click Download.
A File Download dialog will appear. Click the Save button. In the Save As dialog,
navigate to C:\TBEST\DistributableSystems\ directory and save the file. A progress
bar displays the status of the download. When the download is complete, click the
Close button.
Click the Close button on the TBEST System Download dialog.
The downloaded TBEST Distribution File will be available in the Distribution Files
folder in TBEST Explorer. The Transit System can now be loaded for use in TBEST
by following the Loading a Transit System from a TBEST Distribution File procedures
in Section 3.2.
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Figure 3.6 - Download a Transit System

Notes on downloading a transit system:
 If the Transit System already exists, TBEST warns about an already installed Transit
System and does not allow the download.
 If you want to publish your system as a downloadable within TBEST, contact TBEST
technical support through the TBEST website.

3.5 Creating a New Transit System
TBEST Transit Systems can be easily created from the formatted Socio-Economic data
available from within TBEST and network information entered by the user via the TBEST
network editing tools. The preformatted Socio-Economic data comes with a listing of Florida
counties within the boundary of the data. When creating the new System, counties are selected
that comprise the service area for the new Transit System. TBEST will then assemble the
population and employment data for the selected counties and make the new Transit System
available in TBEST Explorer. Now that the Transit System has been created, TBEST tools can
be used to create scenarios and develop the transit network.
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To create a TBEST Transit System, use the following steps:
Creating a new Transit System
Step 1:

Step 2:

Step 3:

Step 4:

Step 5:
Step 6:

From the TBEST Main Menu, select File > New > Transit System or right-click the
Transit Systems folder in TBEST Explorer and select New System. Optionally, in
TBEST Explorer, right-click on the Socio-Economic data to be used to create the
system and select Create a New System from this SE data… .
The Source Socio-Economic Data dialog opens. See Figure 3.7. From this dialog,
select the pre-formatted State-level socio-economic data that will be used for the
Transit System. If you have not downloaded any support data, see Socio-Economic
Data Download (Section 3.3) for more instructions. Click OK to continue.
In the New Transit System dialog, provide a name for the Transit System being
created in the Transit System Name text box. There is a 50 character limit with
regard to the length of the name.
Click the browse (…) button next to the Transit System County(s) field. In the
County Selection dialog, choose the counties that the new transit system operates in,
and then click OK. See Figure 3.8 for an illustration of the county selection. Note:
select counties that may be relevant to not only the current year system but to future
years as well. For example, if consideration is being given to expanding service to
outlying counties, include the outlying counties in the Transit System creation.
The default data directory is entered in the File Directory box. This is not editable.
Click OK. TBEST will begin the data extraction process for the new geographic area.
This process will take some time and users should not interrupt the process while the
data is being extracted. A progress bar appears at the bottom of the screen. When
complete, the new Transit System will be available in TBEST Explorer.

Figure 3.7 –Select Source Socio-Economic Data
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Figure 3.8 – County Selection

3.6 Transit System Properties
The properties of a TBEST Transit Systems can be displayed by right-clicking on the target
Transit System in TBEST Explorer. In the Properties dialog box (Figure 3.9), displays the
Transit System Name, Extent (by County), File Directory and the Socio-Economic Data Source
year for Population and Employment datasets. If the model is validated, the Population and
Employment Source Years will be the same as the validation year. The Transit System Name is
editable.

Figure 3.9 - Transit System Properties
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3.7 Copying/Deleting Transit Systems
Transit Systems within TBEST can be copied and deleted. Copying is useful as a temporary
backup of a system or to create systems for alternate validations. Alternate validations may be
necessary for systems that supply service to University or seasonal populations.
Creating a Copy of an Existing Transit System
Step 1:

Step 2:
Step 3:

In TBEST Explorer, right-click the Transit System to be copied and select Copy.
Note: the Transit System may not be in use while copying. If in use, close the
currently open scenario and try again.
In the Copy to… window, (as shown in Figure 3.10), provide a name for the target
Transit System.
Click OK.

Figure 3.10 – Copying a Transit System

Deleting an Existing Transit System
Step 1:

To delete a system, from TBEST Explorer right-click on the Transit System and
select Delete.
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Once a Transit System is deleted, it is not recoverable. If there is any doubt as to whether this
system will be used again, export the Transit System into Distribution File format as a backup.

3.8 Opening Scenarios in TBEST Explorer
A TBEST transit system is composed of model scenarios containing routes, stops, socioeconomic data and network attributes. Scenarios are created for either base year model
development and validation or to model ridership changes to the base year model based on
proposed future-year network or socio-economic modifications. Scenarios are managed within
the TBEST Explorer window.
Scenarios Folder
The Scenarios folder is displayed beneath all installed TBEST Transit Systems and contains a
list of model scenarios that have been created for a particular Transit System. If no scenarios
have been created the folder will be empty. A scenario can be opened for editing by rightclicking the scenario and selecting Open Scenario. TBEST loads all of the data, tables, and
geographic files corresponding for the selected scenario. A progress bar on the TBEST Status
Bar will display the scenario loading steps. Please note that it may take a minute to load and
open a scenario, particularly for larger Transit Systems.
Once open, TBEST Explorer will display an active icon
next to the scenario and the name
of the scenario will be listed in the left corner of the TBEST Status Bar. The scenario is now
open for editing, analysis and reporting.

Figure 3.11 – Scenarios in TBEST Explorer
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Model Status
Under each scenario in the TBEST Explorer window is the model status for each TBEST time
period. The model status notifies the user if edits to the network or socio-economic data have
taken place and thus a model run is required to update ridership and performance measures.
The model status is dynamically updated by TBEST when edits are made to the scenario.
Figure 3.12 below illustrates the model status for the RTS_Validation scenario.
Users should monitor the model status to assist in efficient model runs. For instance, if the
model status is displaying that only the AM Peak model has been edited (shown with a
), the
user will only need to select the AM Peak model when initiating a model run.

Figure 3.12 – Model Status of a Scenario in TBEST Explorer

Model Logs
The Model Logs folder contains three files – the Scenario Edit Log, the Direct Boardings Log,
and the Transfer Boardings Log. The Scenario Edit Log keeps track of editing and model runs.
It provides a list of changes by individual users and by time.
The Direct Boardings and Transfer Boardings Logs are equation logs to be used as quality
control references during model development. The files open in Excel and can be filtered to a
particular stop and time period to view the equation input and parameters. See Figure 3.13 for
an example.
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Figure 3.13 – Direct Boardings Log in Excel

3.9 Creating Scenarios
TBEST scenarios can be directly created through TBEST tools. Users can specify simulation
variables that will define model conditions either in the base year or future year scenario. When
creating a scenario, TBEST copies the base year scenario network and socio-economic data
into the new scenario. If the model is un-validated, the new scenario will not contain a transit
network and the socio-economic data will reflect the source year for population and
employment. The following procedure provides the options for creating scenarios for unvalidated and validated models.

To create a TBEST scenario, use the following steps:
Creating a Scenario
Step 1:
Step 2:

In TBEST Explorer, right-click the Scenarios Folders and select Create a New
Scenario. The New Scenario dialog box will appear on the screen.
Enter the requested information in the dialog box for the new scenario.
Scenario Name: A descriptive name for the scenario.
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Step 3:

Description: The scenario description is a longer name that can be used to describe
and recall the nature of the scenario at a later time.
(Un-validated Model): See Figure 3.14
Enter the information pertaining to the simulation.
Population Source Year: Enter the source year of the population data used to create
the Transit System. As of October 2009, this number will be 2000 for Florida users.
Target Base Year: Enter the year (in four digits) corresponding to the intended Base
Year of the Transit System.
Mean Annual Wage: Enter the average annual person (not household) wage
corresponding to the base year for the analysis region. This is the wage rate that will
be used to compute the value of time (in the generalized cost or impedance
function).
Wage Growth Rate: For an unvalidated model, this value should be zero since you
are using the known mean annual wage for the Base Year.
Employment Data Source: Two options are provided:
Option 1: InfoUSA (point data). By default, TBEST will utilize InfoUSA point data
that was compiled from the Socio-Economic Support data. Users must enter the
Employment Source Year. For Florida users, the default Florida SE package has
2004 data. An updated SE data package is also available with 2007 employment
data.
Option 2: Forecast Year Zonal Employment Data. If available, the user can input
zonal employment data in ESRI shapefile format. The shapefile must contain a
unique identifier field, commercial employment, industrial employment, and service
employment. The required field definitions are: TAZ_NO (Integer), COMM_EMP
(Double), INDUS_EMP (Double), SERV_EMP (Double). For an un-validated model,
the zonal employment data must be consistent with the Target Base Year.

Creating a Scenario (continued)
Step 3:

(Validated Model): See Figure 3.15
Enter the information pertaining to the simulation.
Scenario Base Year: This will reflect the current validated base year. It is
uneditable.
Scenario Forecast Year: Enter the year (in four digits) corresponding to the forecast
year. The forecast year must be greater than or equal to the base year.

127

Step 4:
Step 5:

Mean Annual Wage: The base year Mean Annual Wage should be visible. Unless
you have a discrete projection for a future year, utilize the Wage Growth Rate for
future year simulation.
Wage Growth Rate: Enter the annual wage growth rate (e.g., 2.5%) for the forecast
period.
Employment Data Source: For a validated model, it is not recommended that the
Employment Data Source is modified unless Zonal Employment data was used
during validation. If this is the case, an updated Zonal Employment file should be
supplied that matches the Forecast Year.
Click the OK button.
After creating the scenario, TBEST will automatically load and open the newly created
scenario. The newly created scenario will now also appear in the list of scenarios in
TBEST Explorer.

Figure 3.14 – Create New Scenario (Un-validated Model)
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Figure 3.15 – Create New Scenario (Validated Model)

Viewing and Editing Scenario Properties
Users can view or reset the Scenario properties at any time by right-clicking on the Scenario in
the TBEST Explorer window and selecting Properties.
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3.10 Copy/Delete a Scenario
TBEST provides tools within the TBEST Explorer window to copy and delete existing Scenarios.
Scenario Copy
Copying a scenario can be beneficial to replicate the existing network and socio-economic
options prior to editing as well as providing a means of incrementally adjusting scenario options
for modeling purposes. When performing TBEST Transit System analysis, it may be beneficial
to explore the impacts of incremental changes to the transit system or socio-economic profile of
a region. The TBEST Copy Scenario capability facilitates such an incremental analysis.

Copy Scenario
Step 1:
Step 2:
Step 3:

Step 4:
Step 5:

In TBEST Explorer, right-click the scenario and select Copy.
The Copy Scenario To dialog box will appear on the screen as shown in Figure 3.16.
Note that the only information that can be provided by the user for this scenario
includes the scenario name and the scenario files location (directory path). All other
fields are gray and locked out. Thus, these parameters remain the same for the
copied scenario.
After entering the scenario name and file location, click the OK button.
TBEST will copy the scenario files to the new location and return a message when
the copy operation is complete. The copied scenario name will appear as a folder in
TBEST Explorer. This scenario will be an exact duplicate of the copied scenario; the
user can then use this scenario to further explore the impacts of incremental
changes to service or socio-economic characteristics on ridership.
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Figure 3.16 - Copy Scenario Dialog Box

Deleting a Scenario
It should be noted that all of the databases associated with a scenario may be quite large
depending on the system size and therefore may occupy a significant amount of hard disk
space. It may be beneficial to discard scenarios no longer deemed useful by the user. To
delete a scenario, in the TBEST Explorer window, right-click on the Scenario and select Delete
from the pop-up menu.
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3.11 Update System Socio-Economic Data
TBEST allows for the incorporation of updated
socio-economic data into an existing, unvalidated Transit System model. The new
socio-economic data can be downloaded
through the method discussed in Section 3.3.
This function also allows for expanding the
Transit System service area by designating
additional counties to include in the update.

Figure 3.17 – Right-Click System Dialog Box

To Update System Socio-Economic Data:
Step 1:
Step 2:
Step 3:

Step 4:

From TBEST Explorer, right-click the Transit System to update and select Update
System Socio-Economic Data.
From the Source Socio-Economic Data dialog, select the data to be used for the
update. Click OK to continue.
The Update Socio-Economic Data form opens. If necessary, modify the County
selection to change coverage of the socio-economic data to fit the service area.
Click OK.
The Population and Employment data will be updated to the source year in the
Socio-Economic data.
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4. SOCIO-ECONOMIC DATA INPUTS
TBEST provides the ability to import and utilize pre-formatted Socio-Economic data for model
development. The background demographics used as input for the TBEST model are derived
from the publicly available Census and licensed InfoUSA spatial and tabular databases. The
following sections describe the processes used for configuring these data sources for their use
within TBEST.

4.1 Population Data Sources
TBEST requires three Census file types from the Census:
• SF1 Census Attribute Table
• SF3 Census Attribute Table
• Census Block-level polygon shapefiles
In support of the Florida implementation of TBEST, these Census files have been compiled for
all counties in Florida. This information is available for download through the Downloads option
in the TBEST software.
Census Attribute Tables
Attribute data required for TBEST was downloaded directly from the US Census Bureau’s website at http://www2.census.gov/. The 2000 Census data contains the full survey of results and
data fields required by TBEST.
The Census SF1 summary data files were downloaded using the following web-link;
http://www2.census.gov/census_2000/datasets/Summary_File_1/. The required files for this
dataset are 00001, 00002, 00037, and GEO.
The Census SF3 summary data files were downloaded using the following web-link;
http://www2.census.gov/census_2000/datasets/Summary_File_3/. The required files for this
dataset are 00001, 00002, 00003, 00006, 00007, 0056, 0058 and GEO.
The conversion mapping from the Census tables and fields to the TBEST required fields
mapping are listed below for both SF1 (Table 4.1) and SF3 (Table 4.2).
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Table 4.1 - Census SF1 Field Conversion Mapping

Source SF1 Field(s)

Source SF1 Table

TBEST Field

GEO

LOGRECNO

ID

GEO

AREALAND

AREA

GEO

STATE

STATE

GEO

STATE, COUNTY

COUNTY

GEO

STATE, COUNTY, TRACT

TRACT

GEO

BLKGRP

BLKGRP

GEO

BLOCK

BLOCK

SF10001

P001001

TOTPOP

SF10037

H001001

TOTHH

SF10001

P003004

BLACK

SF10002

P008010

HISP

SF10002

POP65

SF10002

P012020 + P012021 + P012022 + P012023 +
P012024 + P012025
P012044 + P012045 + P012046 + P012047 +
P012048 + P012049
P012026

SF10002

P010008 + P012012 + P018015

HHCHILD

SF10002

POP16
FEMALE
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Table 4.2 - Census SF3 Field Conversion Mapping
Source SF3 Table

Source SF3 Field(s)

TBEST Field

GEO

LOGRECNO

ID

GEO

AREALAND

AREA

GEO

STATE

STATE

GEO

STATE, COUNTY

COUNTY

GEO

STATE, COUNTY,TRACT

TRACT

GEO

BLKGRP

BLKGRP

GEO

BLOCK

BLOCK

SF30001

P001001

TOTPOP

SF30058

H044001

TOTHH

SF30058

H044003 + H044010

AUTOS0

SF30058

H044011 + H044004

AUTOS1

SF30058

H033005 + H033006 + H033007 + H033008 +
H033009 + H033010

POPMF

SF30007

P088002 + P088003 + P088004

POPPOVTY

SF30006
SF30058

SF30006.P057001 / SF30058.H044001

AVGINC

SF30007

P082001

PERINC

SF30006

P053001

INCMEDIN

SF30003

P030001

WORKER

SF30002

P023002

IMMIG

Census Geography
TBEST uses Census Block level shapefiles as the format for spatial distribution of population
data. The shapefiles used for configuration of the model were downloaded from the ESRI
ArcData website and then formatted for use within TBEST. The projection system can be
locally managed but must be consistent with the TBEST network.

4.2 Employment Data Sources
The default option for employment data to support the TBEST model is InfoUSA. The InfoUSA
dataset provides information on the location of a business as represented by an X,Y location,
the number of employees at the business, and the SIC code that represents the business type.
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Within TBEST, the user can configure the source data for Employment. There are two options:
• By default, TBEST will accept employment data from a point data source. For Florida
properties, this has been 2004 InfoUSA data however newer employment datasets have
been made available.
• If available, the user can optionally input zonal employment data in ESRI shapefile
format. The shapefile must contain a unique identifier field, commercial employment,
industrial employment, and service employment. The required field definitions are:
TAZ_NO (Integer), COMM_EMP (Double), INDUS_EMP (Double), SERV_EMP
(Double). If this option is selected, the input employment data must reflect the Forecast
Year of the model. TBEST will not apply growth rates to this data.
Socio-Economic Data Assignment and Growth Calculations
When the TBEST model is run, the Socio-Economic growth engine assigns population and
employment values to a stop based on the local market area within a distance 0.375 miles
around the stop. During this assignment process, any growth factors input by the user are
calculated with the assignment. In this manner, the source/ base year Socio-Economic data is
not altered. The source Census and Employment variables are only altered during the
validation process when the system base year changes.

4.3 Applying Socio-Economic Growth Parameters
Within the TBEST, individual Systems contain multiple Scenarios that can represent various
socio-economic growth estimations. The TBEST model is designed to work with the available
Socio-Economic growth data provided by the user. This can be in the form of a generalized
growth rate for the service area and/or an input future year zonal dataset.
TBEST provides tools to adjust socio-economic data within the context of two general
methodologies:
•

Scenario Growth - Apply a compounded growth rate for the duration between the
model base year and scenario forecast year to all socio-economic data. This can be a
system-wide growth value, a calculated set of zonal adjustments based on a user-input
future-year zonal data, or a combination both.
Note: TBEST also allows users to
reference a forecast year zonal Employment dataset to be used directly in the model
calculations. It is assumed that the user will have updated this dataset to the Forecast
year and the TBEST Socio-Economic Growth Engine will not apply a growth rate to the
data.

•

Localized Growth - Apply localized adjustments to user-specified socio-economic
variables based on known or predicted growth patterns. This adjustment would over136

ride Scenario Growth parameters. This method is discussed in Section 7: Model and
Analysis Tools.
System-Wide Growth Parameters
TBEST scenario modeling will grow base Population and Employment variables using systemwide rates. Available system-wide growth rate variables include:
•
•
•
•
•
•

Population (required)
Employment (required)
Households
Average Household Income
Per-Capita Income
Median Household Income

Using system wide growth rates (non-spatially sensitive): users are responsible for providing a
valid system wide growth rate as an input for the entire system service area. The growth rate
provided will be applied uniformly to the entire socio-economic data in the database with no
sensitivity to the spatial component. TBEST compounds the input growth rate calculation over
the span between the base year and the forecast year of the current scenario. For un-validated
models, TBEST uses the Population and Employment data source years entered when creating
the Scenario.
Total Population: Enter the annual population growth rate (e.g., 2%) for the forecast
period (i.e., for the number of years between the base year and the forecast year).
Total Employment: Enter the annual employment growth rate (e.g., 3%) for the forecast
period.
Population and Employment growth rates are mandatory fields. If no inputs are provided for
some or all of the non-mandatory fields, the system-wide population or employment growth rate
gets applied to them automatically. See Table 4.3 for Growth Rate Application.
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The following steps detail how to enter system-wide socio-economic growth rates.
Entering System-wide Growth Rates
Step 1:
Step 2:

Step 3:

Step 4:

In the TBEST Explorer window, open the Scenario to be adjusted.
Open the Socio-Economic Data Growth Rates form by clicking the Update SocioEconomic Data button on the main TBEST toolbar and selecting Enter Growth
Rates from the drop down menu.
Enter the system wide growth rate values. Total Population and Total Employment
are required but can be set to zero if growth rates are unknown. See Figure 4.1 for
illustration.
Click the Set Growth Rates button. TBEST will show a verification form. After
selections are confirmed, continue with the process by clicking Yes on the form.
TBEST will apply the growth set growth rates to the current scenario. Note: The
TBEST model must be run for all time periods before the SE adjustments will be
reflected in the ridership estimations or performance measures.

Figure 4.1 - System-wide SE Growth Rates

Zonal Growth Parameters
TBEST has the ability to apply Socio-Economic data adjustments based on future year zonal
Socio-Economic projections. This requires that a zonal (polygon) dataset be provided as input
with future year SE data as attributes. This dataset needs to be in an ArcGIS compatible format
(shapefile or personal geodatabase). Using the input data and the projection year of the zonal
data, the TBEST engine will calculate the spatial intersection between the zonal data and the
Census Block Group geometry of the region then develop growth rates by Census Block Group.
These growth rates will be applied to stops that fall with the Census Block Group geometry.
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It is not required that the input future-year zonal Socio-Economic data contain all of the TBEST
variables. Where there is a gap, the appropriate growth rate will be applied as determined by
the data available. See Table 4.3 for more information on how Zonal Growth Patterns and
System-Wide growth parameters are applied within TBEST.
Scenario Growth Rate Application
Within the TBEST, growth rates are applied based on the users’ available data. TAZ input data
works together with system-wide rates to provide the best-available rate application. Table 4.3
illustrates how TBEST variables growth rates are applied. The first column in the table
organizes the variables into groups with group base variables in bold and sub-variables listed
below the primary. The table includes four methods for growth rate application; Primary,
Secondary, Tertiary and Default listed in order of decreasing precision.
Primary Rates are those calculated from a zonal data source when the TBEST variable contains
a direct match to a variable in the input TAZ data. This includes the group sub-variables. Note:
in order to access a sub-variable in a group, the base variable must be referenced to the TAZ
data source.
Secondary rate applications are those in which the group level base variable is defined but the
sub-variables in a group are not. The base group rates (Total Population, Total Households, or
Total Employment) are applied to missing sub-variables in the group.
For the Income
variables, the Secondary rate application is based on the calculated rate for Total Population.
Tertiary rate applications are those where no TAZ data is defined but optional system-wide
growth rates have been entered. The optional system-wide growth rates are:
•
•
•
•

Total Households
Average Household Income
Per-Capita Income
Median Household Income

The Default growth rates are those for Total Population and Total Employment. These default
rates are applied if no other zonal data or optional system growth rates are provided.

139

Table 4.3 - TBEST Socio-Economic Data Scenario Growth Rate Application

TBEST SE Variable
Total Population
Black Population
Hispanic Population
Female Population
Foreign-born Population
Population greater than 65 years
Population under 16 years of age
Population that is employed
Population in multi-family dwelling
Population in poverty
Total Households
HH with zero-vehicle
HH with one vehicle
HH with children 16-years of age
Average household Income

Primary Rate
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable

Secondary Rate
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Population
Zonal Total Households
Zonal Total Households
Zonal Total Households
Zonal Total Households
Zonal Total Population

Per-Capita Income

Zonal Variable

Zonal Total Population

Median household Income

Zonal Variable

Zonal Total Population

Total Employment
Service Employment
Industrial Employment
Commercial Employment

Zonal Variable
Zonal Variable
Zonal Variable
Zonal Variable

Zonal Total Employment
Zonal Total Employment
Zonal Total Employment
Zonal Total Employment

Tertiary Rate
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
N/A
System Total Households
System Total Households
System Total Households
System Total Households
System Average
Household Income
System Per-Capita
Income
System Median
Household Income
N/A
N/A
N/A
N/A

Default Rate
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Population
System Total Employment
System Total Employment
System Total Employment
System Total Employment
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Compounded Growth Rate
For TAZ growth rate application, TBEST calculates a compounded growth rate for each input
TAZ variable at the Census Block Group-level within the Transit System service area. This
growth rate is calculated by comparing the source year Population and Employment data
aggregated to the Block Group level with input TAZ values aggregated to the Block Group level.
The difference in aggregated Block Group values and span (in years) between the TBEST
socio-economic data and the TAZ data provide the needed input to calculate a compound
growth rate number for each Census Block Group. The growth rate is then applied to the
number of years between the base year and forecast year in the Scenario.
In the formula below,
• “i” is the growth rate,
• FV and PV represent the future (Projected socio-economic data) and present value
(Base year socio-economic data);
• “n” represents the difference in number of years between the projected and the base
year.
Growth rate, i % = {[(FV/PV) ^ (i/n)] – 1} * 100

Flow Chart demonstrating the Spatial analysis involved in Calculating the Growth Rates

Example of TBEST TAZ Socio-Economic Growth Rate Calculations
Base Year of the Socio-Economic Data = 2000
Projected Year of the Socio-Economic Data = 2009
We know the Current population for Census Block Groups:
POPc (A) = 2000
POPc (B) = 4000
Calculating the Projected Population for Census Block groups:
POP f (A) = 1500 + (0.2 * 3200) + 2500 + (0.2 * 2800) = 5200
POPf (B) = (0.8 * 3200) + (0.8 * 2800) = 4800
Using the Growth Rate Equation discussed above:
Growth Rate for Census Block Group A = [((5200/2000) ^ (1/9)) – 1] * 100 = 10.02%
Growth Rate for Census Block Group A = [((4800/4000) ^ (1/9)) – 1] * 100 = 1.83%

Steps to incorporate zonal Socio-Economic data forecasts into TBEST Socio-Economic data
Entering TAZ Growth Rate Information
Step 1:
Step 2:
Step 3:

Step 4:
Step 5:

From the TBEST Explorer window, open the Scenario to be adjusted.
Open the Socio-Economic Data Growth Rates form by clicking the SE Growth
button on the TBEST Main Toolbar.
At the bottom of the form, check Import Future Year Socio-economic Projections
check box. The Socio-Economic Data Growth Rates form changes its display to
accommodate an input TAZ/Polygon layer (Figure 4.2).
Click on the Browse(…) button to point to the layer containing the projected socioeconomic data.
Use the Projection Year dropdown list to select the projection year of the socioeconomic data. Note: this is not the scenario year of the model. For example, if the
zonal input layer has SE data projected to 2035, then select 2035 in the list.

Figure 4.2 - Zonal SE Growth Rates

Step 6:

Step 7:

Once the layer has been referenced, the Total Population, Total Households,
Total Employment and Income text boxes and Lookup buttons become enabled.
Note: Input to a base attribute is mandatory if the subordinate attributes are to be
provided as inputs.
Match the TBEST attribute/variable to a column from the input zonal dataset. To
input the reference column, click the Lookup button
to the right the TBEST
variable. The Reference Column dialog will list all columns in the input zonal
dataset. Select a column from list that matches the TBEST variable. For
illustration, see Figure 4.3 Zonal SE Growth Rates – Reference Column.

Figure 4.3 - Zonal SE Growth Rates – Reference Column

Step 8:

Step 9:

Continue to match all variables that are available in the input zonal file. It is not
necessary to match all variables. The base attribute or system growth rate will be
applied to those that are not available.
Click the Set Growth Rates button. TBEST will show a verification form. After
selections are confirmed, continue with the process by clicking Yes on the form.
TBEST will apply the growth set growth rates to the current scenario. Note: The
TBEST model must be run for all time periods before the SE adjustments will be
reflected in the ridership estimations or performance measures.

Export Socio-Economic Data by Census Block Group
TBEST provides tools to export the results of socio-economic growth to Census Block Group
geography. Exported shapefiles are added to the TBEST map and symbolized to display
growth rate or growth value distribution.
There are two export options:
1. Export Zonal Growth Rate – Exports the growth rate assigned to each Census Block
Group to a shapefile. By default, the population growth rate distribution is symbolized in
the map, however, the symbol properties can be changed using the TBEST Map
Control to show distribution for any TBEST socio-economic variable.

2. Export Zonal Socio-Economic Data – Exports data that has had the calculated growth
rate applied for the scenario duration from the base year or the data source year to the
forecast year. By default, the population distribution is symbolized in the map,
however, the symbol properties can be changed using the TBEST Map Control to show
distribution for any TBEST socio-economic variable.

Exporting System-wide Growth Rates or Growth Values
Step 1:
Step 2:

Step 3:
Step 4:

Step 5:
Step 6:
Step 7:

In the TBEST Explorer window, open or create a Scenario.
Select either the Export Zonal Growth Rates or Export Zonal Socio-Economic
Data drop-down menu options under the Update Socio-Economic Data button on
the main TBEST toolbar.
Enter an export file name and location. See Figure 4.4.
TBEST will process the export file and add it to the map when complete. The
shapefile will be added to the TBEST base map and symbolized to show either
Population growth rate distribution or calculated Population values distribution. See
Figure 4.5.
Right-click on the newly added Growth Rates or Growth Values layer in the TBEST
Map Control and select Layer Properties.
In the Layer Properties dialog, select the Symbology tab.
In the Value drop-down box, select a socio-economic variable to show the
distribution on the map. See Figure 4.6

Figure 4.4 – Export Growth Rate to a Shapefile

Figure 4.5 – Exported Growth Values in TBEST Map

Figure 4.6 – Layer Properties Dialog to modify Symbol Field

5. NETWORK DEVELOPMENT
TBEST transit network development takes place inside the TBEST Scenario Edit Environment.
This environment is comprised of a Map Window, Map Control Tab, Routes Tab, Segment Tab,
and Stops Tab. The TBEST Main Menu and Main Toolbar also contain Scenario specific tools
for network development. This section explains the necessary functions and tools in the TBEST
Scenario Edit Environment that enable the development of transit routes, route segments,
stops, and other coding options required to build a quality transit network.

5.1 Scenario Overview
Opening a Scenario
To open a scenario, navigate to the scenario within the TBEST Explorer window, right-click on
the target Scenario, and select Open Scenario from the popup menu. TBEST will initialize the
scenario and enable the Scenario edit environment.
Closing a Scenario
To close a Scenario, go to the File menu and select Close Scenario or click on the Close
button
in the TBEST Main Toolbar. If edits have been made to the Scenario, TBEST
will prompt the user to keep or discard the changes.
Saving a Scenario
Network, service and socio-economic data edits occurring inside of a TBEST scenario edit
session can be interactively saved by clicking the Save button
on the Main Toolbar. The
Scenario save process will also store references to map layers that have been added by the
user during the edit session. To discard edits and changes, close the active scenario and click
the No button when prompted by TBEST whether the scenario (edits) should be saved prior to
closing.
Note: The TBEST Scenario edit environment does not have an Undo Edit function.

5.2 Map Window
The Scenario Map Window is comprised of mapping functions that are used in standard GIS
map navigation and update.

Figure 5.1 - Map Window Toolbar

Map functions include the following:
Pointer. This standard pointer tool allows for selecting other tools. It is the default form
of the mouse unless another specific tool is selected.
Zoom In. Use this tool to zoom into a certain selected area or portion of the map.
Zoom Out. Use this tool to zoom out of a certain area or portion of the map.
Pan. Use this tool to pan the map and move the map to the desired view.
Route Identify. Use this tool to obtain a list of TBEST routes at any location on the
map. From the list of routes returned by a map-click, the user can select a route from
the list and either Edit, Flash Route, or Flash Stops. .
Identify. Use this tool to obtain information on any feature on the map by clicking on the
feature within the map.
Measure. This tool can be used to measure the straight crow-flying distance between
any two points on the map (in feet).
Fixed Zoom In. Click on this tool to zoom into the map while retaining the current
position of the map center.
Fixed Zoom Out. Click on this tool to zoom out of the map while retaining the current
position of the map center.
Maximum Extent. Click on this tool to zoom to the maximum extent and obtain a full
view of the transit system and model area.

Clear Map. Use this tool to clear the selection or User-defined analysis shapes in the
map window. Any selection set appearing in the Map window and highlighted in the
Routes or Stops windows will be cleared.
Refresh. Use this tool to refresh the map display. In general, the map display should
refresh automatically; use this tool whenever this does not occur.
Open in ArcMap. This tool allows the user to open the map display in ArcMap. This
provides the user the ability to work with the map in a full ArcGIS environment.
Undo, Redo Zoom. This tool initially is grayed out, but becomes available as soon as
another zoom function is used. It allows you to undo (left arrow) or redo (right arrow) the
most recent zoom.
Map Scale. To change the scale of the map, change the value and hit the
Enter key.

Tips for using Map Navigation for Network Coding
Map Scale
The closer the zoom the higher accuracy the network will be in relation to your base map road
network. Select a scale that reflects the accuracy required for network coding and enter it
directly in the Map Scale drop-down box on the Map Toolbar.
Zoom functions
For the purposes of editing, it is sometimes easier to use the Zoom-In
button to get
near the desired map scale, while centering the map on the area to be edited. Once the map
scale has been set, use the Pan
button to re-center the map on the area to be edited. To
return to the previous extent, use the Undo Zoom
button. The Zoom to Max Extent
button
will return the extent to the show the entire transit system. The route remains
activated throughout any zoom extent changes.
Zooming and Panning using the Keyboard
During network coding, it is often helpful to zoom or pan without using the mouse to change
from a digitizing tool to a zoom tool. To alleviate this issue, use the following keyboard
shortcuts:
• Zoom In (Ctrl-I)
• Zoom Out (Ctrl-O)

•
•
•
•

Pan Right (Right Arrow)
Pan Left (Left Arrow)
Pan Up (Up Arrow)
Pan Down (Down Arrow)

5.3 Map Control
The TBEST Scenario editing environment contains a Map Control tab with reference to the base
layers required by TBEST and any additional layers that have been reference by the user. (see
Figure 5.2). This includes the selected Base Map layer, Census information, Employment
information from InfoUSA, Route segments, and Stops. The Map Control is similar to the table
of contents used to manage layers in ArcMap. The Map Control also provides to the ability to
reference local data and imagery into the map, modify layer properties, and remove unwanted
layers.

Figure 5.2 – Map Control Tab

Adding GIS Layers
For transit systems that have pre-existing GIS layers of their route networks and bus stop
inventories, it will be advantageous for the coding effort to add them to the Scenario. In the Map
Control tab, click the Add Data button
. Navigate to the folder location of the layer to add
and select the file. Click OK. The layer will be added to the scenario. To remove the Layer,
right-click the layer in the Map Control and select Remove Layer.
Note: GIS Layers can be in ESRI shapefile or personal geodatabase format.

Modifying Layer Properties
To view or modify layer symbols, labels and other properties, right-click on the layer in the Map
Control and select Layer Properties. The ArcMap Layer Properties dialog will appear. Use
this dialog to modify components of the layer as necessary. For more information on the
ArcMap Layer Properties dialog, see the ArcGIS Desktop Help. This option is not available if
running TBEST from an ArcGIS runtime license.
Note: Modifying the Properties for default Stops and Routes is not permanent. To modify the
default symbols for Stops and Routes, reference the C:\TBEST\TransitSystems\BEST.style file
into ArcMap. See the ArcGIS Desktop Help for modifying .style files.

Figure 5.3 – Layer Properties

5.4 Managing Routes
The TBEST Routes Tab provides tools to manage transit routes within the current scenario.
Routes Toolbar
The Routes Toolbar (Figure 5.4) provides access to the following route management options:
•
•
•
•

Creating Routes
Deleting Routes
Editing Routes
Sorting the Route List

The Routes Toolbar also provides additional tools for network coding including:
•
•
•
•

Copy Routes
Copy Route to Reverse Direction
Generate Stops
Calculating Stop-to-Stop Travel Time

Figure 5.4 – Routes Toolbar

Route Network
The Routes Tab (see Figure 5.5 below) displays a list of all routes including Route Name,
Description, Route Type and Route Technology.

Figure 5.5 –Routes Tab

Creating a Route
To create a new route, click on Route Options, and select Add a Route (see Figure 5.6).

Figure 5.6 – Add a Route

The New Route dialog will be displayed as shown in Figure 5.7. Select the Route Type (Radial,
Circulator, Crosstown, or Express), and the Route Technology (Bus, Heavy Rail,People Mover,
Street Car, BRT, Light Rail, Other). Input the Route Name, the Route Description and the
Directional Descriptions. Click OK and the new Route will entered into the Route Network.

Figure 5.7 –New Route Dialog

Note on Technology Modes: TBEST is currently calibrated to be sensitive to Bus technology
only. As more technology modes are tested and calibrated, the TBEST model coefficients will
be updated to reflect this sensitivity. If you are coding routes other than Bus, code the route
type to reflect the actual technology so that future TBEST releases containing updated
coefficients will be sensitive to your coded network.
Note on Route Deviations: TBEST routes must contain a stop-to-stop path. Before beginning
to code the route structure, review the schedule and determine if any route deviations exist. If a
route deviates from the primary route during a portion of the day, TBEST requires that the
primary and deviated paths be coded as separate routes. However, these routes can share the
same geometry on the trunk portion of the line. The TBEST Route Copy function described in
Section 5.16 can assist in capturing the trunk of the route. The copied route geometry and
stops can then be modified at the deviation point(s). In this situation, based on the schedule,
arrivals (trips) may need to be split between the primary route and the deviated route.
Note on Route Direction: TBEST manages routes by direction. For all route types other than
circulators, directional descriptions will need to be defined. For Circulators, only one direction is
defined. In general, these descriptions are meant to indicate inbound/outbound,
northbound/southbound or eastbound/westbound direction types but any unique indicator can
be input that is understandable by the user.

Route Properties
To change route properties, click the Route Properties button

in the Routes toolbar.

Figure 5.8– Accessing Route Properties

The Route Properties dialog opens allowing edits to the Route attributes. Click OK, and the
Route Properties will be updated.
Note: Routes coded as Circulators cannot be changed to any other route type.
Radial, Crosstown and Express routes cannot be changed to Circulators.

Likewise,

Note: After the system has been validated, you will not be able to modify the Route Type or
Technology.
Deleting a Route
To delete an existing Route, select the Route in the Routes tab and click the Delete Route
button on the Routes Toolbar. You will be asked if you want to delete the route. Click Yes.
The Route will then be deleted from the Scenario.

Sorting the Route List
Routes can be sorted in the Routes Tab by clicking the Route Options drop down menu on the
Routes Toolbar and selecting Settings > Sort by… There are four options for sorting:
Sort by Route Name – Alphabetical list of route name
Sort by Route Description - Alphabetical list of Route Description field
Sort by Route Type – Will sort by Radial, Circulator, Crosstown, or Express

Sort by Route Technology – Will sort by Bus, Heavy Rail, Peoplemover, Streetcar, BRT,
Light Rail, or Other

Figure 5.9 – Route Sorting Options

Activating a Route for Editing
TBEST allows the user to add and update the segments and stops which comprise the Route.
Before adding or modifying segments and stops, the Route in single direction must be activated.
To activate a route for editing, expand the node for the Route and select the Route direction to
edit. Only one direction of the route can be edited at any given time. Select Edit Route in the
Route Options menu, or double-click on the selected route direction to activate the route.

Figure 5.10 – Edit Route

In the Map window, the map zooms to the extent of the activated route, and existing segments
and stops will be displayed with a yellow highlight. In the Routes tab, the arrow beside the route
direction activated will have turned yellow. In the Segments tab, the symbol beside each route
segment in the activated route will also have turned yellow. The TBEST Status Bar will list the
active route name and total length in miles. The TBEST Status Bar will also display the visible
stops, or total number of stops which exist along the activated route. See Figure 5.11 for an
illustration of the changes that occur in TBEST when a route is activated.

Figure 5.11 – Activated Route in TBEST

5.5 Segment Editing
The TBEST Scenario editing environment contains tools to edit the spatial and attribute values
for all segments within the scenario. The Segments tab contains a Segment Editing toolbar
(Figure 5.12) and a table (Figure 5.13) listing the segments within the scenario.
Segment Editing Toolbar
The Segment Editing toolbar supplies the tools to select, add, re-shape, split, merge and delete
segments in the network.

Figure 5.12 – Segment Editing Toolbar

Segments Table
The Segments table contains stop attributes for Segment ID, Corridor ID and In-vehicle Travel
Time (IVTT) for each TBEST time period.

Figure 5.13 – Segments Table

TBEST Segment Properties
• For TBEST, segments are the linear representation of transit routes by direction. A
transit route can contain multiple segments or single segment that defines the entire
route. Multiple segments can be developed to show variations in segment attributes
such as CorridorID or Time Period IVTT. For example, a TBEST route could be devised
to break at each time point along a route. From the schedule, the IVTT for each time
period is calculated and input in the Segment table.
• Segments can be digitized only on an Active Route.
• When a scenario is open, segments are always visible in the TBEST Map window and
the Segments table. There are no built-in options to modify segment visibility or filter the
records.

5.6 Segment Attributes
TBEST Segments contain attributes for network organization and IVTT characteristics. These
attributes are editable by the user. The general categories for stop attributes are:
•
•

Segment Definition Attributes
Time Period In-Vehicle Travel Time (IVTT)

Each category has its own set of functional aspects as it relates to network coding, update and
analysis. Table 5.1 provides a definition for each TBEST segment attribute by category. The
categories are also discussed in the next section.
Table 5.1 – TBEST Segment Attributes by Category
Category
Segment

Attributes
Route

The segments associated route. This attribute is not
editable in the Segment table.

Length (mi)

Length of the segment in miles. This attribute is not
editable in the Segment table.
Unique segment identifier

Definition

SegmentID
CorridorID
Time Period In-

AM IVTT

Vehicle Travel
Time (IVTT)

Attribute Definition

Off-Peak IVTT

PM IVTT
Night IVTT
Saturday IVTT

Sunday IVTT

Flag that allows grouping of segments (regardless of route)
along a Corridor for any other summary area
IVTT (in minutes) from the beginning of the segment to the
end of the segment for the TBEST AM Peak time period.
IVTT (in minutes) from the beginning of the segment to the
end of the segment for the TBEST Off-Peak Peak time
period.
IVTT (in minutes) from the beginning of the segment to the
end of the segment for the TBEST PM Peak time period.
IVTT (in minutes) from the beginning of the segment to the
end of the segment for the TBEST Night Peak time period.
IVTT (in minutes) from the beginning of the segment to the
end of the segment for the TBEST Saturday Peak time
period.
IVTT (in minutes) from the beginning of the segment to the
end of the segment for the TBEST Sunday Peak time
period.

Segment Definition Attributes
Each segment within the network can be organized by a unique SegmentID. The SegmentID
provides a segment management ID that identifies the characteristics of the segment. This
could be any alphanumeric combination. The CorridorID is a flag that allows grouping of

segments (regardless of route) along a Corridor for any other summary area. See Figure 5.14.
This flag is segment organization, selection and reporting purposes. TBEST Reporting is able
to generate a summary report for all unique CorridorID’s in the network.

Figure 5.14 – SegmentID and CorridorID

Time Period In-Vehicle Travel Time (IVTT)
Consult your own transit system’s schedule tables to assess the in-vehicle travel time (IVTT)
between time points. When developing the network, it is advantageous to create segments from
time point to time point. It will make the assignment of IVTT for each segment a straightforward
process. See Figure 5.15 for an illustration of the Segment IVTT columns in the Segments table.

Figure 5.15 Inputting IVTT

Figure 5.16 shows a sample schedule table from a transit system. Suppose that Segment 1 for
the following route was created from time point 1 (Downtown Terminal) to time point 2 (Central
Park Plaza). As shown in the figure, it takes 10 minutes (from 5:45 to 5:55) for the bus to travel
this segment. Therefore, you would input 10 minutes into the AM IVTT (In-Vehicle Travel Time)
for that segment. You would do the same for all other time periods that the route operates.
Input a zero for any time period that the route does not operate.
Note: To utilize the route-level Calculate Travel Time functionality, the segment IVTT must be
entered for each segment on the route. Calculate Travel Time calculates the stop-to-stop IVTT
based on the segment level values and the route distance between each stop. See Section 5.16
for more information.

Figure 5.16 Sample Schedule Time Table

For future year application, the IVTT can be estimated on new routes as a function of a user
defined speed on the proposed route. For more information on calculating IVTT from an input
speed, see Section 5.8 on Performing Segment Attribute Modifications.
Selecting Segments
TBEST provides a variety of methods to interactively select groups of segments based on
spatial location, attribute or other methods. The TBEST segment selection methods are:
1. Select from the Segments Table
Clicking directly on Segment records in the Segment table will select them in the table
and in the Map. By holding down the Shift key during selection, the group of Segments
in the list between the currently selected Segment and the clicked Segment will be
selected. By holding the Ctrl key down during selection, Segments can be either added
to or removed from the current selection.
2. Select from the Map
Select the Select Route Segment
tool from the Segment Editing toolbar. Click on
the Map to select segments. TBEST will select all Segments at this location. Holding
the Shift key down while selecting will add Segments to the selection. Holding the Ctrl
key down while selecting will remove Segments from the selection.
3. Search Tool
See Section 7.1 Attribute Search for more information on building an attribute query to
select Segments.

Note: Clear the current Segment selection by clicking the Clear Map
Toolbar.

button on the Map

Zooming to the Selected Segment
To zoom to the selected Segment, right-click on the Segment table, and select Zoom to
Selected. The Segment selected will be shown centered in the Map window.

Figure 5.17 – Zoom to Selected Segment

5.7 Performing Segment Attribute Modifications
TBEST provides tools to update Segment attributes by either directly modifying cells in the
Segments table or by updating multiple records using the TBEST Calculator. This section
discusses the methods for performing segment attribute modifications.
Cell Editing
Editing cells in TBEST is very similar to Microsoft Excel. Once you have navigated to the cell to
be edited, enter the new value in the cell and either press the Enter key or navigate away from
the cell to accept the value. To permanently store the value, press the Save button on the Main
Toolbar. To discard the value, exit the Scenario without saving.
TBEST Segment Calculator
The TBEST Calculator is used in conjunction with the current Segment selection to modify the
values for the selected group of segments. The Calculator is accessed either from the Segment
Editing toolbar by either pressing the Calculate Segment Values
button or from the
Segment Options drop-down menu.
Once opened, the Calculator will display the columns in Segment table.

Figure 5.18 – Segment Calculator

The Calculator provides two update options: Set a Value and (+/-) % of Current Value. Set a
Value will update the group of selected segments to a discrete value such as CDR-1 for
CorridorID. The (+/-) % of Current Value option allows for adjustment of a numeric variable by a
user defined percentage growth rate. For example, based upon proposed improvements to a
corridor in a future year analysis, AM IVTT can be reduced by 20%.
When calculating Segment-level IVTT, the user has the ability to alternately enter a segment
speed. To have TBEST calculate the IVTT from a speed, check the Enter Segment Speed
(MPH) checkbox and enter the speed in the Set a Value text box.
When the Calculator parameters have been set, click the Update button. To permanently store
the value, press the Save button on the Main Toolbar. To discard the value, exit the Scenario
without saving.

5.8 Editing Segment Geometry
Segment geometry editing takes place on the Active Route. Editing segment geometry includes
the following options:
•
•
•
•
•
•

Adding Segments
Moving Segment Vertices
Deleting Segment Vertices
Splitting a Segment
Merging Segments
Deleting Segments

Adding Segments
To add a segment, click on the Add Route Segment button
in the Segments tab, or click
the Segment Options tab, and click Add Segment. All Segment Options shown in Figure 5.13
are also accessible by right-clicking on a Segment or group of Segments.
When the cursor returns to the Map window, it becomes cross-shaped. To begin digitizing a
route segment, click once at the beginning of the segment. Figures 5.19-5.21 illustrates the
segment digitization process.

Figure 5.19 – Begin Adding Route Segment

To change direction or to navigate curves in the road, click again to add a vertex. To finish the
segment, double-click at the end of the segment.

Figure 5.20 – Finished Route Segment with Vertices shown in Mapping Window

Notice how each vertex clicked along the segment is represented by black squares (vertices).
Also the direction of the route is denoted by red arrows. The segment will also now appear in
the Segment table.
To continue the route, click on the end-point of the previous segment, and proceed from there.
As the route segment continues outside the current view in the map window, use the arrow keys
on the keyboard to pan over as the segments are being digitized.

Figure 5.21 – Continue Adding Segments from End Vertex of Previous Segment

Note: TBEST Segments are developed in sequential order and direction. Segments must be
digitized in the same direction. TBEST will not allow segments to be entered in the wrong
direction.
Note: If you are adding a segment to the beginning of the route (and a segment(s) already
exists), the new segment should end at the beginning point of the first segment in the route. If
you are adding segments to the end of the route, the beginning point of the new segment should
start at the end point of the last segment in the route. The red arrows on the map will assist in
determining the direction of flow for the route. If an internal segment is needed, simply code
between the endpoints of the two segments in the correct direction.
Note: Segments do not automatically snap to the underlying street network geometry.

Adding Vertices
To add vertices, useful for adding deviations or improving the accuracy of curved portions of the
route, click the Edit Route Segment
button. The pointer will turn from black to white
when it hovers over the route where no vertex currently exists. Click the pointer, and a new
vertex will be added to the route.

Figure 5.22 – Adding Segment Vertices

Moving Segment Vertices
To move a segment vertex, click the Edit Route Segment button
located on the Segments
tab. This button will allow you to grab a vertex and move it to its new location. The pointer will
become a four-point compass when it hovers over a vertex. Click on the vertex, and hold the
mouse button down until it has been moved to its desired location.
Release the mouse button, and the route will realign in the map window to the changed vertex
location. Figure 5.23 shows the realigned route after all four vertices were moved.
Note: As the segment geometry is modified, stops that exist along the modified segment will
proportionally re-position themselves along the segment geometry.

Figure 5.23 – Moved Segment Vertices

Deleting Vertices
To delete a vertex, click the Edit Route Segment
button. The pointer will become a fourpoint compass when it hovers over a vertex. Right-click on the vertex and it will blink three
times. Click Delete Vertex.

Figure 5.24 – Deleting Segment Vertices

The vertex will be removed, and the route segment realigned in the map window to reflect the
absence of the vertex.
Splitting a Segment
Sometimes it is useful to split a route segment into two or more separate segments, such as
when the path of a route change, time points having changed, or it is required for reporting
along a defined length of the route. The Split Active Route Segment tool will split a segment at
the desired location.
To split a segment, activate the Route with the target segment. Click the Split Active Route
Segment
button. This will turn the cursor into an arrow. Click at the point at which the
route segment will be split. There does not need to be an existing vertex at that point for this
tool to work. The single segment will now appear as two in the Map window. The two split
segments also appear in the Segments table, where both segments will maintain the properties
of the original segment until manually changed. In Figure 5.25, the red circled area shows the
location where the route was split.

Figure 5.25 – Splitting a Route Segment

Merging Segments
To merge two segments into one, highlight the desired route segments – they must be
sequential in the Segment table. Click the Merge Active Route Segments
button. The
route segments will automatically merge and a dialog box will let you know that the merge was
successful.

Figure 5.26 – Merging Route Segments

The two segments will now appear as one in the map window, and in the Segments table.
The new segment will maintain the properties of the first of the series of segments merged until
changed manually. This tool will only allow two segments to be merged at a time; for three or
more segments, multiple merge functions must be performed.
Deleting Segments
To delete a segment, highlight the desired segment. Click the Delete Route Segment
button. If you select yes, the segment will be deleted from the system. Deleting a segment will
automatically delete all stops along the segment.

5.9 Service Span
Once a route is digitized, the Service Span can be entered for each TBEST time period.
To enter Route Service Span:
Step 1:
Step 2:
Step 3:

On the TBEST main menu, click Scenario > Service Span or click on the Network
Service Span button
on the main toolbar.
In the Route Service Span form, locate the route you want to modify.
Enter service span values (in hours) for AM Peak, Off-Peak, PM Peak, Night,
Saturday and Sunday. Note: Service can be input in fractions of an hour.

Figure 5.27- Service Span window

Notes for entering service span:
• By default, the duration for each time period is populated in the Service Span form.
• Service Span is a variable used in TBEST model calculations.
• The input service span variables are used in calculating stop headway/arrivals. For
example, if a Saturday service span of 5 hours is input for a given route and the user
calculates the arrivals (trips) to be 10 for each stop on the route, the headway will be
automatically calculated by TBEST to be 30 minutes.
• If there is no service in a given time period, enter zero.

The time periods in TBEST are defined as:
AM Peak

6:00am - 8:59am

Off Peak

9:00am - 2:59pm

PM Peak

3:00pm - 5:59pm

Night

6:00pm - 5:59am (following morning)

Saturday

24 hours

Sunday

24 hours

5.10 Stop Editing
The TBEST Scenario editing environment contains tools to edit the spatial and attribute values
for all stops within the scenario. The Stops tab contains a Stop Editing toolbar (Figure 5.28) and
a table (Figure 5.29) listing the stops within the scenario.
Stop Editing Toolbar
The Stop Editing toolbar supplies the tools to add, move, and delete stops into the network.
The toolbar also contains a drop-down menu that displays the current Network Time Period
being reflected in the Stops table. The time period specific stop attribute columns will reflect the
values for the selected Time Period.

Figure 5.28- Stop Editing Toolbar

Stops Table
The Stops table contains stop attributes for Stop Definition, Time Period Specific Service
Characteristics, Socio-Economic Variables including Population, Employment, Households, and
Income.

Figure 5.29 - Stops Table

TBEST Stop Definition
For TBEST, stops are assigned to a Route and Direction. Thus, if a stop location is served by
multiple routes, a TBEST stop will need to be added for each route by direction that accesses
the stop location. Stops are digitized along segments belonging to the Active Route. Digitized
stops can be placed no more than 200ft from an existing segment. As stops are digitized on the
map, corresponding records are inserted into the Stops table based on the sequence they occur
along the route. The Route column is not editable in the Stops table but it gives a reference to
the owning Route for each stop.

5.11 Stop Attributes
TBEST stops contain attributes that detail the network and socio-economic characteristics
present at the each stop location. For the most part, these attributes are editable by the user.
The socio-economic data is calculated by TBEST during the model run procedure but the
calculated values can be updated by user input. The general categories for stop attributes are:
•
•
•

Stop Definition Attributes
Time Period Specific Service Characteristics
Socio-Economic Variables

Each category has its own set of functional aspects as it relates to network coding, update and
analysis. Table 5.2, below, provides a definition for each TBEST stop attributes by category.
The categories are also discussed in the next section.
Stop Definition Attributes
Each stop within the network has reference “operational” attributes such as a stop name,
description, and time point. These attributes are not required for the basic TBEST model to run
but they are required for coding discrete transfer points such as interliners and transfer stations.
These attributes are also helpful map labeling and reporting.

Table 5.2 – TBEST Stop Attributes Definition by Category
Category
Stop Definition

Time Period

Attributes

Name

The stops’ associated route. This attribute is not editable in
the Stops table.
Stop name as operationally defined

Description

Stop description as operationally defined

Time Point

Time Point identifier derived from the schedule. Time point
identifiers are used in defining the transfer stations.
Number of arrivals (trips) at the stop during the selected
Network Time Period.
Headway (minutes) at the stop during the selected Network
Time Period.
In-vehicle travel time from the previous stop on the route
during the selected Network Time Period (expressed in
fractions of a minute)
Flag to apply additional ridership influence at the subject
stop. Current special generators include: Park-n-Ride,
Military, Shopping Mall, University, Event Center, Rec Park,
and Airport.
Total Population with walk access to the subject stop
Expressed as a ratio of Total Population. Individual share
columns include: Black, Hispanic, Foreign-born, Population
> 65, Population < 16, Employed, Population in multi-family
dwelling, Population living below poverty line
Total Households with walk access to the subject stop
Expressed as a ratio of Total Households. Individual share
columns include: HH with zero vehicle, HH with one vehicle,
HH with children under 16
Total Service Employment with walk access to the subject
stop. Two-digit SIC codes (40, 42, 44, 43, 45, 60, 61, 62,
63, 64, 65, 66, 67, 81, 83, 85, 86, 87, 89, 99, 72, 80, 91, 92,
93, 94, 95, 96, 97, 70, 82, 41, 46, 47, 48, 49, 73, 75, 76, 78,
79, 84, 88)

Route

Arrivals

Specific Service
Characteristics

Headway
IVTT

Special Generator

Socio-Economic
Variables

Attribute Definition

Total Population
Shares of population

Total Households
Shares of
households
Service Employment

Industrial
Employment

Commercial
Employment
Average household
Income
Per-Capita Income
Median household
Income

Total Industrial Employment with walk access to the subject
stop. Two-digit SIC codes (1, 2, 8, 9, 7, 10, 12, 13, 14, 15,
16, 17, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33,
34, 35, 36, 37, 38, 39)
Total Commercial Employment with walk access to the
subject stop. Two-digit SIC codes (50, 51, 52, 53, 54, 55,
56, 57, 58, 59)
Average household income around a subject stop
Per-Capita Income around a subject stop
Median household Income around a subject stop

Time Period Specific Service Characteristics
TBEST includes four stop attributes (Arrivals, IVTT, Headway, Special Generator) that vary
based on model Time Period. In the Stops table, these four attributes will display with a yellow
tint to separate them from other attributes. By default, TBEST will display the Route Definition
attributes and the Time Period Specific attributes. To change the visible attributes, see
discussion of the View menu in this section. When defining the network, it is necessary to
populate values for these attributes for each of the time periods.
Socio-Economic Variables
To determine the socio-economic conditions around each stop, TBEST utilizes the source
socio-economic data defined for the scenario to calculate and assign the walk access
demographics (Population, Employment, Households, and Income) around each stop in the
system. The TBEST model procedure will calculate these variables and then use them within
the model to assess the market for riders at a stop location and to determine the destination trip
attractions through network accessibility computations.
While the TBEST model engine calculates and assigns Socio-Economic variables, these values
are also editable at the stop-level within TBEST. This stop-level socio-economic data editing
capability provides the flexibility to perform localized land-use scenario alternatives analysis
within the context of future-year alternatives analysis. Once a socio-economic variable is edited
at the stop level by the user, it is then “locked” so that the model will not recalculate the socioeconomic variables for the stop. Stops can be “unlocked” by the procedure defined in Section
7.3.
Displaying Stop Attributes
TBEST provides various stop attribute display options for ease in network coding and reporting.
The View Menu on the Main Menu contains three display options for Socio-Economic Variables:
•
•

•

Show All Variables: Choose this option to have all variables (both transit attributes and
socio-economic attributes) displayed in the Stops window.
Time Period-Specific: Choose this option to hide all socio-economic variables and
display only the time-period specific variables including Time Point, Arrivals, Travel
Time, Headway, and Special Generator. This is the default view as shown in Figure
5.30.
Socio-economic: Choose this option to hide all time-period specific variables and
display only the socio-economic variables including demographic (population)
characteristics and employment characteristics for each stop buffer.

Viewing Network Geometry
TBEST provides a variety of stop display options for ease in network coding, viewing, updating
and reporting. The View Menu on the Main Menu contains four display options for Network
Geometry:
•

•

•
•

Route Geometry Only: Choose this option to display only the route geometry (route
segments). Stops will not be displayed in the Map window or the Stops tab. This is the
default option for efficient Map draw speed.
Selected Stops Only: If a stop or set of stops have been selected and defined either in
the Stops table or interactively in the Map window, then choose this option to display
only the stops in the selection set.
Active Route Stops: Choose this option to display only the stop records for the active
route.
All Stops: Choose this option to display all stops in the route system in the Map window
and the Stops window. Active route stops will be specially marked by the larger blue bus
icons.

Figure 5.30 – View Menu Options

Note: TBEST will automatically update the Network Geometry display option based on other
TBEST functions called by the user. The functions include:
• Activating a Route for Editing (Active Route Stops)
• Using the Stops Search in the TBEST Search tool (All Stops)

Selecting Stops
TBEST provides a variety of methods to interactively select groups of stops based on spatial
location, attribute or other methods. The TBEST stop selection methods are:
1. Select from the Stops Table
Clicking directly on Stop records in the stop table will select them in the table and in the
map. By holding down the Shift key during selection, the group of stops in the list
between the currently selected stop and the clicked stop will be selected. By holding the
Ctrl key down during selection, stops can be either added to or removed from the current
selection.
2. Select from the Map
Select the Select a Stop on the Map
tool from the Stop Editing toolbar. Click on the
map to select stops. TBEST will select all visible stops at this location. Holding the Shift
key down while selecting will add stops to the selection. Holding the Ctrl key down while
selecting will remove stops from the selection.
3. Select Stops from Selected Segments
Select a segment or segments in the Segments table on the Segments tab. Right click
on the Segment table and select the Select Stops from Selected Segments option.
The Stops located on the selected segment(s) will be selected.
4. Search Tool
See Section 7.1 Attribute Search for more information on building an attribute query to
select stops.
5. Analysis Toolbar
See Section 7.4 Analysis Toolbar for more information on selecting stops from user
defined spatial extents.
Note: TBEST will only select visible stops. For instance, if the View option is for the Active
Route, selecting stops in the map will only find stops on the active route. The exception to this
is if the Search Tool is used to select stops. TBEST will search all stops for the results and then
change the View mode to All Stops.
Note: Clear the current stop selection by clicking the Clear Map
button on the Map Toolbar.

5.12 Editing Stop Geometry
Editing stop geometry includes the following options:
•
•
•

Adding Stops
Moving Stops
Deleting Stops

Adding and moving stops occurs only on an activated route. Deleting stops can occur on both
active and inactive routes.
Adding Stops
To add a stop, determine the positioning of the stop along the route, using either an existing bus
stop inventory layer or other available information. In the Stop Editing toolbar, click the Add
Stop
button. This will change the cursor to a cross within the map window. Place the stop
at the desired location along the route. The stop will now appear in the Map window, and in the
Stops table in the route sequence in which it was entered. Continue adding stops along the
length of the route.

Figure 5.31 – Adding Stops

Note: TBEST keeps an internal reference to the distance along the route that a stop exists.
Moving Stops
To move a stop, select an existing stop. On the Stop Editing toolbar, click on the Move the
Active Stop button. The cursor will change to a four-point arrow with cursor. Click on the
stop and hold down the mouse button until the stop is at the desired location. Release the
mouse button, and the stop will be located at its new position.

Figure 5.32 – Moving Stops

Note: Stops cannot be moved out of their original order.
Deleting Stops
To delete a stop, select an existing stop. Click on the Delete Selected Stops
button.
You will be asked if you really want to delete the stop; click Yes. To delete multiple stops,
highlight all the stops you want to delete before clicking on the Delete button. Stops can be
deleted on any route at any time, i.e. unlike adding and moving stops, deleted stops do not have
to be on the active route.

Figure 5.33 – Confirm to Delete Stops

5.13 Performing Stop Attribute Modifications
TBEST provides tools to update Stop attributes by either directly modifying cells in the Stops
table or by updating multiple records with the TBEST Calculator. This section discusses the
methods for performing stop attribute modifications and provides a sample update methodology
using the TBEST Calculator.
Cell Editing
Editing cells in TBEST is very similar to Microsoft Excel. Once you have navigated to the cell to
be edited, enter the new value in the cell and either press the Enter key or navigate away from
the cell to accept the value. To permanently store the value, press the Save button on the Main
Toolbar. To discard the value, exit the Scenario without saving.
TBEST Stop Calculator
The TBEST Stop Calculator is used in conjunction with the current Stop selection to modify the
values for the selected group of stops. The Calculator is accessed either from the Stop Editing
toolbar by either pressing the Calculate Stop Values
button or from the Stop Options dropdown menu.
Once opened, the Calculator will display the visible columns in the Stop table. If needed, use
the View menu to change the column display.

Figure 5.34 – TBEST Stop Calculator

The Calculator provides two update options: Set a Value and (+/-) % of Current Value. Set a
Value will update the group of selected stops to a discrete value such as 60 for Headway. The
(+/-) % of Current Value option allows for adjustment of a numeric variable by a user defined
percentage growth rate. For example, based upon proposed service reallocation, a 30%
Headway adjustment can be made to the selected stops. Another example could be that a 10%
growth in Service Employment is applied to a local area expecting a new service-based
employer.
When Time Period Specific columns are selected in the Column list, the Time Periods checklist
will be enabled. The Time Periods checklist contains an option to select any of the TBEST Time
Periods for update. To update the values for more than one time period, select the applicable
time periods prior to calculation.
When the Calculator parameters have been set, click the Update button. To permanently store
the value, press the Save button on the Main Toolbar. To discard the value, exit the Scenario
without saving.
The following steps illustrate the steps to coding stops with a Park-n-Ride Special Generator
flag for the AM Peak period.

Sample Calculator Task Steps
Step 1:
Step 2:
Step 3:
Step 4.
Step 5:
Step 6:
Step 7:

Select the stops to be updated using the Stop list, Map, Spatial Analysis Toolbar, or
Search tool.
Open the TBEST Stop Calculator. Make sure the View option for Stop-level
Variables is set to Show All or Time-Period Specific.
Select Generators/Amenities from the Column list
Make sure the Set a Value option is selected and select Park-n-Ride from the dropdown list of Generators/Amenities
Select only AM Peak from the Time Periods checklist.
Click the Update button.
Click Save on the Main Toolbar to save the scenario edits.

Zooming to the Selected Stops
To zoom to the selected stop(s), right-click on the Stops table, and select Zoom to Selected.
The selected stop(s) will be shown centered in the map window.

5.14 Stop Attribute Values
The TBEST model accepts various network and socio-economic data updates at the stop-level.
This section will focus on providing specific information on how to effectively and efficiently code
TBEST stop attribute values. All edits are made in the Stop table located on the Stops tab.
The following values types will be discussed:
• Operational Stop Data
• Time Points
• Headway/Arrivals
• In-Vehicle Travel Time
• Special Generators/Amenities
• Park-n-Ride Special Generator - Parking Spaces
Operational Stop Data
The transit system being coded in TBEST will generally have stop-level information stored in the
form of a bus stop inventory or operations network within a scheduling software. This
information can be useful for populating the TBEST Stop Name and Description values. The
Stop value is equivalent to the stop identifier and the Description value is generally based on
intersection, location, or major landmark describing the area around a stop. While TBEST does
not require these values to run a model or output the results, these values are useful for keeping
stops organized and cross-referenced across routes. These values can also be useful when
trying to find stops with common identifiers or descriptions using the TBEST Search tool.

Figure 5.35 – Stop Number and Description

Time Points
Time points are those bus stops that are specifically listed in the transit system schedules with
accompanying times. Time Points generally have an identifier in the schedule that is the same
across all routes that access the time point. This common identifier is expected in the Time
Point column. Within the TBEST model environment, time points serve the role of identifying
locations where Transfer Stations exist. While not all time points are transfer stations, those

time points that access transfer stations can be specifically identified in the Network Properties
dialog. See Section 5.15 for more information on coding Transfer Stations.

Figure 5.36 – Time Point

Headway / Arrivals
For each time period that a route is in service, TBEST provides the ability to code headway and
arrivals (trips) at the stop-level. While this is generally a route level feature, by coding at the
stop-level TBEST can modify portions of the route that may receive fewer or no arrivals during
certain trips. Also, routes with no service can be coded with zero arrivals to have the model
ignore the route during the time period. Within TBEST, the headway and arrivals information
automatically remain in-sync with each other during editing. Modifying the arrivals will
automatically trigger the headway to be updated based upon the service span for the route.
Likewise, the number of arrivals will be updated if the headway changes. To change the
Network Time Period, select another Time Period from the list and when changed, the values
for the Headway and Arrivals will be displayed for the selected time period.
For base year model development, the arrivals are based on the route schedule and are input
manually by the user. For future year model application, the arrivals can be modified (or defined
in the case of a new route) to fit the proposed service. For example, in the future year, if service
will be increased by 30% on a particular route, TBEST supports updating the existing number of
arrivals on the target route by 30% through the use of the Stop Calculator.
Note: For the purposes of TBEST, arrivals are synonymous with vehicle trips.
Note: For time periods that a route is not in service, arrival and/or headway values should be
set to zero.

Figure 5.37 – Arrivals/Headway

In-Vehicle Travel Time (IVTT)
The stop-to-stop in-vehicle travel time (expressed in fractions of a minute), is populated in the
IVTT column. The intended use for this column is to work in conjunction with the IVTT in the
Segment table. Once IVTT is coded at the segment level, it can be automatically calculated at
the stop level for a selected route(s) by using the Calculate Travel Time function initiated in the
Routes tab. See Section 5.16 for more information.
For base year scenario development, this information would be derived from the transit
schedule. For future year alternatives, the stop level value could be adjusted using the TBEST
Calculator to increase or decrease by a percent value.

Figure 5.38 – Stop IVTT

Special Generators
Special generators are stops that attract specific demographics that cannot be accounted for in
the socio-economic characteristics and accessibility computation of the model. TBEST contains
seven special attractor codes that can be chosen for each stop from the drop down menu in the
Special Generator column. Special Generators are time-period specific and should only be
coded for the impacted time period.

Figure 5.39 – Special Generators

The decision to code a stop as a Special Generator can often be determined by knowledge of
the local area. While some generators are straight forward to determine, others can be tricky to
assess. Table 5.3 lists the TBEST Special Generators and their intended coding application.

Table 5.3 - TBEST Special Generators
Special Generator

Stop Provides Service to:

University
Airport

University or High School campus.
major Airport terminal

Shopping Mall
Rec Park

major shopping malls or retail outlets
recreational parks such as City Parks, Zoos, County or Regional Parks
or other area providing casual recreation
Event Centers such as stadiums, theaters or other locations that hold
specific events
Military bases
Park-n-Ride lots

Event Center
Military
Park-n-Ride

Park-n-Ride Special Generator - Parking Spaces
For stops defined as a Park-n-Ride Special Generator, TBEST is sensitive to the number of
parking spaces available at the Park-n-Ride. To code the number of parking spaces, select the
stop or stops with Park-n-Ride Special Generators, click the Stops Options drop-down menu
and select Parking Spaces.

Figure 5.40 - Park-n-Ride Spaces

Stop Amenities
In addition to Special Generators, the TBEST stop-level coding allows entry of stop amenities.
Table 5.5 contains a list of amenities that are available with TBEST. Amenities are entered in
the Generator/Amenity column in the TBEST Stop table. Users can enter multiple amenities or
special generators within the column.

Table 5.4 – TBEST Bus Stop Amenities
TBEST Stop Amenities
BUS STOP SIGN
BENCH
TRASH CAN
BIKE RACK
SCHEDULE DISPLAY
SHELTER A

SHELTER B
SHELTER C
UMBRELLA
PEDESTRIAN LIGHT
STREET LIGHT
SHELTER LIGHT

Figure 5.41 – TBEST Bus Amenity and Special Generator Network Coding

Calculating Generators/Amenities
The TBEST Calculator will allow the calculation of multiple Generators/Amenities for the
selected stops. The Value drop-down list contains the ability to select multiple values. For
Amenities, values should be calculated for all time periods since they are not time period
dependent. It is also necessary in some situations to append a special generator or amenity
value to existing values.
For example, a series of selected stops has different
Generator/Amenities values code for each stop. We would like to append a Trash Can amenity
to each of the selected stops and keep the existing values. Using the Stop Calculator, select
the Trash Can Generator/Amenities value. In the bottom right corner of the calculator is an
Append to existing values check box (Figure 5.42). With this checked, any calculations will
append the selected values to the existing values. The resulting calculation will have Trash Can
appended to existing values (Figure 5.43).

Figure 5.42 – TBEST Stop Calculator Append Amenity to Stop Selection

Figure 5.43 – TBEST Stop Calculator Appended Amenities

5.15 Network Properties
The Network Properties dialog within TBEST allows users to set the following for the scenario:
• Fare Structure
• Transfer Stations
• Interliners
The following procedure outlines how to perform the updates and the expected values.
Entering Network Properties
Step 1:
Step 2:
Step 3:

Step 4:

Step 5:

From the main TBEST toolbar, click on the Network button
This will bring up the Network Properties dialog box with information describing the
scenario as displayed in Figure 5.41.
In this dialog box, enter the following information:
Fare for First Wait Time: This is the system-wide base cash fare that a person must
pay when first boarding the transit system.
Transfer Fare: If an agency charges a separate transfer fare when a rider transfers
from one vehicle to another vehicle, enter it here.
Inflation Rate: This is the annual inflation rate that will be used to compute the fare
in real dollars in the forecast year.
The Transfer Stations list box will contain all unique values that have been entered
as stop-level time points. Place a check beside any time point locations that are
considered to be a transfer station.
To add a pair of interlined routes to the list, click Add to bring up a screen and dialog
box as shown in Figure 5.43. Use the pull-down menus to identify the pair of routes
that define the new interliner and click OK. The new interliner will appear in the list of
interlined routes. Once the Routes are defined, select the Route directions that
intersect and the stops where the intersection occurs.

Figure 5.41 - Network Properties

Figure 5.42 – Adding a New Interliner

5.16 Route Coding Tools
Copy a Route to the Reverse Direction
In the event that a route travels exactly the same path inbound as it did outbound, there is an
option to copy a route’s reverse direction. This should be used only if no edits, or only minor
edits, are necessary for the opposite direction. If there are major deviations between the
outbound and inbound directions, it is usually faster to digitize the route segments manually
than to perform edits.
To copy a route’s reverse direction, activate the target route’s outbound or inbound direction to
be reversed. Click on the Copy Reverse Direction
button in the Routes tab toolbar
or under Route Options > Tools. The reverse will occur automatically with a confirmation when
complete.
The reversed segment(s) will appear in the Segments tab, and in the map window upon
activation of that route direction.
Note: In-vehicle travel times will need to be adjusted for a new segment that was copied using
Copy Reverse Direction.
Copy Route
TBEST allows the user to make a copy of any route within the network. The ability to copy a
route provides the following network coding shortcuts:
•
•

Copying a route to create a temporary back-up of the route while edits are performed on
the original
Defining a trunk line that will make up a core of several routes. In this situation, a core
route can be developed that includes a trunk line utilized by several routes. The core
route can be copied to become the base of the new routes that share the trunk. The
variations on the routes can be code individually while still keeping the core segments
and stops of the original trunk line. When all routes coded, the core trunk route can be
deleted or left in the network but coded to have no service.

To copy a route, highlight the Route in the Routes tab. Click on the Copy Selected Route
button in the Routes tab toolbar or under Route Options > Tools. In the Copy Route dialog, give
the Route a new name and modify the properties as necessary. Click OK to copy the route.
The copied Route will appear at the bottom of the Route list.
Note: Copy Route works to copy the Route in both directions. It does not work to right click on
a directional node of the Route.

Calculate Stop-to-Stop Travel Time
Once segment IVTT has been entered and stops have been coded, TBEST provides a tool to
automatically calculate the travel time between each stop. The Calculate Travel Time tool will
interpolate the travel time between each stop, based on the scheduled time it takes to travel
each segment.
Calculating Stop-to-Stop Travel Time
Step 1: Select all routes to be calculated from the Routes tab list.
Step 2: Click the Calculate Travel Time button
in the Routes tab toolbar, or select
Calculate Travel Times by clicking Route Options > Tools.
Step 3: Click Yes when asked to calculate travel times.
Generating Stops
TBEST provides a tool to automatically place stops along a route. In general, this tool was
developed to be used for future year alternatives analysis to test the efficacy of a new route
when bus stop locations are unknown.
However, if no stops are provided in a bus stop
inventory or any other format that lists each individual stop and their location, stops can be
automatically generated for a base year development scenario. The Stop Generation tool works
with a single route by direction and can only be run when stops are not already present on the
route. To generate stops, click the Generate Stops
select Generate Stops from Route Options > Tools.

button in the Routes tab toolbar, or

The Generate Stops dialog will allow stops to be placed at user defined distances along the
route, create an offset from the route, auto-number stops, and place a stop at the end of the
route. Make the changes to the defaults as necessary, and click OK.

Figure 5.43 – Generate Stops

Once complete, the stops will appear in the map window and in the Stops table; if auto
numbering was selected, the auto-generated Stop ID will appear as a stop label in the map.
Viewing Stop Labels
TBEST labels stops based on what you input into the Stop column for each stop. Right-clicking
in the mapping window brings up a menu where you can edit how you view stop labels on the
map. The default setting is for labeling active route stops only. You can change this to label all
stops or turn stop labels off altogether.

Figure 5.44 – Viewing All Stop Labels

Note: The network geometry in the view menu must be set to All Stops in order to view all
stops.
Allow Zoom to Route Activation
By default, TBEST will zoom to show the entire route when activated for editing. However,
there may be times when working with stops at a zoomed in level (i.e., moving stops at a
station) that include multiple routes, that you will not want this feature turned on. To turn off
zoom to route activation, select Route Options > Settings and uncheck Allow Zoom on Route
Activation. This feature will turn back on as a default when the scenario is re-opened.

6. MODEL VALIDATION / MODEL RUN
This section describes the TBEST equations for computing direct and transfer boardings at
each stop. The equations can be modified and saved for each scenario so that there is a set of
equations defined for each scenario. Refer to the TBEST Appendices for detailed information
on the definition of the model variables and the methodology for developing and estimating the
model equations.

6.1 Model Specifications
This section provides the models for the various time periods for estimating direct and transfer
boardings. The models were estimated as negative binomial regression models to recognize
that the dependent variable represents the number of boardings at each stop. In addition, the
mean and the variance of the dependent variable are significantly different from one another,
thus violating the assumption of the Poisson regression model. In the negative binomial
regression model, the expected number of boardings at each stop is estimated as:
Number of boardings at each stop (direct or transfer) = exp (a0 + b1X1 + b2X2 + b3X3 + … + bkXk)
= constant term
where a0
= model coefficient associated with kth explanatory variable/factor/attribute
bk
= kth explanatory variable/factor/attribute value
Xk
By taking the exponential of the linear combination of the variables, it is ensured that the model
will always yield positive predictions of boardings at each stop. The models were estimated with
data from Tri-Met in Portland, Oregon. Tri-Met installed APCs on approximately 75% of its bus
fleet. Along with the APCs, Tri-Met also had on-board Automatic Vehicle Location (AVL)
systems on their vehicles, making it a reliable source of stop-level boarding data properly
indexed to the route, direction, and the geographical location of the stop. Tri-Met services cover
around 575 square miles of the urban portion of the tri-county area (Clackamas County,
Multnomah County, and Washington County) in Portland, Oregon with a total population of 1.3
million in year 2000. Tables 6.1a and b show the variables and coefficients for estimating direct
and transfer boardings for each time period.

Table 6.1a - Model Coefficients for Direct Boardings

Variable
Constant
One
Route Types
RADIAL
CROSSTOWN
EXPRESS
Accessibility
O2 Population
O6 Population
O2 Employment
O3 Employment
O6 Employment
O3+O4-O6 Employment
Log O2 Population

AM Peak

Off-Peak

PM Peak

Night

Saturday

Sunday

-2.16933

-1.35045

-0.49661

-3.91886

-9.10036

-9.52480

0.25930

0.04298
0.14375

0.81960

0.00022
0.00005

-0.00019

0.00011

-0.00005

0.26377

0.00009
-0.00003
0.24925

0.10479

Service
Service Span
Log of Service Span
Population
Total Population
Black Population
Multi-Family Dwelling Unit
One Vehicle HH
Zero Vehicle HH
Hispanic
Poverty Level
Worker
Employment
Commercial
Share Service
Special Generators
PARK-N-RIDE Spaces
UNIVERSITY

-0.00060
0.00004

0.00505

0.00248
0.00401

0.00811
0.00165

-0.00014
0.05671

-0.00006

-0.00037
-0.00011

0.41124

0.60000
0.60000

0.60000
0.60000

0.00634
0.00040

0.00479
0.00180

0.00000
0.00164

0.00402

0.00290

0.00998
0.00555

0.01154

0.00536
0.00340

0.00180

0.00136
0.00286

0.00569

0.00810
0.00396

0.00790
0.00431

0.73422

0.57605

0.50249

0.00404
0.00505

0.00346
0.00563

0.00565

Table 6.1b Model Coefficients for Transfer Boardings

Variable
Constant
One
Route Types
CIRCULATOR
CROSSTOWN
Accessibility
O1 Population
O2 Population
O6 Population
O2 Employment
O6 Employment
(O3+O4)-O6 Employment
Log of O1 Boardings
Log of O2 Population
Service
Inbound Transfers
Special Generators
Mall
College/University

AM Peak

Off-Peak

PM Peak

Night

Saturday

Sunday

-0.03364

1.06406

0.35655

-0.05096

-0.08727

2.24843

0.56243
0.49052

0.32769

0.34813
0.52406

0.28869

0.00040
0.00065

.00125

0.35655
0.00096

0.00079
-0.00255

-0.00015

-0.00044

-0.00032

0.08007
0.04584

0.02153

0.10066
0.02773

-0.00031
-0.00001
0.34768
0.10007

0.00488

0.00813

0.01048

0.03633

0.67408

0.71766
1.21282

0.67045
1.49320

-0.00012
-0.00001

0.00228
0.00006
-0.00067
0.00592

0.37003

0.80926
0.49605

0.88864

6.2

Viewing Model Equations

TBEST allows the user to view and modify the equations for a particular scenario.

Viewing and Modifying Model Equations
Step 1:
Step 2:

Step 3:
Step 4:
Step 5:
Step 6:

Click the Modify Equations Coefficients button in the main TBEST toolbar.
In the Model Equations window, choose to display either the direct boarding
equations or the transfer boarding equations by choosing one of those options in the
Equation Type drop down menu. See Figure 6.1.
The Model Equations will be displayed by time period. To edit, click on any cell and
type a new coefficient value.
When finished refining the model coefficients, click OK to complete the process.
TBEST will return to the editor window.
The user may click the Restore Defaults button at any time to restore the TBEST
default equations for the scenario.
The user may wish to export the scenario equations to an ASCII text file. Click the
Export Equations button to save the equations to a text file.

Figure 6.1 - Model Equations

A Strong Note of Caution: The model specifications and coefficients furnished with TBEST
were estimated using rigorous statistical methods and detailed ridership data at the stop-level.
These model specifications and final coefficient values were determined after much analysis,
iterative model fitting and testing processes, and reasonableness checks. Unless there is a
strong reason to adjust or modify coefficients for a particular scenario, the TBEST development
team strongly discourages any arbitrary modifications to the model coefficients merely for the
sake of better “fitting” the model. If it is desired to develop a set of equations and coefficients
native to a certain area or transit system, the TBEST development team strongly encourages
the user to utilize a team of experts to develop and statistically estimate new model equations
and specifications. As a rule, any modifications made to the TBEST model equations and
coefficients should be clearly documented and justified.
Also note, that the TBEST coefficients may be updated with each new release, as the model
continues to get more refined.

6.3 Model Run
The TBEST model run must be performed to compute all socio-economic buffer characteristics,
accessibility measures, impedance values, and to identify competing and complementary stops
for the active scenario. After the calculation of these parameters, the direct and transfer
boardings estimation is performed.
Follow the steps below to perform a TBEST model run:
Running the Model
Step 1:

Step 2:

Step 3:
Step 4:

Step 5:
Step 6:

If the Scenario to model is currently open, click and select the Model tool button in
the main TBEST toolbar. To execute the model from TBEST Explorer without the
scenario being open: navigate to the Scenario, right-click and select Execute Model
Run.
After clicking on the OK button, TBEST will display the Scenario Model Run dialog
box. In the Scenario(s) to model field, check the scenarios to run the model on and
perform calculations.
In the Select Time Period(s) to model field, check all time periods to run and perform
calculations on. An example of this is shown in Figure 6.2.
Under a standard model run, Socio-Economic Buffer Analysis is only performed on
stops that have changed since the last model run. To ensure that TBEST performs
the analysis on every stop, check the Force Socio-Economic Buffer Analysis
checkbox. This is only necessary if the user has manually modified the underlying
socio-economic database.
The Apply Capacity Constraints option (if checked), will limit riders to 40 per bus
arrival. This is the default option.
Click Run and TBEST will start running and performing calculations for all specified
(checked) scenarios and time periods. When finished with the computations, TBEST
will return a message indicating whether the run was completed successfully.

Note: Generally, model run times will be proportional to the size of the system. A TBEST
Model Progress dialog (Figure 6.3) will update the user on the model operations during the
run.
Note: Models can be canceled by the user during the model run process.

Figure 6.2 - Model Run Dialog Box

Figure 6.3 – TBEST Model Progress Dialog

6.4 Batch Model Run
The Batch Model run option allows multiple scenario models to be run sequentially without
kicking off each model individually. This functionality is intended to save time by running
models in off hours not having the user standby during each run. Batch Model Run as shown in
Figure 6.4.

Batch Model Run
Step 1:
Step 2:

In the TBEST Explorer window, right-click the Scenarios folder for the Transit System
to model and select Batch Model Run in the drop down menu.
Verify that all models are present in the Scenarios to Model list box and that the
appropriate Time Periods are checked. After clicking on the Run button, TBEST will
display the Scenario Model Run dialog box. The dialog box will inform the user which
scenario is currently being processed and the processing status.

Figure 6.4 - Batch Model Run for Different Scenarios

6.5 Model Validation
The TBEST Model Validation process is designed to automatically make the model replicate the
actual ridership data for a given urban area. This involves developing a set of factors that adjust
for considerations not captured within the model coefficients. The factors are applied at the stop
level to enable the model to replicate existing ridership and average factors for a service type
and technology. The factors are then developed to use as adjustment factors for application to
new scenarios in the given urban area. Mean adjustment factors are also developed that can
then be used when the model is applied to new service types or technologies.
Validation with respect to any variable will require that there be actual ridership data available
from the subject transit agency at the level of detail to support validation.
Validation Sequence
Step 1 - Stop-level observed ridership (optional)
The first step in validation is optional for any given application. It enables the user to evaluate
the ridership levels at unique stops. The meaning of “unique” is that the ridership cannot be
explained by socio-economic data or local generators. These are stops where transit demand is
not likely to be well reflected by the socio-demographic and service level data available to the
model. Unique conditions such as intermodal transfer stations with an intercity or interregional
mode or other situations where ridership would not be proportional to population or employment
in the stop buffer can be evaluated and validated against the observed ridership at a stop level.
The user can specify up to 100 discrete stops (by route and direction) and their ridership levels
for an average weekday, Saturday and Sunday.
The model will compare actual forecast ridership (direct boardings) for these stops and adjust
the stop level factor by the following equation.
= Stop Adjustment Factort
Stop Count Direct Boardings Ridershipt
Stop Forecast Direct Boardings Ridershipt
Where t is the reference time period.
These stop adjustment factors, determined independently for Weekday, Saturday and Sunday,
will subsequently be applied to each forecast. Table 6.2a specifies the input data from the
transit planners for stops where ridership data is available and where stops serve a location with
traits that indicate it might be a unique stop. The adjustment will change direct boardings to
more closely match the observed boardings (see Table 6.2b)

Table 6.2a – (Input) Data for Unique Stop Validation

Count Stop Number

Agency provided ridership count data (boardings)
Avg. Weekday
Saturday
Sunday
Ridership
Ridership
Ridership

1
2
.
.
100

Table 6.2b – (Output) Table for Unique Stop Validation (pre route, mode and technology scaling)

Agency provided ridership count data (boardings)

1
2
.
.
100

Adjusted
Ridership

Scaling factor

Initial forecast
(direct
boardings)

Sunday Ridership
Count Ridership

Adjusted
Ridership

Scaling factor

Initial forecast
(direct
boardings)

Count Ridership

Saturday Ridership

Adjusted
Ridership

Scaling factor

Initial forecast
(direct
boardings)

Count Ridership

Stop Number

Count

Avg. Weekday

The adjusted ridership number will then be used in place of the raw direct boarding estimate for
the subject stop. That number will be included in the route total for the subsequent scaling in
step two.
Steps for entering Stop Level Observed Ridership
Step 1:

Step 2:
Step 3:

Step 4:

To flag a stop for Unique Validation, with the Scenario open for editing, in the
Scenario Stops list, select the stop(s) to be adjusted and click the Stop Options dropdown menu. In the Stop Options menu, select Validate Selected Stops.
The Unique Stop Validation form opens. Enter the observed ridership for the
selected stops by time period and click OK when finished.
To edit or view the stops that have already been flagged for adjustment, from the
TBEST Main Menu, select Scenario> Model Validation>1. Stop-Level Observed
Ridership.
The Unique Stop Validation form will open and all stops that have been flagged will
be listed and are available for editing.

Figure 6.5 – Unique Stop Validation

Step 2 - Define Route Collections
Route Collections allow for aggregation of routes to fit the level of data to be used for validation.
Preferably, this would be a ridership number for each route by direction for an average
Weekday, Saturday, and Sunday. However, if ridership data does not exist to this level of
detail, TBEST has the ability to validate the system based on a single observed system
ridership number or by any other grouping of routes including by Route Type, Technology, etc.

Steps for Defining Route Collections
Step 1:
Step 2:
Step 3:

With the Scenario open for editing, from the TBEST Main Menu, select Scenario >
Model Validation > 2. Define Route Collections…
The Defining Route Collections form will open.
To add a New Collection, type the name of the collection and click the Add button.
The new collection name will appear in the Collections list and all available routes
will appear in the Available Routes list.

Figure 6.6a – Adding a New Collection

Step 4:

Add Routes to the Routes in Collection list by clicking the
left move button. If
necessary, click the
right move button to remove from the Routes in Collection
list.

Figure 6.6b – Defining Route Collection List from Available Routes

Step 5:

Repeat Steps 3 and 4 for each route collection.

Step 3 - Collection-level Observed Ridership
The next level of adjustment will result in each route being adjusted to replicate count ridership
at the route level. Adjustments will be applied to all routes for which there is observed (count)
data. The following data needs to be provided:
Table 6.3a – (Input) Ridership Data by Route

Route

Average Ridership
Weekday

Average Ridership
Saturday

Average Ridership
Sunday

1
2
.
n
The ridership data should be for a time period coincident with the route alignment and
scheduled service level used in the model. Seasonal changes in service or ridership can be

accommodated by using service and ridership adjusted to reflect annual average conditions or
the model results can be factors to reflect annual conditions if the model run was developed and
scaled by specific seasonal data. The ridership is an integer number. The adjustment process
accommodates the available data, developing adjustment factors for whatever level of data is
available. For example, many routes also do not have Sunday service so adjustment factors
will not be developed for these periods.
The information from Table 6.3a (Input) will be used to generate a route level time period
adjustment factor calculated as shown in the formula below:
t

t

t

RAFr = Route adjustment factorr =
Count Boardings Ridershipr
t
Adjusted Forecast Boardings Ridershipr
Where Adjusted Forecast Boardings Ridershiprt includes the stop-level adjustments from the
Unique Stop Validation in step one. This information will be used to populate the matrix shown
below. Each cell will contain the Route Adjustment Factors for each route with the specified
technology and service type. A matrix will be produced for each time period (weekday a.m.
peak, weekday midday, weekday p.m. peak, weekday evening/overnight, weekday total,
Saturday, and Sunday). The lightly shaded in gray cells will each contain the series of Route
Adjustment Factors for routes that have the respective characteristics. Some cells may have no
data points while other cells may have numerous data points. The row and column means will
provide the user with information on the variation in adjustment factors with respect to
technologies (for the column totals) and for service types (for the row totals).
The individual Route adjustment factors for each route will be used in all subsequent forecasts
to provide "adjusted" ridership estimates. The calculated mean adjustment factors by service
type and technology can be used in subsequent forecasts as the adjustment factors for new
routes that have the same service type, technology, and time period.
This template is set up to include "other" technology and service types. This will allow for the
prospect that there may be situations where a given route does not fall into any of the specified
classifications. This will be an extremely rare situation.

Table 6.3b - (Output) Route Adjustment Factors for Service and Technology Types

(1 of 3 tables, one for each time period)
Time Period (e.g. Weekday)

Technology

Service
Type
Express
Circulator
Crosstown
Radial
Other

Bus
Rapid
Traditional Transit
Bus
(BRT)
t
RAFr
RAFrt
RAFrt
RAFrt

Light
Rail
Streetcar (LRT)
RAFrt
RAFrt
RAFrt
RAFrt

Heavy
Rail
RAFrt
RAFrt

Commuter
Rail
(AGT)
Other
t
RAFr
RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

RAFrt
RAFrt
RAFrt

TBEST is designed to use the most disaggregate data available for subsequent applications of
Route Adjustment Factors. Thus, for a route that has a weekday a.m. peak period adjustment
factor, subsequent forecasts will apply that a.m. peak period adjustment factor. If service is
expanded such that it exists during a weekday time period when it was previously not available,
the model will assign the weekday average Route Adjustment Factor for the same technology
and service type. If service is expanded to a weekend time the model will similarly apply the
average adjustment factor for that route for time periods in which service existed. For example,
the addition of Sunday service to a route would apply an adjustment factor that was the
weighted average of the Saturday adjustment factors for that route. Table 6.4 outlines the
default source for Route Adjustment Factors for various service expansions and additions.

Table 6.4 - Route Adjustment Source for Service Expansion

Case

Route Adjustment Factors
Source

Existing route service
expansion

Additional Weekday service

Weekday RAFr

Inaugural Weekday service

Saturday RAFr or Sunday
RAFr
Additional Saturday service Saturday RAFr
Inaugural Saturday service Weekday RAFr or Sunday
RAFr
Additional Sunday service
Sunday RAFr
Inaugural Sunday service
Saturday RAFr or Weekday
RAFr
New route, existing
New weekday time period(s) Mean (technology, service
technology and service type
type) RAFt
Inaugural Saturday service
Inaugural Sunday service
New route, existing service New weekday time period(s) Mean (all technologies,
type, new technology1
existing service type) RAFt
Inaugural Saturday service
Inaugural Sunday service
A new route, existing
New weekday time period(s) Mean (existing technology,
technology, new service
all service types) RAFt
type
Inaugural Saturday service
Inaugural Sunday service

Steps for Entering Route Collection-Level Observed Ridership
Step 1:
Step 2:
Step 3:
Step 4:

1

With the Scenario open for editing, from the TBEST Main Menu, select Scenario >
Model Validation > 3. Collection Level Observed Ridership…
The Route-Level Validation form opens (Figure 6.7).
For each Route Collection, enter the observed ridership. Note that entering these
numbers alone will not validate the system. You must run Model Validation – step 4.
Click the OK button to save the edits.

As a body of application data is developed there may be value in developing new technology adjustment
factors based on experience in other locations.

Figure 6.7 – Route-Level Validation form

Step 4 – Run Model Validation
This process will validate the Base Year Scenario. The Base Year Scenario is critical to how
the TBEST model operates so it is very important to make sure that all input data is correct.
Before validating the Base Year, run the model to verify that it is performing correctly and that
model output is reasonable. To do this, after a model run has completed, run route-level reports
(See 8.1 Reports) and analyze output for data outliers or route estimations that are out of
proportion with observed ridership.
If outliers are found, review all input data for
inconsistencies.

The Run Model Validation function takes the current Scenario input data and performs three
functions:
• Completes a model run (if necessary);
• Updates the socio-economic data for the current scenario based on the span of base
year and forecast year and population and employment growth factors;
• Copies the current scenario into the base year scenario files. There is an option to
update all existing scenarios with the adjustment factors produced by model validation.
To Validate the Base Year Scenario:
Step 1:
Step 2:

Step 3:

With a Scenario open for editing, from the TBEST Main Menu, select Scenario >
Model Validation > 4. Run Model Validation…
A reminder to copy the Transit System appears as shown in Figure 6.8. It is
important to make a copy of the Transit System before validating and keep it as a
backup. To do this, see 3.2 TBEST Distribution Files.
The TBEST System Validation dialog box opens (Figure 6.9). Verify the validation
options and click OK.

Figure 6.8 – Copy System Reminder

Figure 6.9 – System Validation

Adjustment Factors
Once the Model Validation is complete, TBEST makes the validation factors available to view
and/or export.
To View TBEST generated Validation Factors
Step 1:
Step 2:

Step 3:

With a Scenario open, from the TBEST Main Menu, select Scenario > Model
Validation > View Collection-Level Validation Factors.
The Route Collection Validation Factors form opens (Figure 6.10). The data is not
editable but can be exported to Excel .csv format using the Export button on the
form.
Click OK to close the form.

Figure 6.10 – View Route Collection Validation Factors

Reject Model Validation
If a model validation is performed but it is necessary to update the base year with updated
socio-economic data or network information, the validation can be rejected and re-performed.

Figure 6.11 – Reject Model Validation

To Reject a Model Validation:
Step 1:
Step 2:
Step 3:

Right-click on the Transit System node in TBEST Explorer. Select the Reject Model
Validation option.
Select source Socio-Economic data to be used from the Source Socio-Economic
Data dialog. Click OK to continue.
In the Update Socio-Economic Data dialog, if necessary, select additional counties
that make up the extent of the service area. Click OK. During this process, the
Transit System source socio-economic data will be updated and the model validation
will be removed. TBEST Explorer will show an unvalidated status beside the
Transit System.

7. REPORTS/PERFORMANCE MEASURES
This section provides an overview of TBEST reporting. Reports are generated in TBEST
through the Report Builder. The Report Builder will create stop, segment and route level reports
for all features or selected features. In addition, the Report Builder allows for a Regional
Analysis report that will spatially summarize ridership or service based on user supplied extent.
The Route-level reports offer route performance measures that depict the overall performance
of routes in the system. For interactive reporting, the Report Builder works together with the
TBEST Corridor Analysis, Area Analysis, Site Analysis and Search functions to summarize data
for the selected features. The TBEST Report Builder can generate reports based on a selected
TBEST time period as well as aggregated Weekday or Weekend reports. As TBEST Reports
are generated, they can be managed within the TBEST Explorer window. In addition, saved
reports are packaged with TBEST Distribution Files.

7.1 Report Builder
The TBEST Report Builder is the primary interface for generating interactive, scenario-based
ridership and route-performance reports. The interface allows the selection of a report time
period or aggregated time period including Weekday and Weekend and a feature summary level
including Routes, Stops, Segments, and Regional Analysis. Optionally, users can specify that
TBEST provide a map summary of the ridership results.
Report Generation
Step 1:
Click the TBEST Report Builder button
in the TBEST Main Toolbar.
The TBEST Reports dialog will open.
Step 2:
In the TBEST Reports dialog, choose the reporting time period using the Time Period
drop down menu. Select one of the TBEST time periods (AM Peak, Off-Peak, PM
Peak, Night, Saturday, Sunday) or an aggregation of the first four (Weekday), or and
aggregation Saturday and Sunday (Weekend).
Step 3:
After choosing the time period, the user must specify the format in which the results
should be tabulated and summarized. There are four summary options:

Option 1 - Stops: Use this option to view
boardings on each stop per selected time
period. Use the Selected Stops option to
report on stops selected (highlighted) in the
Stops window. Stops may be selected in
the Stops tab by using the standard shiftclick operation, by clicking the stop in the
map using the map selection tool, by using
the Search tool, or by using the spatial
tools (Area, Corridor, or Site Analysis).
Use All Stops option if boarding estimation
is desired for all stops in the system. Stoplevel output is illustrated in Figure 7.1.

Option 2 - Routes: Use this option to
summarize boardings at the route level.
Use the Selected Routes option to report
on routes selected (highlighted) in the
Routes tab. Routes may be selected in
the Routes tab by using the standard shiftclick operation or by using the Search tool.
Use All Routes option if boarding
estimation is desired for all Routes in the
system. Routes can be grouped by route
name, route direction, route type, or route
technology or ungrouped.
The output
format can either be by individual stop with
route totals subtotaled or with route-level
performance measures.
Route-level
output is illustrated in Figure 7.5.

Option 3 - Segments: If the Selected
Segment option is checked, a report will be
generated with the boardings along each
segment with the total at the bottom of the
report. Segments may be selected in the
Segments tab by using the standard shiftclick operation, by clicking the segment in
the map using the map selection tool, or by
using the Search tool. If the All Segments
option
is
selected,
TBEST
will
automatically group by the values in the
CorridorID field and provide a subtotal for
each Corridor and a grand total at the
bottom of the report. Stop-level output is
illustrated in Figure 7.2.

Option 4 - Regional Analysis: This option
allows the user to input an ESRI polygon
shapefile and aggregate the data based on
an Area ID in the shapefile. The Area ID
could be city name, zip code or any other
planning level identifier. In addition to a
report summarized based upon the Area ID
provided, this option will also produces a
distribution map of direct boardings, transfer
boardings, total boardings or arrivals
aggregated to intersecting polygons based
on the selected Area ID. Regional Analysis
output is illustrated in Figure 7.3.

Report Generation (Continued)
Step 4:

After choosing the time period, the user must specify the format in which the results
should be tabulated and summarized. There are four summary options:

Step 5:

Map Results Check Box (optional): This option is available for Routes and Stops
based reports. If this option is checked, a map will be generated with pie charts at
each stop. The size of the chart is proportional to the total boardings at the stop.
The slices of the pie chart represent the split of transfer boardings vs. direct
boardings. See Figure 7.4.

Step 6:

After choosing the desired option, click the OK or Apply button. TBEST will run the
computations and display the results in tabular form in the Boardings Estimation
window. Map results will display in the map window.

Note: After clicking the OK button, TBEST might return with a warning message indicating that
edits have been made to the system and therefore a full model run of accessibility and
impedance calculations must be performed prior to estimating boardings. This message is just
a reminder to the user.
Note: To remove the Map Results from the Map Window, click the Clear Map button on the
Map Window toolbar.

Figure 7.1 – Stop-Level Summary Report

Figure 7.2 – Segment Summary Report

Figure 7.3 – Regional Analysis Output

Figure 7.4 – Map Results Option Output

7.2 Route-Level Performance Measures
The TBEST Report Builder will output formatted route-level performance measures report for a
given time period or a given selected set of routes. The performance measure columns were
developed to summarize the performance individual route and provide a performance summary
for all routes at the bottom of the report. The performance measures included in the report are
as follows:
1. Direct Boardings
2. Transfer Boardings
3. Total Boardings
4. Revenue Service Trips
5. Route Miles
6. Revenue Service Miles
7. Revenue Service Hours
8. Total (direct + transfer) Passenger Boardings per Service Mile
9. Total (direct + transfer) Passenger Boardings per Service Hour
10. Total (direct + transfer) Passenger Boardings per Service Trip
11. Average Boardings/Stop Visit = total (direct + transfer) boardings on route ÷ number of
stops on route ÷ number of service trips on route.

7.3 Scenario Summary Tool
The TBEST Scenario Summary Tool allows users to summarize model estimation, socioeconomic data, performance measures, and cost for either a single scenario or as a comparison
between two scenarios. Summarization occurs at the Route Collection or Route level
depending on the model validation. The Scenario Summary Tool also allows users to
incorporate a pre-defined Mobility Area for analysis. Mobility areas are simply TBEST Area,
Corridor or Site Analysis zones that have been developed for the Transit System. When input
into the Scenario Summary tool, route variables are totaled for those routes that fall within the
pre-defined zone.

TBEST Scenario Summary Tool
Step 1:
The TBEST Scenario Summary Tool can either be launched from within TBEST or
separately from the Windows Start menu.
Option A: To open the TBEST Scenario Summary Tool from Windows, go to Start > Programs
> TBEST > Tools > TBEST Scenario Reporting.
Option B: To open the TBEST Scenario Summary Tool from TBEST, open TBEST and from
the Scenario menu select Reports > Scenario Summary Tool.
Step 2:
Select an existing TBEST Transit System.
Step 3:
Select a TBEST Time Period (or aggregate Time Period) to summarize.
Step 4:
To summarize a single scenario, select scenario to summarize in the Scenario A
drop-down box and then select the Summarize Scenario A Only check box. See
Figure 7.4.
Step 5:
To compare two scenarios in the report, select a second scenario for Scenario B.
See Figure 7.5.
Step 6:
To summarize all routes existing in the selected scenario(s), select the All Routes
Summary Option. To summarize routes that intersect a Mobility Area, select the
Routes which intersect a Mobility Area Summary Option (See Figure 7.6). With
this option, the user must select a pre-defined Mobility Area. Mobility Areas are
defined in TBEST using the Area, Corridor and Site Analysis tools. To evaluate the
results of a comparison report, click the Define Mobility Area Thresholds button. For
more information on defined Mobility Area thresholds, refer to the instructions in this
section.
Step 7:
Click the Show Report button to generate the report.

Figure 7.4 - TBEST Single Scenario Summary for all Routes

Figure 7.5 - TBEST Comparison Scenario Summary for all Routes

Figure 7.6 - TBEST Comparison Scenario Summary for Mobility Area

Selecting Summary Span and Time Period
The Scenario Summary Tool provides flexibility on how to summarize estimated ridership,
performance measures and cost. The Summary Span drop-down box contains six options for
summarizing these variables.
1. Daily Summary by Time Period – this is the default option and is a single day summary
of the selected Time Period or aggregate Time Period (Weekday or Weekend).
2. Annualized Summary by Time Period – summarizes the selected Time Period for a oneyear duration. If the selected Time Period is during the week (AM Peak, Off-Peak, PM
Peak, Night or aggregated to Weekday), the values are multiplied by 225. Saturday and
Sunday time periods are multiplied by 52 and the Weekend aggregate Time Period is
multiplied by 26.
3. User-defined # of Days by Time Period – with this option, the Days text box is enable
and the user specifies the number of days to summarize for the selected Time Period.
4. Service Week – a one-week span is summarized. This includes five Weekdays,
Saturday and Sunday. With this option, the Time Period drop-down box is not active.
5. Service Month – summary of four Service Weeks. With this option, the Time Period
drop-down box is not active.
6. Service Year – Summary of fifty-two Service Weeks. With this option, the Time Period
drop-down box is not active.

Figure 7.7 – Summary Span Options

Route Operating Cost
The Scenario Summary tool contains an option for calculating Route and System level operating
costs. The Route Operating Cost per Hour is input by the user and this number is applied to
calculate a Route Cost, Cost per Passenger Trip, and Cost per Revenue Mile. The route-level
numbers are summarized to the system level. Cost numbers can be summarized by Summary
Span which includes weekly, monthly and annual totals.
Scenario Summary Interactive Reports
The TBEST Scenario Summary Tool creates reports that can be interactively filtered to display
Boardings, Population, Household, Income, Employment, Network, Performance Measures, and
Cost variables. The left panel of the report displays the variables in treeview checklist. As
variables are checked, they appear in the report. Boardings variables are in the default report.
The Scenario Summary report will summarize TBEST variables by Route Collection/Route.
Reports with only one scenario summarized will contain a single column for each variable.
Comparison reports will have three columns for each variable, the Scenario A value, the
Scenario B value, and the percent difference between the two values. Report values are
summarized at the bottom of the table. See Figure 7.8.

Comparison reports that are summarized by mobility area will contain a summary table in the
header which matches the additional trips generated for Scenario B vs. Scenario A to the
Mobility Area threshold ranges defined for the time period. See Figure 7.9.
Reports that are summarized by Mobility area will contain two tables:
1. Routes, which access the Mobility area – this table, summarizes routes, which intersect
with the Mobility area. Trips are for the entire length of the intersecting routes, including
areas which fall outside of the Mobility Area. *Note: For determining AMA additional trips
within the target comparison scenario are matched with the results of this table.
2. Trips generated only within the Mobility area - this table summarizes routes which
intersect with the Mobility area but only includes variable summaries within that are entirely
within the Mobility area.

Notes on Scenario Summary Reports:
• For Scenario comparison, TBEST will first group/match routes by validation collection. If
routes are not in validation collections, TBEST will attempt to match on Route Name. If
not match is found, the route will be included in the report but will have N/A for a
comparison route.
• Threshold values are not required to generate a Scenario Report with Mobility Area
Summary Option.
• When summarizing scenarios, pending edits in open scenarios will not be reflected in
the report.
• For Scenario Comparison Reports, the report will provide the number of additional trips
(if any) that were produced by route
• The Mobility Area header summarization is only available when the Daily Summary by
Time Period summary span option is selected.

Figure 7.8 - TBEST Comparison Report for All Routes

Figure 7.9 - TBEST Comparison Report for Mobility Area

Scenario Summary Interactive Charts
Once a report has been generated, interactive charts can be generated by clicking the Open
Chart button on the Report toolbar. For reports that summarize all routes, the drop-down box
next to the Open Chart button will only contain a chart option for All Routes. For reports
summarized by Mobility Areas, the drop-down box will contain an option for each of the two
tables in the report.
The Scenario Summary Chart interface allows for filtering not only route-level variables, but also
the routes that appear in the chart. Users can specify individual routes, groups of routes, select
all routes or only system or mobility area totals.
Charts can be saved to image format by clicking the Save Chart as Image… button on the
toolbar.

Figure 7.10 – TBEST Scenario Summary Chart – Population Totals

Figure 7.11 – TBEST Scenario Summary Chart – Total Ridership by Route

Defining Mobility Area Thresholds
The incorporation of Mobility Areas into the TBEST Scenario Comparison Tool was based on
the need to analyze specific growth areas for their impact on transit. Florida Senate Bill 360
requires counties to develop Mobility Plans as part of their comprehensive plans. AMA zones
are areas defined in the Mobility Plan where increased development or trips are expected. The
TBEST Scenario Summary Tool provides tools to develop recommendations Transit
improvements to meet the estimated demand. The Mobility Area Thresholds allow users to
input ranges of trips with recommendations on service improvements that constitute adequate
transit improvements to meet the additional demand. The ranges can be defined for any
TBEST time period or aggregate time period (Weekday or Weekend). Defining the range
values and transit improvement recommendations is the responsibility of local planners.
Within the tool, users incorporate trip thresholds that serve as a guide to matching the additional
trips that may occur within an AMA zone, to the service improvements necessary to meet
transit/trip demand.
1. Open the tool from the Define Mobility Area Thresholds button on the TBEST Scenario
Summary form.

Figure 7.12 – TBEST Scenario Summary Tool – Defining a Mobility Area

2. The TBEST Scenario Summary – Mobility Area Thresholds form will open. To begin
entering thresholds, select a time period from the drop-down box.

Figure 7.13 – TBEST Scenario Summary Tool – Mobility Area Thresholds Form

3. Click the New Threshold button on the toolbar. A new line will appear in the Threshold
list.
4. Enter Threshold Name, Min Trip Range , Max Trip Range and Recommendations
5. Ranges should not be overlapping. Ranges are set by time period and it is not required
to have a range for all time periods, only the ones that are needed for threshold analysis.
6. Recommendations are elements that may be suggested or required based on the
number of trips generated by network and/or socio-economic changes within the Mobility
Area. (Note: To itemize recommendations on the output report, place a semi-colon
between each specific instance.)

Figure 7.14 – TBEST Scenario Summary Tool – Mobility Area Thresholds Form (cont.)

7.4 Reporting Options
Printing and Saving a Report
The TBEST Report window contains Print and Export to Excel functions.
Use this tool to print the output table showing the estimated boardings.
Use this tool to export the table into Excel as a .csv file. TBEST will default to storing this
in the Reports directory under the current Transit System. If the default location is
accepted, the report will be listed under the Reports folder in TBEST Explorer. The report
can be re-opened at any time from the Explorer window.

Figure 7.15 – Saved TBEST Reports in TBEST Explorer

Figure 7.16 – TBEST Report in Excel

Quick Reports
TBEST allows you to quickly generate reports based on selected segments or stops.
Segments
To quickly summarize the segment ridership, select the segment(s) and click the Segment
Options drop-down menu and select the Show Ridership for Selected Segments option. A
report will be created summarizing segment(s) ridership.
Stops
To quickly summarize the ridership at a stop, select the stop(s), click the Stop Options dropdown menu and select the Show Ridership for Selected Stops option. A report will be
created summarizing stop(s) ridership.

Export Map/Lists
TBEST also has an option to export the current map view, route list, stop list, or segment list to
an Excel document (.csv). To do this, select Export from the File menu and then select the item
you want to export.

7.5 Stop Summary
TBEST provides a summary view of stop-level ridership for all time periods and transfer
opportunities listed by time period. TBEST Accessibility Measures are known as O-Values and
they are listed here as well. To open the Stop Summary form, select the stop to be summarized
in the Stop List, click the Stop Options drop-down menu, and select the Stop Summary…
option. If there have been changes to the scenario that would affect ridership predictions, a
message will appear stating that the scenario has pending edits and that some of the
information may need to be updated through a model run. The Stop Summary form opens. To
view ridership, transfer opportunities and O-Values by time period, select the time period from
the drop-down box at the top of the form.

Figure 7.17 - Stop Summary

8. MODEL AND ANALYSIS TOOLS
TBEST provides a powerful set of tools to develop attribute or location based data queries that
can be used to update model attributes and/or report model output that match a criteria or
location. These tools can used to update attributes and compare model output across multiple
scenarios.

8.1 Attribute Search
TBEST has a powerful search engine to search transit data based on user’s requirements. A
particular route, segment or stop can be searched by entering an attribute data through Attribute
Search Tool. A logical query or combination of queries can be also be used to select features.

The steps below illustrate the method for executing a search in the Search Attribute tool.
Using Search Attribute tool
Step 1:

Step 2:
Step 3:

Step 4:

Step 5:
Step 6:
Step 7:

Select Search from Scenario Menu or Click on the Search button
in the TBEST
Toolbar. Optionally, the Attribute Search can be initiated by right-clicking the Search
Files folder under within the current Transit System in the TBEST Explorer window.
This displays an Attribute Search Window as shown in Figure 8.1.
Select a Search Category. This could be a Route, Segment or Stop.
Select a TBEST Attribute to query. The list options will vary based on the Category
selection. When an attribute is selected from the list, the Value list is populated with
all of the possible values for the Attribute.
Select a logical operator for the Search expression. The options are: Equal To,
Greater Than, Less Than, Not Equal To, Greater Than or Equal To, Less Than or
Equal To, Like. The Like operator allows a text search for any string.
Enter a query Value or select a Value from the list of unique values for the Attribute.
Click on Add Search Criteria and this adds the query into Search Criteria box.
Optionally, additional search criteria can be built into the statement. Use the Or or
And Operator buttons to concatenate additional statements into the criteria.

Using Search Attribute tool (continued)
Step 8:
Step 9:

If the selected attributes are time period specific, the search time period can be
specified in the Search Time Period drop-down menu.
Click the Apply or OK buttons to execute the Search.
Results will display based on the Category selected. Route(s) will be selected
by direction from the Routes list with no map display. Segment(s) will be
selected in the Segment table and Map display. Stop(s) will be selected in the Stop
table and Map display.

Figure 8.1 - Attribute Search Window

Search Files
TBEST provides tools to save and re-query scenarios within a Transit System. When an
Attribute Search is saved, a Search File is created and can be managed under the Search Files
folder in TBEST Explorer. From TBEST Explorer, Search Files can be opened for any scenario
within the Transit System.
Saving a query provides the ability to:
• Save a complex query that would take time to reset from the Statement Builder
• Apply the same search parameters across multiple scenarios to achieve a target report
based on specific criteria. This can be used for evaluating the ridership performance of
routes, segments or stops that meet the criteria. For example, a search can be saved
that selects all Radial routes. To compare the performance of Radial routes across all
alternatives, open each scenario, load the search file and execute the search. Use the
TBEST Report Builder to create of Route-level report with the selected routes only.
Save the reports for each scenario and then build a composite spreadsheet with the
results from each alternative. See Section 8.1 for more information on Report Building.

Figure 8.2 – Search Files Folder in TBEST Explorer

The steps below illustrate the steps to saving, loading and executing a stored Search File.
Save Search Parameters and then Load back into the Scenario
Step 1:
Step 2:
Step 3:

Step 4:
Step 5:
Step 6:
Step 7:

Open the Attribute Search dialog and build an Attribute Query
Click the Save button on the Attribute Search dialog
Give the search statement a name and click Save. By default, TBEST will open the
Save dialog to the Search directory in the Transit System. TBEST saves its Search
files with a .tsh file extension.
Close and re-open the Attribute Search dialog OR clear the full search statement in
the Attribute Search text box.
Click the Load button and navigate to the saved .tsh file or right-click on the Search
file in TBEST Explorer and select Open.
The Attribute Search dialog will open and the selection statement will appear in the
Search Criteria text box.
Click OK or Apply to execute the search.

8.2 Import Routes
The Import Route Tool can be accessed from the Tools tab in the Main Menu. This tool allows
a user to import route(s) into a scenario from another transit system or scenario. The primary
purpose of this tool is to allow exchange of routes across multiple alternatives without recoding
the route(s) in each scenario.
Important note on importing a route into a validated scenario: When importing a route into
a validated scenario, it may be necessary to readjust the Route Collections in the model
validation. TBEST does not automatically know if an imported route is part of the original route
collections in the validation. For example, if Route A existed within the validation and was being
tested in a future year scenario for increased service. The model results showed that the
service increase did not show much gain in ridership it was determined the route would remain
unaltered in the future year scenario. To return the route to the original base year service, the
modeler will need to delete the current Route A and then import Route A in from a scenario with
base year service. Once imported, Route A will need to be added back into the validation route
collection in order to preserve its adjustment factor.

Figure 8.3 - Import Routes Tool

8.3 Stops with Localized Socio-Economic Adjustments
When editing socio-economic data within the TBEST environment for future year analysis, the
TBEST model records the stops at which the edits take place so that future model runs will use
the localized adjustments rather than re-generating and assigning numbers from the underlying
socio-economic data. With the Localized Socio-Economic Adjustments tool, TBEST provides
the user ability to “unlock” the localized edits allowing TBEST to again assign the calculated
socio-economic data for the edited stops. To unlock or review the stops that have been edited,
click the Tools menu option on the TBEST Main Menu, then select Stops with Localized
Socio-Economic Adjustments. To unlock a stop(s), check the stops to be unlocked in the list
and click the Unlock Stops button. To view the stop list in a .txt file, click the Save Stop List
button. To view the checked stops on the Map and select them in the stop list, click the Plot
Edits button (see Figure 8.4).

Figure 8.4 - Review Edited Stops

8.4 Analysis Toolbar
TBEST provides tools for performing area, corridor, and site analyses. With the spatial overlay
created by these tools, socio-economic and network variables can be updated to present a
localized growth scenario consistent with DRI (Development of Regional Impact) studies,
corridor analysis, or site analysis. The Area, Corridors and Site specific analysis tools bring
together the power of TBEST modeling and integrated reporting capabilities.

Benefits of TBEST Spatial Analysis Tools:
• Network and Socio-Economic data can be updated based on spatial extent. Socioeconomic adjustments would reflect localized growth within the analysis boundary area.
• Areas, Corridors and Sites can be created, saved and managed within TBEST
• Modeling results within an Analysis area can easily be compared across multiple
scenarios to derive the system impact within the zone.
• Analysis Areas, Corridors and Sites can be saved as Sector Scenarios for regional
modeling or sub-area modeling.
Tips on using TBEST Analysis Tools:
• The Tools will only select the visible stops in the map window.
• Use the Refresh Selection button on the Analysis toolbar updating the stop selection in
within the Area, Corridor or Site.
• Holding the Shift key while digitizing will allow for multiple shapes within the Area,
Corridor or Site.
To access these tools, go to the View menu and select Analysis Toolbar. From this toolbar,
you can select one of three types of analysis from a drop-down menu.

A

B

C

D

E

F

Figure 8.5 – Analysis Toolbar

The following alphabetized button descriptions correspond to the letters on Figure 8.5.
A. Save button – Use this button to save any analyses to the corresponding folders in
TBEST Explorer.
B. Create a Sector Scenario - Save the current Site, Corridor or Area as a Sector
Scenario
C. Digitize – Select this button in order to digitize features into TBEST. In Area Analysis,
you digitize a polygon (at least three points). In Corridor Analysis, you digitize a buffered
line using points. In site analysis, you digitize buffered points.
D. Select Polygon Features – Define an Analysis Area using features from a polygon
layer
E. Refresh Selection – Selects stops within polygons and buffer areas.
F. Buffer Distance – A user can change the buffer distance (in miles) by inputting a
number here. The default is 0.25 miles. This is used for corridor and site analysis only.

8.5 Area Analysis
Use the digitize tool to interactively create a polygon(s) directly in the map. All of the stops that
fall within the selected area will then become part of a selection set. The stops within the
selection set can have Socio-Economic The selection set can be saved and then re-opened in
subsequent TBEST sessions. This procedure is illustrated in this section.
Performing an Area Analysis
Step 1:
Step 2:
Step 3:

Step 4:

Step 5:

Step 6:

Step 7:

Zoom into the desired area in the Map window of TBEST. This may be done using
the zoom-in tool button.
From the Analysis Toolbar, select Area Analysis definition tool.
Click on the map. This point will serve as the starting location for drawing/ defining
an Area Analysis. Move the cursor and click at desired locations in the map to define
an enclosed sub area. Double-click at the final point to end the process of defining
the area.
(optional): Click the Select Polygon Features tool button and select polygon features
from an input layer. The selected features can be saved in the Area Analysis. Note:
The input polygon layer must be selected in the Map Control. Hold the Shift key
down to add polygons to the selection and the Ctrl key down to de-select polygons
from the selection.
In the View menu, click Show Selected Stops Only. Note that having previously
activated route has no bearing on this operation. The set of stops (across all routes)
that fall within the defined subarea will be highlighted in light blue, both in the Map
window and in the Stops window .
The user is free to modify the transit system attributes and/or the socio-economic
buffer characteristics associated with these stops. In the View menu, click All Stop
Variables to include the socio-economic variables. The user can manually enter new
attribute/variable values within individual cells in the Stops table. Alternatively, the
user can use the Calculator tool button to make modifications across multiple stops:
For example, if a new development is proposed for the defined Area, then the user
may wish to increase the buffer population across all stops in the defined area by a
certain percentage.
The Area Analysis can be saved for future sessions. Click the Save button on the
Analysis Toolbar. Enter a name for the Analysis Area and click OK.

Figure 8.6 – Area Analysis

Figure 8.7 - Saving an Analysis Area

8.6 Site Analysis
Using the site analysis tool, users can select and analyze transit stops by circular buffers around
a particular location. The buffer size (mi) can be modified on the Analysis Toolbar.
Creating a Site Buffer
Step 1:
Step 2:
Step 3:
Step 4:
Step 5:

Step 6:

Select Site Analysis from the Analysis Toolbar.
Choose your buffer distance and hit enter.
Select the Digitize button if not selected and click on a point on the map. A circular
buffer of your chosen distance is created and all stops in that region are selected.
In the View menu, make sure that Show Selected Stops Only is selected for the
network geometry.
You may need to refresh the selection to view the stops in the digitized area. Click
the Refresh Selection button in the Analysis Toolbar. The set of stops (across all
routes) that fall within the defined area will be highlighted in light blue, both in the
Map window and in the Stops window.
The site buffer can be saved for future sessions. Click the Save button in the
Analysis Toolbar. A dialog box that asks for the name of the site buffer will appear.
Enter a name and click OK.

Figure 8.8 - Site Buffer

8.7 Corridor Analysis
A corridor buffer is created using selected routes or by drawing a line along which the corridor
buffer is needed. The buffer size (mi) can be modified on the Analysis Toolbar.

Creating a Corridor Buffer
Step 1:
Step 2:
Step 3:

Step 4:
Step 5:

Step 6:

Select Corridor Analysis from the Analysis Toolbar.
Choose your selected buffer distance and hit enter.
Select the Digitize button. Click a spot on the map to begin your corridor. Drag the
pencil cursor to trace your route and click as needed. Double-Click at the ending
point of your corridor. A buffer of your chosen distance is created around your
corridor and all stops in that region are selected.
In the View menu, make sure that Show Selected Stops Only is selected for the
network geometry.
You may need to refresh the selection to view the stops in the digitized area. Click
the Refresh Selection button in the Analysis Toolbar. The set of stops (across all
routes) that fall within the defined area will be highlighted in light blue, both in the
Map window and in the Stops window.
The corridor buffer can be saved for future sessions. Click the Save button in the
Analysis Toolbar. A dialog box that asks for the name of the site buffer will appear.
Enter a name and click OK.

Or
Step 1:
Step 2:
Step 3:

Select a segment(s) and select Create a Corridor from Selection from the
Segment Options menu as shown in Figure 8.9.
This creates the set buffer distance around the selected segment(s).
Follow Steps 4-6 above. See Figure 8.10 for an example of a corridor buffer.

Figure 8.9 – Creating a Corridor from Selection

Figure 8.10 - Corridor Buffer

Analysis Reports
For any type of analysis, a boardings estimation report can be developed for the stops that fall
within the selected area.
Boardings Estimation for Selected Area, Corridor, or Site Buffer
Step 1:

Click the Reports button

Step 2:

In the Summarize by: drop-down menu, select Stops. Select the report time period.
For Stops to Summarize, choose Selected Stops Only.
Click the OK or Apply button to view the report.

Step 3:

in the TBEST main toolbar.

Re-opening an Analysis
An analysis selection can be re-opened at any time by right-clicking on the analysis name under
the appropriate Area Analysis, Corridors or Site Analysis folder in TBEST Explorer. This
window is shown in Figure 8.11. Note that any selection (previously saved) can be deleted
using the Delete button in the menu. When re-opening an analysis, it may be necessary to
reset the visible Network Geometry in the View Menu to select the necessary stops.

Figure 8.11 - Opening a Previously Saved Analysis

8.8 Sector Scenario
TBEST provides users the ability to segment models to support regional, corridor and sub-area
modeling. Through use of a TBEST Sector Scenario, a TBEST model can be scaled-down to
model specifically within a given geographic sub-area of the model.
The Sector Scenario contains exactly the same editing environment and attributes as a
standard TBEST scenario, the primary difference being that only the stops with the sector
boundary are editable.
Network and socio-economic data edits can be made inside of the sector but the network and
socio-economic data outside of the sector remains static.
Sector Scenario Applications
 Regional Models – large transit systems or combined regional systems can be sectored
to decrease model run times but still retain the regional connections.
 Sub-Area and/or Corridor Analysis – Using TBEST tools, users can define Analysis
Areas, Corridors or Sites for analysis. Through a Sector Scenario, modelers focus on
network or socio-economic data modifications within the sub-area/corridor while
decreasing model run times.
Tips on Using Sector Scenarios
• Routes that will be edited within a Sector should be fully contained within the Sector
boundary.
• Reports generated in a Sector scenario will only contain ridership estimations for stops
within the sector boundary. Route level reports will still contain all routes in the system
but with ridership estimates for stops in the sector boundary. Thus, depending on the
sector definition, there may be Routes in the report with zero boardings.

•

Sector Scenarios should not be created until the model has been validated.

The following steps illustrate the method for creating a Sector Scenario.
Creating a Sector Scenario
Step 1:
Step 2:
Step 3:
Step 4:
Step 5:

Step 6:
Step 7:
Step 8:

From the TBEST Explorer window, make a copy of the scenario that will become
the sector scenario.
Open the copied scenario.
Identify the geographic extents that will define the sector boundary by either
creating or utilizing an existing TBEST Area Analysis, Corridor or Site Analysis.
In TBEST Explorer window, right click on the TBEST Area Analysis, Corridor or
Site Analysis that will define the geographic extent of the sector.
From the right-click context menu, select the option to convert the Scenario into a
Sector Scenario. Optionally, the Analysis Toolbar contains a button to create the
Sector Scenario.
TBEST will perform the sector building procedure. This procedure will take
nearly same amount of time as a model run for the scenario.
When complete, the scenario will be zoomed to the extent of the sector boundary
(Figure 8.12).
When not open, the Scenario will now be displayed in the TBEST Explorer
window with the Sector Scenario
icon.

Figure 8.12 – Sector Scenario

Editing a Sector Scenario
Once the sector scenario has been created, it is managed and edited in the same manner as a
standard TBEST scenario. The two differ in that only stops within the sector boundary can be
edited.
New stops can only be placed within the sector boundary. All others are non-visible and their
values are held static. The exception to this rule is that changes in the scenario socio-economic
data growth rates will be reflected in stops outside of the sector boundary.
Tips on Editing a Sector Scenario
• Although stops outside of the sector boundary will not be visible, segments will be
visible. It is not recommended that segments outside of the boundary be edited.
Removing a Sector Boundary
Once the sector modeling has been completed, the sector scenario can optionally be returned
to a standard scenario. A full model run is required after function has been completed. To
remove a Sector Boundary, with the Sector Scenario open, under the Tools menu on the
TBEST Main Menu, select Undo Sector Scenario. This will remove the sector and restore the
scenario to the standard scenario format.

8.9 Loaded Network
The TBEST Loaded Network output associates all of the model attributes for a given scenario
and time period with the transit network. The Loaded Network function associates socioeconomic data, ridership, accessibly, service, route names, stop names, IVTT and other model
attributes with individual stops and segments.
The output of the Loaded Network process is a personal geodatabase containing Stops and
Route Segments feature classes. This output can be analyzed in ArcMap, Microsoft Access,
Excel and other external software platforms.

Creating a Loaded Network
Step 1:
Step 2:
Step 3:
Step 4:

Step 5:
Step 6:
Step 7:
Step 8:

Start a TBEST session and open a scenario.
Go to Tools  Create a loaded TBEST Network. A form opens as shown in
Figure 8.13.
Select the desired Output Time Period.
Under “Output Options”, browse to the location on the local machine where the
loaded network file is to be saved. The output personal geodatabase will be
named TBEST_LOADEDNETWORK.mdb.
Check the box next to “Add Accessibility Measures” to add TBEST model
network accessibility measures to the output file.
Check the “Add to TBEST Map after processing”, to add the loaded network as a
layer in the TBEST Map control.
Click OK.
Once the process is completed, the loaded network can be found added as
layers in the Map Control in TBEST (Figure 8.14). The loaded network consists
of two layers; Loaded Network –Stops and Loaded Network – Segments.
Note: If Add to TBEST Map after Processing was unchecked before starting
the run to create the loaded network, you would be required to manually add
layers in TBEST ArcMap from the output location.

Figure 8.13– Loaded Network Dialog

Figure 8.14 – Map Control with Loaded Network

Analyzing a Loaded Network in ArcMap
Step 1:

Step 2:

In order to analyze the loaded network in an ArcMap environment, click on the
Analyze TBEST in ArcMap button on the Map Toolbar. When ArcMap opens, all the
layers currently in the TBEST map are added to a the new ArcMap document.
Utilize ArcMap tools to create maps and charts that help visualize model results,
socio-economic data distribution, and internal model relationships. An examples of
analysis output is illustrated in Figure 8.15 below.

Figure 8.15 – Analyzing a Loaded Network in ArcMap

Appendix B – TBEST Model Application Scenario Checklist

Original
Date:
Dates
Revised:

TBEST MODEL APPLICATION SCENARIO CHECKLIST
Fill in the relevant information regarding the scenario. Not all items are required.
Modeler Name:

Organization:

TBEST Transit System Name:

SCENARIO PROPERTIES
Scenario Name:
Model Base Year:

Model Forecast Year:

Service Area Mean Annual
Person Wage

 Future Year Information
Entered (No Growth Rate)
 Expected Wage Growth Rate
Entered

Source:
Source:

 No Change Expected
Employment Data Source

 InfoUSA
 Zonal Employment Shapefile

Filename and Location:

Scenario Description

SOCIO-ECONOMIC GROWTH
System Growth Rates
*Required

*Population:
Average Household Income:

Zonal Growth Rates

File Name and Location:

Localized Growth

DRI Name:
TOD Name:
Corridor Name:
Site Name:

*Employment:
Per-Capita Income:

Households:
Median Household Income:
File Source Year:

Changes to Socio-Economic Variables4:

NETWORK INPUT
New Routes

Realigned Routes

New Stops (on
existing routes)

Moved Stops (on
existing routes)

Deleted Routes

Name:

Location:

Type:

Name:

Location:

Type:

Name:

Location:

Type:

Name:

Location:

Type:

Name:

Location:

Type:

Route:

Description:

Route:

Description:

Route:

Description:

Route:

Description:

Route:

Description:

Route:

Description:

Route:

Description:

Route:

Stop:

Route:

Stop:

Route:

Stop:

Route:

Stop:

Route:
Route:
Route:
Route:

Deleted Segments

Deleted Stops

IVTT/Speed

Route:

Location:

Route:

Location:

Route:

Location:

Route:

Stop:

Route:

Stop:

Route:

Stop:

Route:

Stop:

Route:

Segments:

Route:

Segments:

Route:

Segments:

Additional Description of Network Edits:

 Increase or 
Decrease
 Increase or 
Decrease
 Increase or 
Decrease

Value:
Value:
Value:

SERVICE CHANGES

Service Span

Route:

Time Period1(s):

 Increase or  Decrease

Number of Hours:

Route:

Time Period1(s):

 Increase or  Decrease

Number of Hours:

1

 Increase or  Decrease

Number of Hours:

1

Route:

Headway

Time Period (s):

Route:

Time Period (s):

 Increase or  Decrease

Number of Hours:

Segment:

Time Period1(s):

 Value or  % Change

Number:

1

 Value or  % Change

Number:

1

Route:

Time Period (s):

Route:

Time Period (s):

 Value or  % Change

Number:

Route:

Time Period1(s):

 Value or  % Change

Number:

1

Corridor, Area, or Site:

Time Period (s):

 Value or  % Change

Number:

Entire System

Time Period1(s):

 Value or  % Change

Number:

Additional Description of Service Changes:

NETWORK PROPERTIES
Fare

 Future Year Fare Entered (No Growth Rate)
 Expected Inflation Rate
Entered

Source:

 No Change Expected
Transfer Hubs

Interlined Routes

 Added or  Removed

Time Point Identifier:

 Added or  Removed

Time Point Identifier:

 Added or  Removed

Route A:

Route B:

 Added or  Removed

Route A:

Route B:

 Added or  Removed

Route A:

Route B:

SPECIAL GENERATORS
Special
Generators1

 Added or  Removed

Stop Name:

Time Period1:

SG Type2:

*Parking Spaces:

*Only for PnR
Generators

 Added or  Removed

Stop Name:

Time Period1:

SG Type2:

*Parking Spaces:

 Added or  Removed

Stop Name:

Time Period1:

SG Type2:

*Parking Spaces:

 Added or  Removed

Stop Name:

Amenity Type3:

 Added or  Removed

Stop Name:

Amenity Type3:

 Added or  Removed

Stop Name:

Amenity Type3:

Amenities2

REFERENCE TABLES

1

TBEST Time Periods

AM Peak

6:00am - 8:59am

Off Peak

9:00am - 2:59pm

PM Peak

3:00pm - 5:59pm

Night

6:00pm - 5:59am (following morning)

Saturday

24 hours

Sunday

24 hours

2

TBEST Special Generators

University
Airport
Shopping Mall
Rec Park
Event Center
Military
Park-n-Ride

University or High School campus.
major Airport terminal
major shopping malls or retail outlets
recreational parks such as City Parks, Zoos, County or Regional Parks or other
area providing casual recreation
Event Centers such as stadiums, theaters or other locations that hold specific
events
Military bases
Park-n-Ride lots

3

TBEST Stop Amenities

BUS STOP SIGN
BENCH
TRASH CAN
BIKE RACK
SCHEDULE DISPLAY
SHELTER A

SHELTER B
SHELTER C
UMBRELLA
PEDESTRIAN LIGHT
STREET LIGHT
SHELTER LIGHT

4

Socio-Economic Variables

Total Population
Shares of
population
Total Households
Shares of
households
Service
Employment

Industrial
Employment
Commercial
Employment
Average household
Income
Per-Capita Income
Median household
Income

Total Population with walk access to the subject stop
Expressed as a ratio of Total Population. Individual share columns include:
Black, Hispanic, Foreign-born, Population > 65, Population < 16, Employed,
Population in multi-family dwelling, Population living below poverty line
Total Households with walk access to the subject stop
Expressed as a ratio of Total Households. Individual share columns include:
HH with zero vehicle, HH with one vehicle, HH with children under 16
Total Service Employment with walk access to the subject stop. Two-digit
SIC codes (40, 42, 44, 43, 45, 60, 61, 62, 63, 64, 65, 66, 67, 81, 83, 85, 86,
87, 89, 99, 72, 80, 91, 92, 93, 94, 95, 96, 97, 70, 82, 41, 46, 47, 48, 49, 73,
75, 76, 78, 79, 84, 88)
Total Industrial Employment with walk access to the subject stop. Two-digit
SIC codes (1, 2, 8, 9, 7, 10, 12, 13, 14, 15, 16, 17, 20, 21, 22, 23, 24, 25, 26,
27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39)
Total Commercial Employment with walk access to the subject stop. Twodigit SIC codes (50, 51, 52, 53, 54, 55, 56, 57, 58, 59)
Average household income around a subject stop
Per-Capita Income around a subject stop
Median household Income around a subject stop

Appendix C – TBEST GTFS Network Import Tool

Introduction
The TBEST GTFS (General Transit File Specification) Network Import Tool takes advantage of the
investment agencies and vendors have made in developing Google Transit Trip Planner compatible files.
The TBEST GTFS Network Import tool is a critical part of the use of TBEST for service planning since it
integrates current or historic operational network information directly into TBEST, saving the
organization valuable time in maintaining an accurate modeling and analysis platform.
The GTFS file specification includes data that can be utilized by TBEST to import the route network,
service characteristics and other TBEST model variables. The TBEST GTFS Network Import tool can be
used to import individually selected route(s) or the entire network while maintaining the integrity of the
model validation. Planners can maintain the base year model network structure by intermittently
updating the network with modified routes per bid update or re-validate the model based on the new
bid update.
TBEST GTFS Network Import File Requirements
In general, transit agencies utilizing the Google Transit Trip Planner will house their GTFS feed in the
Operations or Planning departments. If your agency does not utilize Google Transit, it is still possible
that the GTFS feed can be output from proprietary operational software such as Trapeze.
Once generated, the files can easily be transferred through email and viewed using a text editor or
Microsoft Excel. The planner will not be required to modify the files for use with TBEST.
TBEST requires the following GTFS files:
•
•
•
•
•
•
•
•

Routes.txt
Calendar.txt or calendar_dates.txt
Trips.txt (must contain a populated direction_id field)
Stops.txt
Shapes.txt
Agency.txt
Stop_times.txt
Stop_features.txt (Optional) – this table stores stop amenities and special generators as defined
by TBEST. The stop_features.txt file contains the following field definitions:
Data Field
Stop_id

Feature_type

Description
Required. The stop_id field contains an ID that
uniquely identifies a stop or station. Each stop_id
value should be included in the stop.txt file.
Required. The feature code describing an amenity or
special generator at the stop. A single stop can have
multiple amenities. Valid values are listed below:

Feature code
1

spaces

Feature description
UNIVERSITY

2
MILITARY
3
SHOPPING MALL
4
EVENT CENTER
5
PARK-n-RIDE
6
AIRPORT
7
REC PARK
8
DIRECTIONAL BIAS
9
BUS STOP SIGN
10
BENCH
11
TRASH CAN
12
BIKE RACK
13
SCHEDULE DISPLAY
14
SHELTER A
15
SHELTER B
16
SHELTER C
17
UMBRELLA
18
PEDESTRIAN LIGHT
19
STREET LIGHT
20
SHELTER LIGHT
100
Transit Hub
Optional: For Park-n-Ride values, the number of
parking spaces that are available at the park-n-ride lot.

See the following link for additional details on the GTFS:
http://code.google.com/transit/spec/transit_feed_specification.html
Obtaining the TBEST GTFS Network Import Tool
The TBEST team is ready verify that your GTFS feed is compatible with TBEST. Because not all feeds are
the same, agencies are required to submit the feed to the team for evaluation and adaptation to TBEST.
In most cases, the team must modify a translational Microsoft Access database to “fit” the feed to
TBEST. The database is then provided with the TBEST GTFS Network Impot tool for deployment to the
agency.
Intalling and Configuring the TBEST GTFS Network Import Tool
Once the installation file and database are obtained from the TBEST team, run the installation
procedure. The procedure is straightfoward and should take less than one minute.
After installation, perform the following steps to configure the tool:

1. Replace the C:\TBEST\Tools\GTFSImport\GTFSNetwork.accdb with the Microsoft Access database

supplied by the TBEST team.
2. Once replaced, open the GTFSNetwork.accdb in Microsoft Access 2007 or 2010. If you have a prior
version of Access, or no version at all, then disregard this step and the next.
3. Follow the instructions in the following link to add the database location as a trusted location within
Access. (http://office.microsoft.com/en-us/word-help/create-remove-or-change-a-trusted-locationfor-your-files-HA010031999.aspx). The trusted location to add is: C:\TBEST\Tools\GTFSImport\.
GTFS Routes to TBEST Routes
Both TBEST and GTFS formulate routes on the level of the pattern or path. GTFS may have several
patterns that make up a single route. The GTFS Import tool translates the patterns and creates TBEST
routes with two directions or one direction in the case of a circulator. When generating a route, the
GTFS Import tool will try to match inbound and outbound patterns that are most likely to have trips that
run along both patterns. In some cases where there is an odd number of patterns on a route, a TBEST
route will only have a pattern in one direction.
Since there are no field values in the GTFS schema that denote the route type, the TBEST GTFS Network
Import tool will look for key words such as ‘Express’, ‘Circulator’ or ‘Crosstown’ in the route description
and then code the TBEST route with the correct route type. If none of these types are present in the
route description, the route will be coded as a Radial. If the route type needs to be modified, follow the
instructions for Modifying Route Properties.
TBEST routes also deal with service differently than GTFS. TBEST summarizes stop-level headway,
arrivals, and in-vehicle travel time by time period. The GTFS provides individual arrival times by stop (or
time point). The GTFS Import tool calculates the TBEST service from the individual arrival times
populated in the GTFS.
TBEST routes can also be broken into segments which are helpful in more accurately defining in-vehicle
travel time based on time points within the schedule. The GTFS does not contain an absolute flag for
whether a stop is a time point or not. It does indicate that a time point is a stop that has arrival times
populated in the stop_times.txt table, however, most agencies are currently populating all stops with
arrival times so time points become indistinguishable in the feed. Therefore, the GTFS Network Import
Tool does not break route linear geometry into segments. Routes segments can be created manually
after import using the TBEST Network Editor.
In addition, the TBEST GTFS Network Import tool does not populate Interliners as defined in TBEST.
Operating the TBEST GTFS Network Import Tool
The TBEST GTFS Network Import tool has been developed to assist in the creation and maintenance of
TBEST model networks. In general, it is capable of the following:
•
•

Generating a new network in a new TBEST transit system
Replacing an existing TBEST network and with a GTFS generated network

•

•

Interactively replacing existing routes with GTFS routes. If the route to be replaced is in a route
collection, the GTFS Import tool will maintain the integrity of the route collection as well as any
validation numbers associated with the collection.
Adding new routes to an existing TBEST system

When generating routes into a TBEST system where no validation exists and no route collections are
present, the GTFS Import tool will create route validation collections and place the generated routes in
those collections. After the network is generated, the user may modify those collections within the
TBEST Network editor if there are any issues.

TBEST GTFS Network Import Tool Utilization
Procedure Steps
1.

Open the GTFS Network Import Tool

2.

Navigate to the GTFS Source File Folder
*The folder will contain the files that make up the GTFS feed for the transit system. The required files are
routes.txt, stops.txt, trips.txt,shapes.txt,stop_times.txt, agency.txt, calendar.txt or calendar_dates.txt

3.

Select the Target TBEST Transit System

4.

Select the Target TBEST Scenario
*The selected scenario should not be open in TBEST.

5.

Click the Show Service IDs button. The tool will load the list of Weekday, Saturday and Sunday service codes
in the GTFS Feed. The service codes can be indicative a types of service, alternating service, holiday service or
other categorizations defined by the agency. For more information on the meaning of the agency service
codes, contact the agency Operations Department.

6.

Utilize the Select Service Periods to Import section to view the service codes. To view which routes belong
to a service code, check the box beside the code and click the Show Routes button. The routes will be visible
in the Import Options section. Multiple service codes can be combined for the import. If the same route
exists under more than one service code, it will only be imported once.

7.

To import routes into a scenario with no existing network or where existing routes need to be deleted:
a. Select the Remove all existing routes in the scenario before importing selected routes option in
the Import Options section.

8.

9.

b.

To import all routes into the scenario, check the Select All checkbox. To import only select routes,
check each route to be imported in the Import column.

c.

Go to Step 10.

To add new routes from the current GTFS feed to an existing scenario:
a.
b.

Select the Interactively select routes to import/replace option in the Import Options section.
To import all routes into the scenario, check the Select All checkbox. To import only select routes,
check each route to be imported in the Import column.

c.

For each selected route, the Action column value must be ‘Insert as a New Route’

To replace routes within the existing scenario with updated routes from the current GTFS feed:
a.
b.

Select the Interactively select routes to import/replace option in the Import Options section.
To import and replace all routes into the scenario, check the Select All checkbox. To import only
select routes, check each route to be imported in the Import column.

c.
d.

For each selected route, the Action column value must be ‘Overwrite Existing Route’.
In the ‘Replace TBEST Patterns’ column, click the ellipsis button to select the TBEST patterns in the
existing scenario that will be replaced.
In the Routes to be Replaced dialog, check the pattern(s) that make up the route and click the OK
button.

e.

10. Click the Import button to begin the import. A progress bar will monitor the routes that are being imported.
When complete, the scenario will be ready to open in TBEST.

GTFS Network Import Quality Control Procedures
Operation Steps

1. Review Service Span
a. Review the route-level service span to verify that it accurately reflects the service in each
TBEST time period
2. Review Routes
a. Verify that routes have been coded with the appropriate route type and technology.
Expanding the Routes window will allow this information to be easily examined.
b. Activate routes to verify correct linear geometry and stop locations. This only needs to
be performed on routes that have been imported.
3. Review Validation
a. In general, all routes should be in validation route collections. The exception to this is
when a new route is added to an existing network.
4. Review Segments
a. Verify that all segments have IVTT population for time periods where they are in service
5. Review Stops
a. Verify that stop sequencing is correct
b. Verify that headway, IVTT and arrivals are correct
c. If stop_features.txt was part of the GTFS feed, verify that time points, special
generators/amenties, and transfer hubs have been coded.
6. If any of the information in the imported network is incorrect, notify the Operations or Planning
department of the problems. If the GTFS feed is verified to be correct, there may be issues in
interpreting the network through the TBEST GTFS Network Import tool. In this case, contact the
TBEST team for technical assistance.

